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Introduction

Getting Started

Introduction
Welcome . . : ,

IBM® Sterling Gentran:Director® provides you with the tools you need to
electronically exchange data with your trading partners. These tool include
the following:
B Datatrandation
B Process control
B Communications system
We believe that you will find this software, and its supporting material's, easy
to use and beneficia to your business.
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Getting Started What’s in this Manual

What's in this Manual

Introduction _ . . . . .
This manual supports the online Help by assisting you with various tasksin

Sterling Gentran: Director. Thistask-oriented approach provides step-by-step
instructions to answer any questions you might have about Sterling
Gentran:Director.

Intended

audience Thismanual isintended for the staff responsible for the following:
Implementing EDI

Setting up trading partner relationships

Creating and using EDI documents

Sending and receiving documents

Acknowledging documents

Tracking document flow

Using accum tracking

Prerequisite

knowledge Thismanual assumes that you are familiar with using a PC and with
Microsoft™ Windows functions.

Conventions in
this Manual Thefollowing typeface conventions are used in this manual:

Sending a Document  Thistypefaceis used for emphasis or to indicate a
chapter or section in this manual.

NEW This typeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, and then press
ENTER.

F1 This typeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a combination of keysto be
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Getting Started

pressed together. For example, CTRL + C.

Description of

contents ThelBM® Serling Gentran:Director® User Guide is organized into
chapters. A brief description of each chapter is outlined below.

Chapter 2, Using Translation Objects explains how to register (install),
delete, and view trandation objects.

Chapter 3, Using Partners explains how to set up a complete partner
profile. This chapter describes how to import or export a partner profile
and partner tables, and describes how to copy a partner profile.

Chapter 4, Using Documents explains all the facets of managing your
documents.

Chapter 5, Using Communications explains how to send, receive, and
resend documents, and how to view the Send Queue.

Chapter 6, Using Interchanges explains how to view interchanges and
the documents within interchanges, how to filter the display of
interchanges, and how to attach (link) an interchange to a partner.

Chapter 7, Using Acknowl edgements explains how to manually set a
document to “acknowledged,” and how to define inbound and outbound
acknowledgement criteria for document reconciliation.

Chapter 8, Using the Tracking and Audit Systems explains how to view
and print document tracking and audit log information.

Chapter 9, Using the Accum Tracking Extension defines the Accum
Tracking Extension and explains how to use accum tracking.

Chapter 10, Daily Processing describes an example of the operational
activities that may be executed as part of your daily processing.

Appendix A, Using TDF describes the Transaction Data File (TDF)
which serves as a bridge between your application data and the Sterling
Gentran:Director trandator.

Notices contains legal information governing the use of information
contained in this document.

The Glossary contains definitions of EDI and Sterling Gentran:Director
terms and concepts.

The Index provides you with a page listing of terms, concepts,
functions, and processes to enable you to quickly find them in this
manual.

May 2011 IBM Sterling Gentran:Director User Guide



Getting Started What’s in this Manual

Online Help

system The mgjority of the documentation for Sterling Gentran:Director is
contained in the online Help system. Thisincludes dialog box element
definitions, detailed processing information, and all the how-to information
that is contained in this manual .
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Getting Started

Getting Support

Introduction

How To Get Help

Before calling
Support

Sterling Gentran:Director software is supported by trained customer support
personnel who are available to help you with product questions or concerns.

IBM® Sterling Customer Center provides awealth of online resources that
are available around the clock to enrich your business experience with
IBM® Sterling Gentran®. By using Sterling Customer Center, you gain
access to many self-support tools, including a Knowledge-Base,
Documentation, Education, and Case Management. Access Sterling
Customer Center at http://customer.sterlingcommerce.com.

Once logged in, select Support Center from the top navigation menu, and
then locate Sterling Gentran product-specific support information from the
left navigation menu.

Additionally, our Customer Support Reference Guide outlines our support
hours, contact information, and key information that will enhance your
support experience with us. For detailed information about Customer
Support, please refer to the Customer Support Reference Guide accessible
from the login page. (http://customer.sterlingcommerce.com)

To help us provide prompt service, we ask that you do the following before
calling Customer Support:

B Attempt to recreate any problem that you encounter and record the exact
sequence of events.

B Be prepared to provide us with the following information:

1. Mailbox number:
A mailbox number is assigned to customers who have an assighed
mailbox.

2. System Configuration
Information about the primary system controller and all machines
experiencing problems, including the computer manufacturer and
model number, Windows version, amount of memory, available

May 2011 IBM Sterling Gentran:Director User Guide
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disk space, and the network adapter type.

3. Error Messages
Record the exact wording of any error messages you receive and
where the error occurred in the software.

4. Attempted Solutions
Record any steps you performed to resolve the problem and note all
the outcomes.
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Introducing Electronic Data Interchange Getting Started

Introducing Electronic Data Interchange

Overview

Using EDI

Electronic Data Interchange (EDI) is the paperless exchange of data between
business partnersin a standardized, computer-processible format. This
business data includes invoices, purchase orders, and advance shipping
notices.

In today’s fast-paced business environment, EDI is a necessity. Thisneed is
driven by just-in-time (JIT) manufacturing schedules, customer-service
demands, “partnering” with another company or sharing information
systems, increasingly competitive business environments, and the need to
establish and maintain the competitive advantage.

The key to EDI is standardized data. EDI extracts information from your
application and convertsit into a standardized format that can be transmitted
to your business partner. Transmitting information between two computer
systems requires that the data and its format be expected, meaning itisan
established format. Non-standard data or formats can introduce errors and
confusion.

EDI standards regulate the syntax, structure, and content of the transaction
data. EDI translators convert the data from your application format to a
standard format such as ANS| X12, TDCC, VICS, EDIFACT, or
TRADACOMS. At the receiving end, the standard format allows your
trading partner’s computer system to read the data so it can be automatically
processed and interfaced with their internal applications.

The entire process can be accomplished in minutes, without the rekeying
involved with manual document processing.
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Introducing Electronic Data Interchange

Example

The following diagram illustrates the EDI process:

|
K Network

Purchasing Order Entry
Application Application
Application Application
Link Link
EDI Translator EDI Translator

I x

Communicationy Communication

Value-Added

Understanding

the Structure of EDI structure can be divided into the following levels:

EDI o

Envelopes
Transaction sets (documents)

Segments

Elements
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Introducing Electronic Data Interchange Getting Started

Diagram o ,
The following figureillustrates the enveloping and EDI structure.

Communications Protocol

Communications ™M — interchange Header |

Session
—1{ Functional Group Header|
Interchangé ——1—p —1 Transaction Header |
Transaction
. (Document)
Functional Group 4 Purchase Order
(optional) ! Transaction Trailer |

— Transaction Header |

. Transaction
Transaction g (Document)

Purchase Order
— Transaction Trailer |

— Functional Group Trailer |

—1 Functional Group Header |

Functional Group 4
(optional) Transaction Header |
Transaction
Transaction (Document)

Transaction Trailer |

—| Functional Group Trailer |

—— Interchange Trailer |

Communications Protocol
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Introducing Electronic Data Interchange

Envelopes

Transaction sets

Segments

Elements

EDI envelopes function in the same way as paper envelopes. They separate
different types of data and carry address information. Each envelope
contains a header segment and a trailer segment. These segments separate
the envelope from other envelopes and provide information about the
contents of the envelope.

Thethreelevels of envelopes are as follows:

Interchange

Interchange is the outermost level of the envel ope structure, and contains all
the data sent from one sender to one receiver in the same transmission.
Functional group

Functional group isthe next level of envelope structure, and is contained
inside the interchange. The functional group surrounds a group of
transaction sets of the same type.

Transaction set

Transaction sets arethe final level of enveloping inside the functional group.

Transaction sets represent the paper documents that EDI replaces. For
example, a purchase order corresponds to atransaction set. The standards
define each transaction set in terms of the segments and elements that make
up the document, the order in which they appear, and the relationships
among them. Transaction sets are known as “messages’ in Europe.

Segments are like sentences, and they are equivalent to the records in your
application file. In the structure of EDI, the segments are groups of data
elements that combine to communicate useful data. For example, asingle
data element may contain the number “4.” Though meaningless by itself, in
the proper place in asegment, “4” indicates quantity.

Elements are the smallest piece of usable information defined by the
standards, including a quantity, unit price, or description. An individual
element can have different meanings depending on context, and therefore are
normally not considered to have useful meaning until they are combined into
segments.
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Introducing Sterling Gentran:Director

Overview

Process control

Sterling Gentran
Director Service

Database

Sterling Gentran:Director isacombined system made up of datatranslation,
process control, and communication. It is designed primarily for the
trand ation and communication of EDI, and other similar types of data.

Through the process control system, you can integrate Sterling
Gentran:Director with awide variety of business applications. It acts as an
extension of the application, rather than a cumbersome add-on.

Sterling Gentran:Director also operates in an unattended mode. Audit trails
and message tracking enable you to know precisely where amessageisin
the process, at any time.

Sterling Gentran:Director uses the Sterling Gentran:Director Service, which
controls the execution of communication and transl ation functions.

The database is the Microsoft Access relational database that Sterling
Gentran:Director uses to store system data. The database tables contain
indicators that point to actual datalocated in the system data store. The
system data store is the repository of all shared Sterling Gentran:Director
data.
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Introducing Sterling Gentran:Director

Director

components Thefour main components of the Sterling Gentran:Director user interface
arelisted in the following table;

Component

Description

Electronic Commerce (EC)
M anager

A data management component that serves as a high-level
navigation tool and document management tool. It contains
many windows, browsers, and dialog boxes for viewing and
mai ntai ning documents, interchange, audit, reporting, process
control, communications, and translation object information.

The EC Manager also provides access to the Partner Editor and
Document Editor.

Partner Editor

A tool that allows you to define, edit, and delete all partner
information for your company and for your trading partners.

Document Editor

A data entry tool that allows you to create, modify, and view
documents.

System Configuration

Enables you to modify system-wide configuration parameters
after Sterling Gentran:Director isinstalled, including the
following:

B System directories

System import specifications

Splitter options

Users

Stop and start the Sterling Gentran:Director service

Additional

components EDI message standards

The Integration components also allow you to access EDI message standards
to use for creating new translation objects. The EDI message standards files
can be accessed from Compact Disc (CD) or transferred to a hard drive on
your machine.
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Thefollowing tablelists additional componentsthat can be purchased. These
components can be accessed through the EC Manager:

Component Description
Application Integration Enables you to generate import, export, and document
turnaround translation objects.
Note

When the Application Integration trandl ation objects
are registered with Sterling Gentran:Director and
selected as part of atrading relationship, they allow you
to do the following:

B Outbound mapping - translate your application
filesto EDI standard formats for documents that
you send your partners.

B [nbound mapping - translate EDI standard formats
to your application format for documents that you
receive from your partners.

Forms Integration Enables you to generate screen entry and print
trand ation objects.

Note

When the Forms I ntegration transl ation objects are
registered with Sterling Gentran:Director and selected
as part of atrading relationship, they allow you to
facilitate the keying and printing of EDI documentsthat
you send or receive.

Accum Tracking Extension | Enables you to do the following:

B Define and maintain trackable items
B Maintain the associated counts
B Report on trackable items

Transaction DataFile(TDF) | Enablesyou to do the following:

Integration B Create animport or export translation object so you
can use TDF with Sterling Gentran:Director. TDF
isaflat file representation of an EDI standard
document.

B Print adetailed report of the TDF layout of any
EDI standard.
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Navigating Sterling Gentran:Director

Navigating Sterling Gentran:Director

Overview

You can access functionality on the Sterling Gentran:Director EC Manager
window in the following ways:

Clicking amenu option from the Main Menu Bar
Clicking a button on the Main Toolbar

Clicking on the Browser Toolbar

Clicking a part of The Desk

Clicking a button within the chosen browser window

IBM Sterling Gentran:Director User Guide May 2011 1-15



Navigating Sterling Gentran:Director

Getting Started

Main window

The Sterling Gentran:Director EC Manager window is displayed as follows:

Control Menu

|  GENTRAN:Director

File Edit “iew Document Commands  Tools

Title Bar

Window Help

Minimize/Maximize Buttons

&

IIEIW:“’H“"III-ﬁlll'ilil!5

)

=
8

: Partners
b In Drrawer

Int Out ?
Workspace
Transmit

Process Comtrol

Interchanges
Out Drawer

Help Exit

May 2

011

|For Help, press F1 [ [NUOM 4
— Browser Toolbar
—— Main Menu Bar Status Bar The Desk Main Toolbar
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Getting Started Navigating Sterling Gentran:Director

Components , . : , .
The main components of the Sterling Gentran:Director window include the

following:

H  Control menu

Title bar

Minimize and maximize buttons
Main menu bar

Main toolbar

Browser toolbar

The Desk

Status bar

Control menu

The Control Menu contains the following commands: Restore, Move, Size,
Minimize, M aximize, and Close.

Title bar

The Title Bar contains the name of the application. Clicking on the title bar
and dragging allows you to move the Sterling Gentran: Director EC Manager
window on your desktop.

Minimize/Maximize buttons

The Minimize button reduces the window to an icon. The Maximize button
enlarges the window to its maximum size.

Main menu bar

The Main Menu Bar contains the drop-down menus. Unavailable items are
dimmed. For a detailed description of the commands contained in each
menu, refer to the online Help.
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Navigating Sterling Gentran:Director Getting Started

Main toolbar

The Main Toolbar provides access to some of the most common browsers
and functions in Sterling Gentran:Director. Unavailable items are dimmed.
The Main Toolbar isillustrated below:

Send Send and  Process Forms
Out Documents Queue Translation Receive  Control Integration

?In Documents Out Drawer Object Partner
’ ‘ Wizard

Workspace

| »58 8B ot » B &« B8 d OB\ G5
|

In Documents

| | ‘ ‘
?0ut Documents Processing Clos
System Application

Configuration Integration
Accum Tracking

In Drawer Interchanges Audit Log

Browser toolbar

The Browser Toolbar provides access to functions that are available from
browsersin Sterling Gentran:Director. Unavailable items are dimmed. The
Browser Toolbar isillustrated below:

Post
Delete View Copy Translator Report
NTW ‘ Export Document Sort/Filter Acknowledge
mERERIEE ERRE i B[R]
|

Im|‘oort Co|py Respond Data  Toggle
Open . Interchange

p Print Move to Attach Status

In Drawer

1-18 May 2011 IBM Sterling Gentran:Director User Guide



Getting Started Navigating Sterling Gentran:Director

The Desk

The Desk is agraphical representation of the Sterling Gentran:Director
components and document locations. It provides you with a quick and easy
way to access some of the most commonly used browsers, functions, and
subsystems of Sterling Gentran:Director. Click the appropriate part of The
Desk any time you need to access a browser, function, or subsystem
represented on The Desk.

Some of the browser icons display a graphical representation of paper if the
document location contains documents. The Desk also allows you to access
the Partner Editor subsystem, the online Help system, the Process Control
function (clock icon), and the Send/Receive functions (phone icon). Click
the Exit/Door icon to quit Sterling Gentran:Director.

Status bar

The Satus Bar does the following:

B Displays status information about a selection, command, or process.
B Defines menu items as you highlight each item in the menu.

B Indicatesany current keyboard-initiated modes for typing. For example,
CAP is used to represent the “ Caps Lock” key, and NUM to represent
the “Num Lock” key.
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Overview

Using Translation Objects

Overview

In this chapter

Translation

object definition

Creating
translation
objects

Types of
translation
objects

This chapter describes how to use trandlation objects with Sterling
Gentran:Director.

A trandation object isaset of definitions, links, and rules that combine to
provide the trand ator with all the information necessary to convert datafrom
one format to another. Tranglation objects are used in Sterling
Gentran:Director to control the processing of the trandator subsystem.

Translation objects are created by compiling an application map or aform
definition using the Sterling Gentran:Director Application or Forms
Integration subsystem. For more information, see the IBM® Serling
Gentran: Director® Application Integration User Guide and IBM® Serling
Gentran: Director® Forms Integration User Guide.

There are two types of transation objects: system trandlation objects and
user trandlation objects.

System translation objects

System translation objects control the creation and separation of
interchanges, functional groups, and transaction sets. They are also used to
generate and reconcile functional acknowledgments. All the required system
trangl ation objects are automatically installed with the Sterling
Gentran:Director system.

User translation objects

User translation objects control screen entry, importing, exporting, and
creating printed reports.
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Registering (Installing) a New Translation Object

Introduction , . . : :
The Register Tranglation Object function enables you to register your

tranglation object file with Sterling Gentran:Director so the system can use
the trandation object to translate data.

Procedure ) . . :
To register atranslation object, complete the following steps:

Step Action

1 From the View menu, select TRANSLATION OBJECTS.

System Response
The EDI Translation Objects browser is displayed.

{ EDI Translation Ohject - 70

IType Description Used | WiEw.
|mport ACKBUILD_ 997 Sv5® e Print...
Impuort ACKBUILD_999 SvS —
Impert ACKBUILD_ACT 55 Deletz
Impuort ACKBUILD_CONTRL SvS Mew...
Impuort ACKBUILD_TA1 SvS
Expaort ACKBREAK_997 SvS Sort..
Expaort ACKBREAK_939 SvS
Expaort ACKBREAK_ACT SvS
Expaort ACKBREAK_CONTRL SvS
Expaort ACKBREAK_Ta1 SvS
Export Tradacoms Reports Mo
TranzactionBuild MHD Build Template 5YS
TranzactionBuild ST Build Template - AMSI SY5® =l Eiliadh
Claze
70 Translation 0 zelected
Help

Continued on next page
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Registering (Installing) a New Translation Object

Using Translation Objects

(Cont.)
Step

Action

Click NEw.

System Response
The Register Translation Object dialog box is displayed.
(2] ]

o & e e

Register Tranzlation Object

I 4 Trans0bj

Look jr:

File name: I

j Cancel |
Help |

Files of type: ITransIation Objects [*.tpl]

Select the trandation object file that you want to register
with the system from the list, or typeit in the File name box.

Note

To highlight a group of translation objects, click on thefirst
tranglation object, pressthe SHIFT key, and then click on
the last tranglation object in the group. To highlight several
tranglation objects that are not adjacent to each other, press
and hold the CTRL key while clicking on each trandation
object.

Click OPEN.

System Response

The trandlation object files are registered and the Register
Tranglation Object dialog box is closed.

Notes

W |f the selected fileisinvalid, you receive awarning
message. Only valid Sterling Gentran:Director
translation object files can be installed.

W [f the trandlation object is aduplicate, you are prompted
with a message asking whether or not you want to
overwrite the existing translation object.

May 2011
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Using Translation Objects

Deleting Translation Ob

jects

Deleting Translation Objects

Introduction

You can delete old or unused translation objects from the system only if they
are not currently associated with an Inbound or Outbound Partner
Relationship. Trand ations objects shown with “No” in the Used column are

not associated. The system also prevents you from deleting tranglation
objects that are designated as “ system translation objects.” These are shown
as“SYS*” or “SYS.”

Procedure

To delete atranglation object, complete the following steps:

Step

Action

1

From the View menu, select Translation Objects.

System Response
The EDI Translation Objects browser is displayed.

¢+ EDI Translation Ohject - 70

IT_l,lpe Description Uszed | WIE.
|mpork ACKBUILD 937 Sv5® i Prit..
Impaort ACKBUILD_999 SvS ——
Import ACKBUILD_ACT 575 Delets
Impaort ACKBUILD_COMNTRL SvS Mew...
Impaort ACKBUILD_TaA1 SvS —
Export ACKBREAK_997 S5 Sait..
Export ACKBREAK_999 SvS
Export ACKBREAK_AC1 SvS
Export ACKBREAR_COMTRL SvS
Export ACKBREAK_Ta1 SvS
Export Tradacoms Reports Mo
TranzactionBuild MHD Build Template 5YS
TranzactionBuild ST Build Template - AMSI S5 =l Er—

Cloze

70 Translation 0 selected

Help

Select the trand ation object or objects you want to delete.

Click DELETE.

System Response
The Delete confirmation dialog box is displayed.

Click YEs to confirm the deletion.

IBM Sterling Gentran:Director User Guide
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Sorting Translation Objects

Overview _ _ . :
You can use the Sort function on the EDI Translation Objects dialog box to

arrange the columns of the translation objects into one of the following
sequences:

B Group by Type - Sorts the trandation objects al phabetically by type

B Sort by Description - Sorts the trandl ation objects a phabetically by
description

Procedure _ _ .
To sort trandlation objects, complete the following steps:

Step Action

1 From the View menu, select Trandlation Objects.

System Response
The EDI Trandlation Objects browser is displayed.

{ EDI Translation Ohject - 70

IType Description Used | WiEw.
|mport ACKBUILD_ 997 Sv5® e Print...
Impuort ACKBUILD_999 SvS —
Import ACKBUILD_AC 5Y5 Delste
Impuort ACKBUILD_CONTRL SvS Mew...
Impuort ACKBUILD_TA1 SvS —_—
Export ACKBREAK_997 S5 Sait..
Expaort ACKBREAK_939 SvS
Expaort ACKBREAK_ACT SvS
Expaort ACKBREAK_CONTRL SvS
Expaort ACKBREAK_Ta1 SvS
Export Tradacoms Reports Mo
TranzactionBuild MHD Build Template 5YS
TranzactionBuild ST Build Template - AMSI SY5® =l Eiliadh
Close
70 Translation 0 zelected
Help

Continued on next page
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Using Translation Objects

Sorting Translation Obj

ects

(Cont.)
Step

Action

Click SoRT.

System Response
The Sort Translation Objects dialog box is displayed.

Sort Translation Ohbjects

— Sort Order
¥ Group by Type

= Sark by Description

— Filter
[~ Hide Systemn Tranzlation Objects

Click the radio button for the appropriate sort order.

Deselect the Hide System Trandlation Objects check box to

display system trandlation objects. The system translation
objects are hidden by default.

Click OK to sort the list of translation object(s) into the
specified sort order.
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Overview Maintaining Partner Relationships

Maintaining Partner Relationships

Overview

In this chapter _ , , . .
This chapter describes the following tasks for creating and maintaining

partner relationships:

Defining partner defaults
Using the Partner Wizard
Setting up partner profiles
Routing partner profiles
Using partner tables
Using partner locations

Partner relationships are based on how you and your trading partner
exchange EDI data. Sterling Gentran:Director enables you to install custom
datato simplify the process. To create partner relationships, two tools are
provided: the Partner Wizard and Partner Editor.

Quick Partner _ _ .
The Quick Partner function enables you to establish default valuesto be used

when adding new partner profiles or relationships using the Partner Wizard
or Partner Editor. This function significantly simplifies and quickens the
creation of partner profiles and relationships.

Partner Wizard o ,
The Partner Wizard is an easy-to-use method for adding new partners and

new partner relationships to the system, and is designed for the novice EDI
user. Thistool walks you through the creation of new partner profiles,
inbound relationships, and outbound relationships. Partner Wizard also
automatically creates the appropriate acknowledgment for inbound and
outbound documents.
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Maintaining Partner Relationships Overview

Partner Editor o _
Partner relationships allow you to send and receive datato and from your

trading partners.The Partner Editor allows you to define, edit, and delete all
partner relationship information for your company and your trading partners.

The Partner Editor also allows you to use an internal system partner
(<Internal System User>) to define your company to the system.
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Maintaining Partner Relationships

Setting Up Partner Profiles

Overview

Introduction

You can set up your partner profiles by using one of three methods:
importing, copying, or creating them yourself. The method you use depends
on whether you have a partner profile to use as a starting point. Use the
following table to decide which method to use:

Partner profile
creation method

When to use

Import existing profile

Use this method if you receive partner profiles
from IBM or if you have an existing profile
from which you can import partner details. The
profile can be exported from another copy of
the Sterling Gentran:Director system.

Reference

For more information, see Importing a Partner
Profile on page 3 - 61.

Copy existing profile

Use this method when you have an existing
profile that you can copy. You must then enter a
unique partner definition and key enveloping
information for the copied partner.

Reference

For more information, see Copying a Partner
Profile on page 3 - 66.

Create anew profile

Use this method when you do not have aprofile
to import or copy.

Reference

For more information on how to create a new
partner profile, see Defining a partner profile
on page 3 - 6.
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Partner definition . N _— _—
A partner profile begins with a partner definition. The partner definition

contains the basic information about a partner that the system needs before
you can define the rest of the partner profile.

Note

You need to create a partner definition for each partner with whom you are
going to exchange data.

Partner profile _ . .
To complete the partner profile, you need to define an inbound or outbound

relationship, or both.

B |f you are receiving and processing information from this trading
partner, you need to define an inbound relationship.

B |f you are sending information to thistrading partner, you need to define
an outbound relationship.

Note

You need to create a partner profile for each partner with whom you are
going to exchange data.
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Defining a
partner profile Thefollowing table describes the process for creating a partner profile.

Stage Description

1 Define default values that will be used each time you create a new partner relationship.
Note

You define partner defaults one time only.

Reference

For more information, see Using Quick Partner to Define Defaults on page 3 - 7.

2 Use this table to determine the next stage.

IF you need to... THEN use...

B create abasic partner definition the Partner Wizard
create an inbound relationship
B create an outbound relationship

Reference

For more information, see Using the Partner
W zard on page 3 - 26.

B  modify existing partner profiles the Partner Editor
B  modify existing partner

. ) Reference
relationships . . .
B usepartner tables Fort_more information, see the appropriate
section:

B use partner locations
B set up advanced options such as B Editing or Deleting a Partner Definition on
control numbers or page 3 - 58
acknowledgment options B Setting Up Partner Profileson page 3 - 4
B Using Partner Locations on page 3 - 87

3 Do you need to use a Cross-reference or Lookup table with the partner relationship in
order to supplement or convert data entered or received inbound?

B |f yes, see Creating a Table on page 3 - 71 for more information.
B |f no, continue with stage 4.

4 Do you need to use locations to contain address and contact-related information about
the partner?

B If yes, see Creating Partner Locations on page 3 - 88 for more information.
B |f no, you have completed the partner profile definition process.
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Using Quick Partner to Define Defaults

Introduction , , _
The Quick Partner function enables you to establish default values that are

used when adding new partner profiles or relationships with the Partner
Wizard. These values will not affect existing partner profiles or
relationships.

Recommendation

Use this function prior to setting up partner profiles and significantly
simplify and quicken the creation of partner profiles and relationships.

Quick Partner

Defaults dialog There are three defaults sets of values you can establish with the Quick
box Partner Defaults dialog box:

B Sender ID enables you to set up default sender ID values for outbound
data.

B Inbound enables you to set up default values for inbound relationships.

B Outbound enables you to set up default values for outbound
relationships.

You can complete default values for any one of these sections, or for all
three.
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Using Quick Partner to Define Defaults Maintaining Partner Relationships

Accessing the dialog box
To access the Quick Partner Defaults dialog box:

1. From the Tools menu, select Partner Editor.

2. Click DEFAULTS.

The Quick Partner Defaults dialog box is displayed.

Changing the Quick Pariner default values will not change the values for
eristing partner definitions. Quick Partner Defaults ars used when adding
new partner definitions thiaugh the Partner Wizard.

Sender 1D

@ This aption will allow pou to set up the Quick Partner

default values for your Sender 1D
Sender ID...

W This option will alow you to set up the Quick Partner
47  cefault values forinbound relatianships

Inbound..

Outhound

A This option will allow you to set up the Quick Partrer
No%  default values for autbound relationships.

Dutbound..

Parts and functions

The following table lists the parts of the Quick Partner Defaults dialog box
and their functions:

Part Function

SENDER ID Accesses the Quick Partner Sender ID Setup
dialog box.

INBOUND Accesses the Quick Partner Inbound
Defaults dialog box.

QUTBOUND Accesses the Quick Partner Outbound
Defaults dialog box.

CLOSE Exits the Quick Partner Defaults dialog box.
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Using Quick Partner to Define Defaults

Sender ID Setup

dialog box The Quick Partner Sender ID Setup dialog box enables you to set up default
sender ID values for outbound data.

Accessing the dialog box

From the Quick Partner Defaults dialog box, click SENDER ID. The Quick
Partner Sender ID Setup dialog box is displayed.

Quick Partner Sender ID Setup E2

Enter the Group and Interchange Sender 10 /Qualifier that will be used
as the Quick Partner default values for outbound data,

— Group
Sender |D: I
Qualifier:* I—
* Mote that the Group Qualifier is used with the
EDIFACT and ODETTE standards only.
i~ Interchange
Sender |D: I
Qualifier: I

oK I Cancel |

Help

Parts and functions

The following table lists the parts of the Quick Partner Sender ID Setup
dialog box and their functions:

Part

Function

Group Sender 1D

I dentifies your company in outgoing groups
(as defined by the standards).

Group Qualifier

Qualifiesthe group Sender ID (as defined by
the standards).
Note

Used with EDIFACT and ODETTE
standards only.

Interchange Sender ID

The value that identifies your company in
outgoing interchanges (as defined by the
standards).

Continued on next page
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Maintaining Partner Relationships

Inbound Defaults

dialog box

Part

Function

Interchange Qualifier

Qualifies the interchange Sender ID (as
defined by the standards).

OK Saves the values and closes the Sender ID
Setup dialog box.

CANCEL Closes the Sender ID Setup dialog box
without saving values.

HELP Accesses context-sensitive help on the

Sender ID Setup dialog box.

The Quick Partner Inbound Defaults dialog box enables you to set up default

values for inbound relationships.

Accessing the dialog box

From the Quick Partner Defaults dialog box, click INBOUND.The Quick
Partner Inbound Defaults dialog box is displayed.

Quick Partner Inbound Defaults B

NSl | EpiFacT | opETTE | TDCE | TRADACEMS | UCs | wics |

—Sequence Checking

How should GEMTRAN:Director sequence check Tranzactions?

& None
 Duplicate
" Incremental £ [rsremental

" Chiondlogical | € Chionological e j' Eammat

I™ Reject Duplicate Documents

" Sequence from Group

— Acknowledgements
Acknowledge Transactions?
& No
1 e - o Erron Detal
) e - /it Erron Dietai

How should GEMTRA&N:Director sequence check Groups?
& None
 Duplicate
 Incremental
" Chronalogical

Acknowledge Groups?

& No
Ve

How should GEMTRAN:Director sequence check Interchanges?

Acknowledge Interchange?

' Nane & Ho
 Duplicate © Yes
€ Incremental
" Chronaological
Caricel Appll Help
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Parts and functions

The Quick Partner Inbound Defaults dialog box has atab for each EDI
standard. The options that are available on each tab are determined by the
EDI standard. If an option is unavailable, it is not required by that standard.

The following table lists the parts of the Quick Partner Inbound Defaults
dialog box and their functions:

Part

Function

Transaction Sequence
Checking option

Instructs the system whether to expect afunctional acknowledgment
from your trading partner.

Note

When you are setting up sequence checking options, note that if the
system detects duplicate control numbers, or detects incremental or
chronological control numbers that are out of sequence, those
documents are located in ?ln Documents.

Values

B None - Sequence checking will not be used.

B Duplicate - Check for duplicate control numbers.

B |ncremental -The control number must be one greater than the last
numbey.

B Chronological - The control number must be greater than the last
numbey.

Note
These options are disabled if Sequence from Group is selected.

Sequence from Group

Indicates whether the transaction set control numbering options for this
group setup should be controlled at the group level.

Incremental or
Chronological option

Specifies how you want sequence checking to be used.

Values

B |ncremental - The control number must be one greater than the last
numbey.

B Chronological - The control number must be greater than the last
numbey.

Note

These options are disabled if Sequence from Group is not selected.
Continued on next page
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Maintaining Partner Relationships

(Cont.)
Part Function
Format Indicates the format of the transaction set control number that the
system will generate.
Values
Normal  The number is generated by incrementing the last used
control number. The length of the number is defined by the
standard.
6/3 The number is acomposite of two numbers. Thefirst six
digits are the last six digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. Use this format only as
instructed by your trading partner.
5/4 The number is acomposite of two numbers. Thefirst five
digits are the last five digits of the functional group control
number. The last four digits are a counter beginning at “1”
within the functional group. Thisisthe normal TDCC
numbering convention. It is used by the Motor, Rail, and
Ocean transportation industries.
5/3 The number is acomposite of two numbers. Thefirst five
digits are the last five digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. Thisisthe normal UCS
convention, which is used by the Grocery and Warehousing
industries.
Note
Thislist is disabled if Sequence from Group is not selected.
Reject Duplicate Instructs the system to check for duplicate document names, and then
Documents reject those documents.
Group Sequence Indicates how the system should sequence check groups.

Checking option

Values

None - Sequence checking will not be used.

Duplicate - Check for duplicate control numbers.

I ncremental -The control number must be one greater than the last
number.

Chronological -The control number must be greater than the last
number.

Continued on next page

May 2011 IBM Sterling Gentran:Director User Guide
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(Cont.)
Part

Function

Transaction Sequence
Checking option

Indicates how the system should sequence check interchanges.

Values

B None - Sequence checking will not be used.

B Duplicate - Check for duplicate control numbers.

B Incremental - The control number must be one greater than the last
number.

B Chronological - The control number must be greater than the last
number.

Acknowledge
Transactions option

Instructs the system to generate a functional acknowledgment to this
trading partner when you receive the transaction set defined in this
relationship.

Values

B No- Do NOT generate acknowledgments

B Yes- No Error Detail - Generate acknowledgments without error
detail

B Yes- With Error Detail - Generate acknowledgments with error
detail

Acknowledge Group Instructs the system to generate a functional acknowledgment to this
option trading partner when you receive the group defined in this relationship.
Acknowledge Instructs the system to generate a functional acknowledgment to this

Interchange option

trading partner when you receive the interchange defined in this
relationship.

OK Saves the values and exits the Inbound Defaults dialog box.
CANCEL Exits the Inbound Defaults dial og box without saving values.
HELP Accesses context-sensitive help on the Inbound Defaults dialog box.
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Outbound

Defaults dialog The Quick Partner Outbound Defaults dialog box enables you to set up
box default valuesfor Outbound relationships.

Accessing the dialog box

From the Quick Partner Defaults dialog box, click OuTBOUND.The Quick
Partner Outbound Defaults dialog box is displayed.

Quick Partner Dutbound Defaults [ ]
ANsI | EpiFacT | ODETTE | TOCC | TRADACOMS | UCS | wiCs |
— Sequence Checking  Transaction Contral Mumbers—

Should GEMTRAM: Directar expect an Acknowledgement by Transaction
& No
Ve Hioure Hyerdue: I48 ™ Reject Duplicates ™ Sequence Fram Group

Should GEMTRAM:Directar expect an Acknowledgement by Group? llz= I j' FEarmat
& Mo

' es s verdie: I48

Should GEMTRAM: Director expect an Acknowledgement by Interchange?

& Mo
© Yes bl s Wverdue: I48
1S4 Envelop:
Elemert Separator: Text l*— IK Hex Segment Terminator: Text l"— lf Hex
Sub-Element Separator:  Text |>_|¥ Hex ™ Acknowlegement Requested
i~ ICS Envelope
Element Separator: Text I_ IK Hex
Segment Terminator: Text I"_lf Hex I Acknowlegement Fequested

Cancel Apply Help
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Parts and functions

The Quick Partner Outbound Defaults dialog box has atab for each EDI
standard. The options available on each tab are determined by the EDI
standard. If an option isunavailable, it is not required by that standard.

The following table lists the parts of the Quick Partner Outbound Defaults
dialog box and their functions:

Part

Function

Transaction
Acknowledgment option

Instructs the system to expect an acknowledgment from your trading
partner when they receive the transaction set defined for the
relationship.

Hours Overdue
(transaction)

Defines how many hours must elapse before the expected
acknowledgment is considered overdue.

Note

The default value for the Hours Overdue box is* 48", indicating that the
acknowledgment is considered overdue in two days. If you enter avalue
of “0" (zero), the acknowledgment isimmediately considered overdue.

Reject Duplicates

Instructs the system to check for duplicate document names, and then
reject those documents.

Group Acknowledgment
option

Instructs the system to expect an acknowledgment from your trading
partner when they receive the group defined for the relationship.

Hours Overdue (group) Defines how many hours must elapse before the expected
acknowledgment is considered overdue.
Interchange Instructs the system to expect an acknowledgment from your trading

Acknowledgment option

partner when they receive the interchange defined for the relationship.

Hours Overdue
(interchange)

Defines how many hours must elapse before the expected
acknowledgment is considered overdue.

Sequence From Group

Instructs the system to manage transaction set control numbering
options at the group level.

Continued on next page
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Maintaining Partner Relationships

(Cont.)
Part Function
Format Defines the format of the transaction set control number that the system
generates.
Values
Normal  The number is generated by incrementing the last used
control number. The length of the number is defined by the
standard.
6/3 The number is a composite of two numbers. The first six
digits are the last six digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. Use this format only as
instructed by your trading partner.
5/4 The number is acomposite of two numbers. Thefirst five
digits are the last five digits of the functional group control
number. The last four digits are a counter beginning at “1”
within the functional group. Thisisthe normal TDCC
numbering convention. It is used by the Motor, Rail, and
Ocean transportation industries.
5/3 The number is acomposite of two numbers. Thefirst five
digits are the last five digits of the functional group control
number. The last three digits are a counter beginning at “1”
within the functional group. Thisisthe normal UCS
convention, which is used by the Grocery and Warehousing
industries.
OK Saves the values and closes the Outbound Defaults dialog box.
CANCEL Closes the Outbound Defaults dialog box without saving values.
HELP Accesses context-sensitive help on the Outbound Defaults dialog box.
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Using Quick Partner to Define Defaults

Envelope

definitions If you set defaults for an outbound relationship, you also need to specify
enveloping defaults. The envelope you use depends on the EDI standard.
Thefollowing tableliststhe EDI standards and their corresponding envelope

options.
EDI Standard Envelope you use
ANSI ISA or ICS
EDIFACT UNA
ODETTE UNA
TDCC ISA or BG
TRADACOMS SCH
UCSs ISA or BG
VICS ISA or ICS
IBM Sterling Gentran:Director User Guide May 2011 3-17
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Maintaining Partner Relationships

Envelope
options

The envelope options that you must specify depend on which envelope you
areusing. Thefollowing table definesall Sterling Gentran: Director envelope
options. Refer to the table when completing the envelope information for
outbound relationships.

Envelope option

Definition

Element Separator

Defines the value that separates elementsin an outbound data segment.
This box is mandatory. The value MUST be between HEX “01” and
HEX “FF".

Do one of the following:

B Inthefirst box, type the specia character (*, #, etc.). The system
converts and enters the hex value for that character in the second
box.

B Inthe second box, type the hex value. The system converts and
entersthe specia character for that hex valuein the first box. If there
is no printable character that corresponds to the hex value, the
character box is blank.

Sub-Element Separator

Defines the value that will separate the parts of an outbound element.
This box is mandatory and the value MUST be between HEX “01” and
HEX “FF".

Do one of the following:

B [nthefirst box, type the special character (*, *, etc.). The system
converts and enters the hex value for that character in the second
box.

B |nthe second box, type the hex value. The system converts and
entersthe special character for that hex valuein thefirst box. If there
is no printable character that corresponds to the hex value, the
character box is blank.

Continued on next page
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(Cont.)
Envelope option

Definition

Segment Terminator

Defines the value that identifies the end of an outbound data segment.
This box is mandatory. The value MUST be between HEX “01” and
HEX “FF".

Do one of the following:

B [nthefirst box, type aspecia character. The system converts and
enters the hex value for that character in the second box.

B |nthe second box, type the hex value. The system converts and
entersthe special character for that hex valuein thefirst box. If there
is no printable character that corresponds to the hex value, the
character box is blank.

Acknowledgment
Requested

Instructs the system to require an acknowledgment for the outbound
interchange.

Send UNA Segment

Instructs the system to send the UNA segment.

Component Element

Separator

Defines the value that separates the parts of an outbound element. This
box is mandatory. The value MUST be between HEX “01” and HEX
“FE

Do one of the following:

B [nthefirst box, type the specia character. The system converts and
enters the hex value for that character in the second box.

B |nthe second box, type the hex value. The system converts and
entersthe special character for that hex value in thefirst box. If there
is no printable character that corresponds to the hex value, the
character box is blank.

Decimal Notation

Defines either acomma (“,”) or aperiod (“.") to indicate the decimal
point in anumeric box. This box is mandatory.

Recommendation

“w o

The character (“.”) is recommended.

Release Indicator

Defines a character that restores any character, used as a syntactical
separator, to its original meaning. This box is mandatory.

Send SCH Segment

When selected, the system sends the SCH segment.
Continued on next page
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Maintaining Partner Relationships

(Cont.)

Envelope option

Definition

Sender ID Name

Defines your name as it will appear on the interchange header segment
sent to this Trading Partner.

Segment Code Separator | Defines the value that separates segment codes. This box is mandatory.

The value MUST be between HEX “01” and HEX “FF".

Do one of the following:

B Inthefirst box, type the specia character. The system will convert
and enter the hex value for that character in the second box.

B |nthe second box, type the hex value, and the system will convert
and enter the specia character for that hex valuein the first box. If
there is no printable character that corresponds to the hex value, the
character box is blank.
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Procedure _ . ,
To use Quick Partner to define defaults, compl ete the following steps:

Step Action

Accessing Quick Partner

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

B el B

¥

il

il
i
¥ i

2 Click DEFAULTS.

System Response
The Quick Partner Default dialog box is displayed.

Setting default values for sender IDs

1 Click SENDER ID.

System Response
The Quick Partner Sender ID Setup dialog box is displayed.

2 Complete the Group and Interchange Sender ID and Qualifier
information.

Continued on next page
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Maintaining Partner Relationships

(Cont.)
Step

Action

Click OK.

System Response

The sender 1D information is saved and the Quick Partner ID
Setup dialog box is closed.

Setting default values for inbound relationships

Click INBOUND.

System Response
The Quick Partner Inbound Defaults dialog box is displayed.

Select the tab for the EDI standard you are using to establish
inbound partner relationships.
Note

The optionsthat are available on each tab are determined by the
EDI standard. If an optionsis unavailable, it is not required by
that standard.

Do you want to control transaction set control numbering
options at the group level?

B If yes, continue with steps 5 through 7.

m [f no, continue with step 4.

In the Sequence Checking section, select an option to indicate
whether the system should expect afunctional acknowledgment
from your trading partner. Continue with step 8.

Select Sequence from Group to indicate whether the transaction
set control numbering options for this group setup should be
controlled at the group level. Continue with step 6.

Select the sequence checking option that specifies how sequence
checking should be used. Continue with step 7.

B From thelist in the Sequence Checking section, select the
format of the transaction set control number that the system
generates. Continue with step 8.

Continued on next page
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Using Quick Partner to Define Defaults

(Cont.)
Step

Action

Do you want the system to check for duplicate document names
and reject those documents?

W [f yes, select the Duplicate Documents check box and
continue with step 9.
W [f no, continue with step 9.

B |Inthe Sequence Checking section, select how the system
should sequence check groups. Continue with step 10.

10

B |n the Sequence Checking section, select how the system
should sequence check interchanges. Continue with step 11.

11

Do you want the system to generate a functional
acknowledgment to this trading partner when you receive the
transaction set defined for this relationship?

B [f yes, in the Acknowledgments section, select the
appropriate transaction set option and continue with step 12.
B [f no, continue with step 12.

12

Do you want the system to generate a functional
acknowledgment to this trading partner when you receive the
group defined in this relationship?

B If yes, in the Acknowledgments section, select the Yes
option and continue with step 13.
B If no, continue with step 13.

13

Do you want the system to generate a functional
acknowledgment to this trading partner when you receive the
interchange defined in this relationship?

B If yes, in the Acknowledgments section, select the Yes
option and continue with step 14.
B If no, continue with step 14.

14

Do you have additional EDI standards you need to define?

W [f yes, repeat steps 2 through 13 for each additional EDI
standard you are using to define relationships.

W [f no, click OK to save the inbound relationship information
and exit the Quick Partner Inbound Defaults dialog box.

Continued on next page
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(Cont.)
Step

Action

Setting default values for outbound relationships

Click OQUTBOUND.

System Response
The Quick Partner Outbound Defaults dialog box is displayed.

Select the tab for the EDI standard you are using to establish
outbound partner relationships.

Do you want the system to expect an acknowledgment from
your trading partner when they receive the transaction set
defined in thisrelationship?

B If yes, in the Sequence Checking section:
a.  Select the Yes option.
b. Typehow many hours must elapse before the expected
acknowledgment is considered overdue.
c. Continue with step 4.
® [f no, continue with step 4.

Do you want the system to check for duplicate document names
and reject those documents?

B [f yes, select the Duplicate Documents check box and
continue with step 5.
m [ no, continue with step 5.

Note

When you are setting up duplicate document options, the system
places any duplicate control numbersthat it detectsin ?In
Documents.

Do you want the system to expect an acknowledgment from

your trading partner when they receive the group defined in this

relationship?

B If yes, in the Sequence Checking section, select the Yes
option and continue with step 6.

m [f no, continue with step 6.

Continued on next page
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Using Quick Partner to Define Defaults

(Cont.)
Step

Action

Do you want the system to expect an acknowledgment from
your trading partner when they receive the interchange defined
in this relationship?

B [f yes, in the Sequence Checking section, select the Yes
option and continue with step 7.
W [f no, continue with step 7.

Do you want to manage transaction set control numbering
options at the group level?

m |f yes, complete the following:

a  Select Sequence from Group.

b. From thelist in the Transaction Control Numbers
section, select the format of the transaction set control
number that the system generates.

c. Continue with step 8.

m [f no, continue with step 8.

B Complete the appropriate envelope information, and
continue with step 9.

Reference

For information about envel ope definitions, refer to Envelope
options on page 3 - 18.

B Repesat steps 2 through 8 for each additional EDI standard
you are using to define relationships.

B Click OK to save the inbound relationship information and
exit the Quick Partner Outbound Defaults dialog box.

Saving Quick Partner Defaults

Click CLosE on the Quick Partner Defaults dialog box to exit
Quick Partner.

Note

The established default is used by the system when you create a
new partner profile/relationship using the Partner Wizard.
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Using the Partner Wizard

Introduction

Before you begin

The Partner Wizard is an easy-to-use method for adding new partners and
new partner relationships to the system, and is designed for the novice EDI
user. The Partner Wizard walks you through the creation of new partner
definitions and profiles, inbound relationships, and outbound rel ationships.
Thistool also automatically creates the acknowledgment for inbound and
outbound documents.

Before using Partner Wizard to create a new partner, you must have the
following information:

B The EDI code for the partner.

B The application code used to identify the partner in theimport file. This
application code is needed only if the transactions are processed using
the file Import facility.

B The communication profile name you use to communicate with the
partner.
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Procedure , _
To use the Partner Wizard, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Fartews Foblos

|
|
[Fened. |
nm|
Im.|
[ B |
Liw |
[Setmis | || wowd | [ Bm |

2 Click WIZARD.

System Response
The Partner Wizard dialog box is displayed.

The Pastrer Wizad will gusde you thaough a series of easy
o mMuﬁ:‘. to quickly creste a burines:
m:‘;ﬂbﬂuu-wn”d‘ﬂh udnlunn-'. *

- Fuomm. The Paitne: Pralids 10, Hame, EDD
= Ta add la an exsting peolde: The Padne: Prodile 10
ol ther axisling patne,

=3 For an DUTROUND Nninlnﬂ% The EDI
10°s and/os Qualifiers used for selected
and the description

' the =l
L of the template pou with to uze,

=# For an INBOUND business ielationship: The tree of
o parner will send pou snd the
description of the pou with to use.

To bvgin exmalang o bussinmee selalinship, chek Nests.

cioch [ Wemr ] cancel | Mew |

3 Click NEXT>.

System Response
The Partner Wizard leads you through the necessary stepsto
create anew partner profile or partner relationship.
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Creating a New Partner Definition

Introduction

Before you begin

The partner definition contains the basic information about the partner that
the system needs before you can define the rest of the partner profile.

Before setting up a new partner definition, you must have the following
information:

B The communication profile name you use to communicate with this
partner.
B The EDI code for this partner.

B The application code used to identify this partner in the import file. This
application code is needed only if the transactions are processed using
the file Import facility.
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Procedure _— .
To create a new partner definition, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 |

il
i
¥ i

2 Click NEw.

System Response
The Partner Definition - New dialog box is displayed.

T |
N
N ——
DI Code: | I
pokwntos [

Combok [ 3

3 In the Profile ID box, type a unique alphanumeric Profile ID for
this partner.

Note
Do not use specia characters.

4 In the Name box, type the partner name.

Continued on next page
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(Cont.)
Step

Action

In the EDI Code box, type the EDI identifier for this partner.

Note

The system uses the EDI identifier during inbound processing,
to select the correct partner.

If necessary, in the Application Code box, type an application
code to identify this partner.

Note

The system uses this identifier during outbound import
processing to select the correct partner.

From the Comm. Profile list, select the predefined
communications setup that you are using for inbound and
outbound processing.

Click SAVE.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.

Note

To complete the partner profile you need to define an inbound or
outbound relationship, or both.

B |f you are receiving and processing information from this
trading partner, you need to define an appropriate inbound
relationship. For more information, see Creating a New
Inbound Relationship on page 3 - 31.

B [f you are sending information to this trading partner, you
need to define an outbound relationship. For more
information, see Creating a New Outbound Relationship on
page 3 - 43.
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Creating a New Inbound Relationship

Introduction , . . :
To correctly receive and process information from atrading partner, you

must have an inbound relationship established that defines the parameters
for receiving data files. Each inbound relationship defines which business
documents are received from a partner.

Required
parameters Parameters are required when you create an inbound relationship. These
parameters provide the system with the following information:

B Thetype of datawhich isreceived.
B The criteriathe system usesto validate the information it receives.

B Thefunctiona groups and interchanges in which you expect to receive
the documents.

Translation
objects Eachinbound relationship must have one or more associated inbound
trangl ation objects. These trand ation objects determine how the received
datais processed. You need to specify which trandation objects are used to
define the rules for exporting, printing, and creating turnaround documents.
At aminimum, one translation object must be available.

Note

If this relationship requires a new transation object, you must register that
tranglation object with the system before creating the inbound relationship.
For instructions on how to register trandlation objects, see Registering
(Installing) a New Translation Object on page 2 - 3.
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Inbound groups
and interchanges

You must define or select an inbound interchange and/or inbound functional
group before the system allows you to complete the setup of an inbound
relationship. The inbound functional group defines the format of the
functional group and the parameters that are used to verify it. The inbound
interchange defines the format of the interchange and the parametersthat are
used to verify it.

However, for some transactions, the functional group or interchangeis
optional. If your trading partner has chosen not to useiit, then it is not
necessary for you to select one. Refer to the standards discussed below to
determine whether or not you are required to select an inbound functional
group or interchange.

B For some ANSI X12 documents, the interchange is optional and the
functional group is required. However, for most documents, both an
interchange and functional group are required.

B For TDCC, theinterchangeis optional and the functional group is
required.

B For UCS, theinterchange is required and the functional group isalso
reguired.

B For EDIFACT, theinterchange is required and the functional groupis
optional.

B For ODETTE, theinterchange isrequired and the functional group is
optional.

B For TRADACOMS, the Interchange isrequired and there is no
functional group.

Note

If you do not want to use an optional functional group or interchange, you
must select <none> from the appropriate dialog box to alert the system that
you are not using a group.
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Before you begin _ . N :
Before setting up an inbound relationship, you must have the following

information:
B The EDI standard that you expect from this trading partner. For
example, ANSI.

B The standard version that you expect from this trading partner. For
example, 003020 for ANSI or 090001 for EDIFACT.

B Thecodefor the transaction set you expect from thistrading partner. For
example, “INVOIC” represents an EDIFACT invoice.

B Thetype of functional group and interchange the transaction set is
wrapped in when it is received from this partner.

Inbound

relationship After you complete your implementation planning for this partner, you can
dialog box set uptheinbound relationship by using the Inbound Relationship dialog
box. The Inbound Relationship dialog box controls other subordinate dialog
boxes, which are used to define everything that is necessary to establish the
relationship.
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Defining an

inbound  The process used to define an inbound relationship is explained in the
relationship following table:

Stage

Description

1

Create a new inbound relationship. For more information,
see page 3 - 35.

Select at least one inbound tranglation object.

Create and select at least one inbound group to define how
the document is received from this partner.

Note

Depending on the standards you are using, either the
functional group or interchange may be optional. To
determine what is optional for the standard you are using,
see Inbound groups and interchanges on page 3 - 32.

Create and select at least one inbound interchange to define
how the document is received from this partner.

Note

Depending on the standards you are using, either the
functional group or interchange may be optional. To
determine what is optional for the standard you are using,
see Inbound groups and interchanges on page 3 - 32.

If you are generating functional acknowledgments as aresult
of receiving documents for an inbound relationship, you
must set up the corresponding outbound relationship to
generate the acknowledgments your partner regquests.

Reference

For information about establishing an outbound relationship,
see Creating a New Outbound Relationship on page 3 - 43.
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Creating a New Inbound Relationship

Procedure

To create an inbound relationship, complete the following steps:

Step

Action

Creating a new inbound relationship

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

B Select the partner profile for which you want to create an
inbound relationship.

B Click INBOUND.

System Response

The Inbound Relationship dialog box is displayed.

Inbound Relationship - PETZONE

Relatiorip Deserpios
' B
Standard B
Yersion I
Transaction Set [ [
Blelease [Tzl
[ none selected

[ none selected

Note

You must have already created a partner definition for this
partner. For more information, see Creating a New Partner
Definition on page 3 - 28.

Continued on next page
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(Cont.)
Step

Action

Click NEw.

System Response
The New Inbound Relationship dialog box is displayed.

Mew Inbound Relationship E
Enter new description: :
| Exit |
Help |

In the description box, type a unique relationship name. For
example, Inbound Invoice.

Click SAVE.

System Response

A new inbound relationship is created and the Inbound
Relationship dialog box is displayed.

From the appropriate lists on the Inbound Relationship dialog
box, select the following:

B Standard

B Version

B Transaction Set

B Release -- select for TRADACOMS only

Note

Theinformation required for this dialog box should be
provided to you by your trading partner when they define the
details of the transactions they send to you.

Continued on next page
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Creating a New Inbound Relationship

(Cont.)
Step

Action

Click ADVANCED>> to define parameters that comply with
the processing needs of your partner. These parameters
include Sequence Checking, Last Used Control, Duplicate
Documents, or Generate Acknowledgment.

System Response
The Inbound Relationship dialog box is extended.

Sequence Checking Last Lised Coniral Humber  Generats Acknowlsdgments
@ None | @ No
O Dupliede | = icata Documents | ) Yes - No Exror Detal

O Incremental
© Chronslogical | = Skip Compliance Check C Yes - With Enror Detail

Test Indicator O Test @ Production

Selecting an inbound translation object

On the Inbound Relationship dialog box, click
TRANSLATION.

System Response
The Inbound Tranglation Object dialog box is displayed.

Inbound Translation Objects - PETZONE
Select Trarslation Objects
Tunfround  [<rons 5o | [
EvpotFile  [PET 3030 850 Expont =] ¥iuta &I
Pint [<none: =l —Iadva"CEd a4
Help
Expor File Name
petzone. ord

From the lists, select the translation objects that are required
for thisinbound relationship.

Note

Thelists display all the translation objects registered in the
system that are appropriate for the type of translation object,
such as Export or Print, and the transaction set.

If there are no trandation objects displayed in the lists, no
trandation objects are registered for the document defined in
the relationship.

Continued on next page
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(Cont.)
Step

Action

If you selected an Export File translation object and you want
to export to aspecific file, type the mapped path of that filein
the Export File Name box.

Note
Do not use Universal Naming Convention (UNC) paths.

Click SAVE.

System Response

Your selections are saved and the Inbound Relationship
dialog box is displayed.

Selecting an inbound functional group

On the Inbound Relationship dialog box, click GROUPS to
display alist of existing groups.

System Response

The Inbound Group Select dialog box is displayed.

Inbound Group Select - PETZONE E

Groups: Select |

Inbound %3030 PO Grp

Is the required group in the Groups list?

B If yes, select the group and click SELECT. Select <none>
if you are not using groups. Continue with the Selecting
an inbound interchange section of thistable.

System Response

The highlighted group is selected and the Inbound
Relationship dialog box is displayed.

B |f no, continue with step 3 to create the group.
Continued on next page
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(Cont.)
Step

Action

On the Inbound Group Select dialog box, click NEw.

System Response
The Inbound Group Entry dialog box is displayed.

Inbound Group Entry - PETZ0NE E
Description: I
Standard: 12 Exit |
Wersion: 003030 Advanced »> |
Functional Group |D: IF'D Help |

In the Description box, type the group description.

In the Functional Group 1D box, type theidentification of the
functional group you are specifying.
Note

The EDI standards define which functional group 1D should
be used for each type of document.

If you have more complex requirements for processing the
functional group, click ADVANCED>> to display the full list
of functional group setup options.

System Response

The Inbound Group Entry dialog box is extended.

Sequence Checking Last Lsed Group Contrel Humber:
@ None

O Duplicate

O Incremental
O Chronological

¥ Acknowledge Group
Ack Tranzaction Set D
997

Transaction Control Mumbers

[T Sequence From Group Eormat Last Used Control Mumber.

Sequence Checkin g :gmal
@ Incrementsl T
O Chianclogica e

Group Trans!, Oibj |

L] []

Acknowledge Transl. Obj IAEKBHEAK_SS?

Continued on next page
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(Cont.)
Step

Action

After you set up the required parameters in this dialog box,
click SAVE.

System Response
The information is stored and the Inbound Group Select
dialog box isdisplayed.

B Highlight the new group.
B Click SELECT.

System Response
The group is selected and the Inbound Relationship dialog
box is displayed.

Selecting an inbound interchange

On the Inbound Relationship dialog box, click
INTERCHANGES.

System Response
The Inbound Interchange Select dialog box is displayed,
showing alist of existing interchanges.

Inbound Interchange Select - PETZ0ME E

Interchanges: Select |

< NONES
Inbound 3030 PO Int

Inbound $3040 PO |nt

Isthe required interchange in the Interchanges list?

B If yes, select the interchange and click SELECT. Select
<none> if you are not using groups. Continue with the
Finalizing the inbound relationship section of thistable.

System Response
The highlighted interchange is selected and the Inbound
Relationship dialog box is displayed.

® If no, continue with step 3 to create the interchange.

Continued on next page
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(Cont.)
Step

Action

On the Inbound Interchange Select dialog box, click NEw.

System Response
The Inbound Interchange Entry dialog box is displayed.

Inbound Interchange Entry - PETZ0MNE [x]
Description: I
Standard: W12 Exxit |
Versian: 002020 Advanced »> |
Interchange 1D: 154 - Help |

In the Description box, type the interchange description.

In the Interchange ID box, select the identification of the
interchange you are specifying.

Note

The EDI standards define which interchange 1D should be

used for each type of document. See Envelope definitions on
page 3 - 17 for details.

If you have more complex requirements for processing the
interchange, click ADVANCED>> to display the full list of
interchange setup options.

System Response
The Inbound Interchange Entry dialog box is extended.

Seguence Checking  Last Used Control Mumber: [ Acknowledgs Interchangs
@ Mone I

O Duplicate Ack Tranzaction Set [D:

O Imeremental

O Chronclogical

Interchange Transl. Obj. I |£I
Bl

Acknowledge Transl. Obj. I

Continued on next page

IBM Sterling Gentran:Director User Guide May 2011 3-41



Creating a New Inbound Relationship

Maintaining Partner Relationships

(Cont.)
Step Action

7 After you set up the required parameters in this dialog box,
click SavEe.
System Response
Theinformation is stored and the Inbound | nterchange Sel ect
dialog box is displayed.

8 B Highlight the new interchange.
B Click SELECT.
System Response
Theinterchange is selected and the Inbound Relationship
dialog box is displayed.

Finalizing the inbound relationship

1 On the Inbound Relationship dialog box, click SAVE.

2 Click ExIT.
System Response
The Partner Editor dialog box is displayed.
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Creating a New Outbound Relationship

Introduction . _ . :
To correctly send information to atrading partner, you need to define an

outbound rel ationship. Outbound rel ationships define the parameters needed
to send adatafile to atrading partner. Each outbound relationship defines
the format of a single business document, and how that business document is
formatted and sent to the specified trading partner.

Required
parameters Parameters are required when you create an outbound relationship. These
parameters provide the system with the following information:

B How to create the required message.
B The criteriathat the system uses to validate the information entered.

B How to create the functional group and interchange envelopesin
preparation for sending.

Translation
objects Each outbound relationship must have one or more associated outbound
tranglation objects. These trandlation objects determine how the sent datais
formatted. You need to specify which translation objects are used to define
therules for screen entry or file import. At a minimum, one translation
object must be available.

Note

If this relationship requires a new trandation object, you must register that
trandlation object with the system before creating the outbound relationship.
For instructions on how to register trandlation objects, see Registering
(Installing) a New Translation Object on page 2 - 3.
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Outbound

groups and You must define or select an outbound interchange and/or outbound
interchanges functiona group before the system allows you to complete the setup of an
outbound relationship. The outbound functional group defines the format of
the functional group and the parameters that should be used to verify it. The
outbound interchange defines the format of the interchange and the
parameters that should be used to verify it.

For some transactions, the functional group or interchange is optional. If
your trading partner has chosen not to useit, then it is not necessary for you
to select one. Refer to the standards discussed bel ow to determine whether or
not you are required to select an outbound functional group or interchange.

B For some ANSI X12 documents, the interchange is optional and the
functional group is required. However, for most documents, both an
interchange and functional group are required.

B For TDCC, theinterchangeis optional and the functional group is
required.

B For UCS, theinterchange is required and the functional group is also
required.

B For EDIFACT, the interchange is required and the functional group is
optional.

B For ODETTE, theinterchangeis required and the functional group is
optional.

B For TRADACOMS, the Interchange is required and there is no
functional group.

Note

If you do not want to use an optional functional group or interchange, select
<none> from the appropriate dialog box to alert the system that you are not
using a group.
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Before you begin _ L _
Before setting up an outbound relationship, you must have the following

information:
B The EDI standard that this trading partner expects. For example,
ANSI X12.

B The standard version that this partner expects. For example, 003020 for
ANSI or 090001 for EDIFACT.

B The code for the transaction set you use. For example, “INVOIC”
represents an EDIFACT invoice.

B Thetype of functional group and interchange envel ope the transaction
set iswrapped in when it is sent to this partner.

Outbound

relationship After you complete your implementation planning for this partner, you can
dialog box set up the outbound relationship by using the Outbound Relationship dialog
box. The Outbound Relationship dialog box controls other subordinate
dialog boxes, where you define everything that is necessary to establish the
relationship.
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Defining an
outbound The process you use when defining an outbound relationship is explained in
relationship thefollowing table:

Stage Description
1 Create a new outbound relationship. For more information,
seepage 3 - 47.
2 If you are using the EDIFACT, ODETTE, or TRADACOMS

standard, you must complete the envelope (header)
information for this type of document. See Envelope
definitions on page 3 - 17 for details.

3 Select at least one outbound translation object.

4 Create and select at least one outbound group (including
enveloping information) to define how the document is
received from this partner.

Note

Depending on the standards you are using, either the
functional group or interchange may be optional. To
determine what is optional for the standard you are using,
see Outbound groups and interchanges on page 3 - 44.

5 Create and select at least one outbound interchange
(including enveloping information) to define how the
document is received from this partner.

Note

Depending on the standards you are using, either the
functional group or interchange may be optional. To
determine what is optional for the standard you are using,
see Outbound groups and interchanges on page 3 - 44.
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Creating a New Outbound Relationship

Procedure

Stage

Description

If you are receiving functional acknowledgments as a result
of sending documents for an outbound relationship, part of
establishing that outbound relationship is setting up the
corresponding inbound relationship to receive the
acknowledgments from your partner.

Reference

For information on how to establish an inbound relationship,
see Creating a New Inbound Relationship on page 3 - 31.

To create an outbound relationship, complete the following steps:

Step Action
Creating a new outbound relationship
1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.
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(Cont.)
Step Action
2 B Select the partner profile for which you want to create an
outbound relationship.
B Click OUTBOUND.
System Response
The Outbound Relationship dialog box is displayed.
[ . =
Sz | New
Version = T
Transacion Bt [ = Translion...
Helease l_;l Ervelope
Advanced »>
Help
(Eifee [none selected ]
Interchannes | [ none selected ]
Note
You must have aready created a partner definition for this
partner. For more information, see Creating a New Partner
Definition on page 3 - 28.
Continued on next page
3 Click NEw.
System Response
The New Outbound Relationship dialog box is displayed.
Enter new description:
| E it |
Help |
4 In the description box, type a unique relationship name.

May 2011
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Maintaining Partner Relationships

Creating a New Outbound Relationship

(Cont.)
Step

Action

Click SAVE.

System Response

A new outbound relationship is created and the Outbound
Relationship dialog box is displayed.

From the appropriate lists on the Outbound Relationship
dialog box, select the following:

m Standard

m Version

B Transaction Set

B Release -- select for TRADACOMS only

Note

Theinformation required for this dialog box should be
provided to you by your trading partner when they define the
details of the transactions they send to you.

Continued on next page

Click ADVANCED>> if you need to define parameters that
comply with the processing needs of your partner.These
parameters include Last Used Control Number, Expect
Acknowledgment, Hours Overdue, Duplicate Documents, or
Test Indicator.

System Response

The Outbound Relationship dialog box is extended.

Last Uzed Control Mumber: I nooo

[~ Ewpect Acknowledgement [ Dluplicate Documerts

Howrs Oxerdue: I Test Indicator: | O Test @ Productior

Continued on next page
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(Cont.)
Step Action

Selecting a transaction envelope (EDIFACT, ODETTE, and
TRADACOMS standards only)

1 If you are using the EDIFACT, ODETTE, or TRADACOMS
standard, click ENVELOPE to complete the envelope (header)
information.

System Response

One of the following dialog boxes is displayed:

B Outbound UNH Envelope dialog box
B Outbound MHD Envelope dialog box

2 B Enter the appropriate information.
B Click SAVE.
System Response

Theinformation is saved and the Outbound Relationship
dialog box is displayed.

Continued on next page
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Creating a New Outbound Relationship

(Cont.)
Step

Action

Selecting an outbound translation object

On the Outbound Relationship dialog box, click
TRANSLATION.

System Response
The Outbound Tranglation Object dialog box is displayed.

Select Translation Objects
Import IF'ET ¥ 3030 810 Import j
Print I j il |
st Bt I j Advanced »> |
Help |
Application 10: I
Application Alias Value: IS‘I 1]

From the lists, select the translation objects that are required
for this outbound relationship.

Note

Thelists display al translation objects registered in the
system that are appropriate for the type of translation object,
such as Import or Print, and the transaction set.

If there are no translation objects displayed in the lists, no
translation objects of that type are registered for the
document defined in the relationship.

If you selected an Import translation object, you may need to
define the following:

B IntheApplication ID box, type the application identifier
that indicates the destination for the documents.

B Inthe Application Alias Vaue box, type criteriathat the
system uses to distinguish this relationship from others
during the application import function.

Continued on next page
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Maintaining Partner Relationships

(Cont.)
Step

Action

Click SAVE.

System Response

The selections are saved and the Outbound Relationship
dialog box is displayed.

Selecting an outbound functional group

On the Outbound Relationship diaog box, click GRouPs.

System Response
The Outbound Group Select dialog box isdisplayed, showing
alist of existing groups.

Select |
Exit |
Mew... |

— J
Help |

Groups:

Is the required group in the Groups list?

B |f yes, select the group, and click SELECT. Select <none>
if you are not using groups. Continue with the Selecting
an outbound interchange section of thistable.

System Response

The highlighted group is selected and the Outbound
Relationship dialog box is displayed.

B [f no, continue with step 3 to create the group.

Continued on next page
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Creating a New Outbound Relationship

(Cont.)
Step

Action

On the Outbound Group Select dialog box, click NEw.

System Response
The Outbound Group Entry dialog box is displayed.

Description: I i
Standard: H12 Exxit |
Wersion: 003030 Ervelope. .. |
Functional Graup |D: IIN— Advanced > |

Help |

In the Description box, type the group description.

In the Functional Group 1D box, type theidentification of the
functional group you are specifying.
Note

The EDI standards define which functional group 1D should
be used for each type of document.

If you have more complex requirements for processing the
functional group, click ADVANCED>> to display the full list
of functional group setup options.

System Response

The Outbound Group Entry dialog box is displayed.

Outbound Group Entry - PETZ0NE E
Drescription: I
Standard: H12 Exxit |
Wersion: 003030 Ervelope. .. |
Functional Graup |D: ||N Advanced > |

Help |

Recommendation

Do not change the translation objects in the Group Trangl.
Obj. and Acknowledge Trand. Obj. lists, unless you have a
specific reason to do so.

Continued on next page
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(Cont.)
Step

Action

Click ENVELOPE to set up the parameters for the generation
of the Functional Group segment.

System Response

The Outbound Functional Group dialog box that is displayed
is determined by the standard selected on the Outbound
Relationship dialog box. It is one of the following:

B Outbound GS Functional Group

B  Outbound UNG Functional Group
B Outbound BAT Functiona Group

After you set up the required parameters in the enveloping
dialog box, click SAVE.
System Response

Theinformation is stored and the Outbound Group Entry
dialog box is displayed.

Click SAVE.

System Response

The information on the Outbound Group Entry dialog box is
stored and the Outbound Group Select dialog box is

displayed.

10

B Highlight the new group.
B Click SELECT.
System Response

The group is selected and the Outbound Relationship dialog
box is displayed.

Continued on next page
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Creating a New Outbound Relationship

(Cont.)
Step

Action

Selecting an outbound interchange

On the Outbound Relationship dialog box, click
INTERCHANGES.

System Response

The Outbound Interchange Select dialog box is displayed,
showing alist of existing interchanges.

Outbound Interchange Select - PETZ0NE E
Interchanges: Select |

40
Outbind #3040 IN Int

Is the required interchange in the Interchanges list?

B If yes, select the interchange and click SELECT. Select
<none> if you are not using groups. Continue with the
Finalizing the outbound relationship section of thistable.

® If no, continue with step 3 to create the interchange.

System Response

The highlighted interchange is sel ected and the Outbound
Relationship dialog is displayed.

On the Outbound Interchange Select dialog box, click NEw.

System Response
The Outbound Interchange Entry dialog box is displayed.

Drescription: I Save I
Standard: H¥12 Exit |
Wersion: 003030 Ervelope. .. |
Interchange |0 158 = Advanced »> |

Help |

Continued on next page

IBM Sterling Gentran:Director User Guide May 2011 3-55



Creating a New Outbound Relationship Maintaining Partner Relationships

(Cont.)
Step Action

4 In the Description box, type the interchange description.

5 In the Interchange ID box, type the identification of the
interchange you are specifying.
Note
The EDI standards define which interchange ID should be
used for each type of document. See Envelope definitions on
page 3 - 17 for details.

6 If you have more complex requirements for processing the

interchange, click ADVANCED>> to display the full list of
interchange setup options.

System Response

The Outbound Interchange Entry dialog box is extended.

™ Set Max Number of Documents per Interchange

ol &l wmben of Moeuments ger Interchanae: 1]

Last Used Contral Humber: [" Expect Acknowledaement
000000000 Hiurs Dwerdie: IU

Interchangs Transl. Obi. 154 Buid Template - ANSI =l

Acknowledge Transl. Obj. I j

Recommendation

Do not change the translation objects in the Interchange
Trangl. Obj. and Acknowledge Trangl. Obj. lists, unless you
have a specific reason to do so.

Continued on next page
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Creating a New Outbound Relationship

(Cont.)
Step

Action

Click ENVELOPE to set up parameters for generating the
interchange segment.

System Response

The Outbound Interchange dialog box that is displayed, is
determined by the standard you selected on the Outbound
Relationship dialog box. It is one of the following:

Outbound ISA Envelope
Outbound ICS Envelope
Outbound BG Envelope
Outbound UNB Envelope
Outbound UNA Envelope
B Outbound STX Envelope

After you set up the required parameters in the enveloping
dialog box, click SAVE.

System Response
Theinformation is stored and the Outbound Interchange
Entry dialog box is displayed.

Click SAVE.

System Response

The information on the Outbound Interchange Entry dialog
box is stored and the Outbound Interchange Select dial og box
isdisplayed.

10

Highlight the new interchange and click SELECT.

System Response
The interchange is sel ected and the Outbound Relationship
dialog box isdisplayed.

Finalizing the outbound relationship

On the Outbound Relationship dialog box, click SAVE.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Editing or Deleting a Partner Definition

Introduction - . . _ .
The partner definition contains the basic profile information about that

partner to which the system associates the rest of that partner’s records. You
can edit or delete the partner definition from the Partner Editor dialog box.

Editing a partner
profile To edit apartner profile, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

il
i
¥ i

Continued on next page
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Editing or Deleting a Partner Definition

(Cont.)
Step

Action

B Select the appropriate partner from the Select a Partner
list.

B Click EDIT.

System Response

The Partner Definition dialog box is displayed for that
partner.

Partner Definition - PETZ0NE E
Erafile IPETZDNE
Mame: |PETZONE Exit |
EDI Code: |PETTEST Help |

Application Code: IF'ETTEST

Comm. Profile  [COMMERCE Network =l

Make the necessary changes and click SAVE.

System Response
The Partner Editor dialog box is displayed.

Note

You can also edit other aspects of a partner relationship by
clicking the appropriate button on the Partner Editor dialog
box. For example, if you want to edit an inbound or outbound
relationship, click INBOUND or OUTBOUND.

You are not able to edit any boxes that are unavailable; these
arethe “keys’ to the relationship. In this case, you must
create a new inbound or outbound relationship for that
partner.

Reference

B For more information on creating a new inbound
relationship, see Creating a New Inbound Relationship
on page 3 - 31.

B For more information on creating a new outbound
relationship, see Creating a New Outbound Relationship
on page 3 - 43.
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Editing or Deleting a Partner Definition

Maintaining Partner Relationships

Deleting a

partner profile To delete apartner profile, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

il |

¥

il

il
i
¥ i

B Select the appropriate partner from the Select a Partner
list.

B Click DELETE.

System Response

You are prompted to confirm the deletion.

Caution

When you delete a partner relationship, the documents and
interchanges associated with that partner are also del eted.

You are warned before the actual deletion.

Click YEs to delete the selected partner profile.

System Response
The partner profile and all associated records are deleted.

May 2011
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Routing Partner Profiles

Importing a Partner Profile

Introduction _ _ .
The partner profile defines the parameters that control the processing and

structure of inbound and outbound data. As aresult, the partner profiles may
become complex and may require you to define a significant number of
parameters.

To simplify this process, Sterling Gentran:Director includes the import
partner feature, which enables you to import partner details from afile. The
file of partner details can originate from a partner profile that was exported
from another copy of the Sterling Gentran:Director system.

You can a'so use the import facility to update information for existing
partners. If you import to an existing partner profile, you can add new
trading relationships. Existing relationships are not modified.

Note

Any tables attached to the partner profile, such as Cross-reference, L ookup,
or Location, are also imported.

Before you begin _ _ _ ,
You must register any translation objects required for the partner before

loading a partner profile. Only those profiles for which one or more of the
necessary tranglation objects are available isimported. Any relationshipsin
the import file that are not loaded can be imported once you obtain and
register the translation objects.

Reference

For more information on registering transl ation objects, see Registering
(Installing) a New Translation Object on page 2 - 3.
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Procedure

To import a partner profile, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

il |

¥

il

il
i
¥ i

Click IMPORT.

System Response
The Import File Select dialog box is displayed.

Import File Select

Lookjn | =3 Tutorial

Petzone. par

Petzonel.par

Petzone2.par

Petzoned. par

Petzoned.par

File name: " par i

Fies of ype:  [Impon Files [ par) =l Cancel
Help

Select the location of the partner file by doing one of the
following:

B Sdlecting it from the Look in list
B Typing it in the File name box

Continued on next page
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Importing a Partner Profile

(Cont.)
Step

Action

Click OPEN.

System Response
The Import dialog box is displayed. This dialog box allows
you verify that this partner is the correct one.

Import E

Partrer ta lmport:

JPETZONES

Click SAVE to continue.

If you are prompted to enter additional partner information,
enter that information and click SAVE.

System Response
The system imports the partner detailsif they do not already
exist on the system, and any relationships for which there are
tranglation objects.

During this process, the system prompts you for any
additional information it needs by displaying the appropriate
Partner Editor dialog box. You are prompted with dialog
boxes when you would normally be required to provide
information about your site. Thisisusually restricted to your
EDI identifiers which the system uses to generate outbound
EDI envelopes. The system continues displaying Partner
Editor dialog boxes until it has all the information it needs.

Oncetheimport iscompl ete, the system displays the message
“Import process completed. Note any warnings or errors.”

Click OK.

System Response
The Import dialog box is displayed.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Exporting a Partner Profile

Introduction

Procedure

Sterling Gentran:Director includes a feature that enables you to export
existing partner detailsto afile. You can also export your partnersto diskette
to use as a backup of your partner system.

Note

Any tables attached to the partner profile, such as Cross-reference, L ookup,
or Location, are also exported.

To export a partner profile, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

W||W|EW|
Douds | | wewd | | po |

Continued on next page
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Exporting a Partner Profile

(Cont.)
Step

Action

B Select apartner.

B Click EXPORT.

System Response

The Export File Build dialog box is displayed.

Export File Build

Saveln | Parners =l ﬁl

File pame:  [FETZOME par [ ave ]

Save astype: [Expor Fies ["par] =l Cancel
Help

Name the export file by doing one of the following:
B Sdlecting it from the Look in list

B Typing it in the File name box

Note

The system automatically prompts you to name the export
file with the name of the partner and the .PAR extension.

Click SAVE.

System Response
The partner is exported.
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Copying a Partner Profile

Introduction

The partner copy function enables you to select a partner profile to copy.
This means that you do not need to type in similar partner profiles from
scratch. Instead, you can copy from an existing profile, enter unique partner
definition, and key enveloping information for the copied partner.

The partner copy function is designed to provide you with a quick method
for establishing partners that, generally, have similar or identical trading
relationships.

Note

You must export the partner profile before you copy it. If you do not know
which EDI standard that partner profile uses, check the profile information
before you export and copy it.

Reference
For more information, see Exporting a Partner Profile on page 3 - 64.
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Copying a Partner Profile

Procedure

To copy apartner profile, complete the following steps:

Step Action
1 From the Tools menu, select Partner Editor.
System Response
The Partner Editor dialog box is displayed.
[ —T -1 [=]
Select & Parines:
e
[
_ o |
Irkund
Orlbenrd
Tablet .
Losetire |
e |
Help
hw‘::! | Impost | Expast |
Deus | | wewd | e |
2 Click Copy.

System Response
The Partner Copy dialog box is displayed.

Partner Copy
Puofile ID: Gave
Mame: I Clear
EDI Code: [ Evit

Application Code Help

Gioup Recsiver Gualfier Edifact with UING orly
Group Recsiver ID: ANSI/Ediact/UCS/TDEC
Interchangs Receiver Quaifier: ANSI/Edtact/UCS/TDED
Interchange Receiver D ANSI/Edfact/UCS/TDET
Interchange Commurication ID: ucs
Interchange Passuord ues

Recipient Cade: Tradacoms
Recipient Name: [ Tradacoms

Continued on next page
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Maintaining Partner Relationships

(Cont.)
Step

Action

Click SELECT PARTNER.

System Response
The Import File Select dialog box is displayed.

Import File Select HE

Look jr: 3 Tutorial = ﬁl s
o8] Petzone. par

] Petoonet par
Pelzanez. par

Peteoned par

Petzoned.par

File name: [~ par Dpen

| Cancel
Help

Files of ype: [ Import Fies [~ par)

Select the file you want to copy by doing one of the
following:

B Selecting it from the Look in list
B Typing it in the File name box

Click OPEN to copy that partner.

Notes

B Themodel partner profile nameis displayed in the title
bar of the Partner Copy dialog box.

B The default file extension for exported partnersis
“.PAR.”

On the Partner Copy dialog box Profile ID box, type aunique
profile identifier.

In the Name box, type the partner name.

In the EDI Code box, type the EDI identifier for this partner.
Note

The system uses the EDI identifier during inbound
processing to select the correct partner.

Continued on next page
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Copying a Partner Profile

(Cont.)
Step

Action

If necessary, in the Application Code box, type an application
code to identify this partner.

Note

The system uses this identifier during outbound import
processing to select the correct partner.

10

Complete the appropriate boxes in the enveloping section of
the dialog box.

Note

You should only complete those boxes that are necessary for
the standard used by the partner profile you copied. The
standards are listed to the right of each box.

If the partner profile you copied uses a standard, you must
complete al the necessary enveloping boxes for that
standard. If you do not complete the necessary boxes for the
standard, the system takes the necessary information from the
copied partner profile envelope.

Example

If the copied partner profile uses the UCS standard, you must
complete the Interchange Communication ID box, among
others.

11

After you enter all the partner information, click SAVE.

12

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Setting up Partner Tables

Overview

Introduction

Table use

Using tables

The translation process allows you to set up tables to use information in the
Partner database when a document is entered into the system, either from a
file or from the Document Editor facility.

The Partner Editor also alows you to use an internal system partner
(<Internal System User>) to define your company to the system. Tables can
be set up for use with either atrading partner or with the special system
partner.

B Tablesthat you establish under a specific partner are valid only for that
partner.

B Tablesthat you set up under the internal system user can be used
globally.

The use of partner or system partner tablesis defined in the trandlation
objects at design time. This alows commonly used items such as names and
addresses to be inserted into the outbound data without the need to typeit. It
also alows you to use Lookup and Cross-reference tables to supplement or
convert data you enter or receive inbound.

You can create Cross-reference and Lookup tablesin Sterling
Gentran:Director, or you can import and export existing tables to and from
your system.

Note

Tables are used only if you create atrandation object that specifically
accesses those tables.
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Creating a Table

Creating a Table

Procedure

To create a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

b B |

W||W|EW|
Douds | | wewd | | po |

B Sdlect the partner profile or the system partner (<Interna
System User>) for which you want to create a Cross-
reference or Lookup table.

B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

CrozsHef - FRODCODE
Mew... |
Edit... |
Delete |
|mport |
Export |
Help |

Continued on next page
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(Cont.)
Step

Action

Click NEw.

System Response
The New Table dialog box is displayed.

Mew Table E

Table Mame: I

Table Type
’7(3' Cross Reference € Lookup

In the Table Name box, type the unique table name.

Note
The table name must be the same as the name used in the
tranglation object that requires the table.

From the Table Type section, select the Cross-reference or
Lookup table option.

Click SAVE.

System Response
Theinformation is saved and the CrossRef Select or Lookup
Select dialog box is displayed.

Click NEw.

System Response

The CrossRef Entry or Lookup Entry dialog box is displayed,
depending on the type of table you selected on the New Table
dialog box.

Type the table values. You can enter the following:

B Two valuesfor across-reference and one value for a
lookup table

B A description

B Any other reference information for the entry

Note

The way that the data you enter is used depends on how the
trandation object is defined. Consult with the trandation
object designer if you are unclear about what is required.

Continued on next page
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Creating a Table

(Cont.)
Step

Action

Click SaVE after each entry to save the information and enter
another table record.

10

Once you finish typing all entries, click ExIT.

System Response
The Cross-reference or Lookup Select dialog box is

displayed.

11

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Editing a Table

Procedure

To edit a partner table, compl ete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

il |

¥

il

il
i
¥ i

B Select the partner profile or the system partner (<Internal
System User>) for which you want to modify a Cross-
reference or Lookup table.

B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

"RODCODE

Delete |
|mport |
Export |
Help |

Continued on next page
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Editing a Table

(Cont.)
Step

Action

B Select the table you want to modify.
B Click EDIT.

System Response
The CrossRef Select or Lookup Select dialog box is
displayed, depending on the type of table.

B Select theitem you want to modify.
B Click EDIT.

System Response
The CrossRef Entry or Lookup Entry dialog box is displayed,
depending on the type of table.

Modify the entry.

Once you finish modifying all necessary table entries, click
SAVE.

System Response
The Cross-reference or Lookup Select dialog box.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Deleting Entries in a Table

Procedure . :
To delete entries in a partner table, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

b B |

Loy, | Impos | Expast |
Oods | Wowd | pen |
2 B Sdlect the partner profile or the system partner (<Internal

System User>) for which you want to delete atable entry.
B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

ef - PRODCODE

Continued on next page
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Deleting Entries in a Table

(Cont.)
Step

Action

B Select the table you want to modify.
B Click EDIT.

System Response
The CrossRef Select or Lookup Select dialog box is displayed,
depending on the type of table.

B Select theitem you want to modify.
B Click DELETE.

System Response
The Confirm Delete dialog box is displayed.

Click YEs to complete the deletion.

System Response
The CrossRef Select or Lookup Select dialog box is displayed.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Deleting a Table

Procedure

To delete a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

W||W|EW|
Douds | | wewd | | po |

B Select the partner profile for which you want to delete a
table.
B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

"RODCODE

Delete |
|mport |
Export |
Help |

Continued on next page
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Deleting a Table

(Cont.)
Step

Action

B Select the table you want to delete.
B Click DELETE.

System Response
The Confirm Delete dialog box is displayed.

Click YEs to complete the deletion and return to the Partner

Editor dialog box.

IBM Sterling Gentran:Director User Guide May 2011



Exporting Partner Tables Maintaining Partner Relationships

Exporting Partner Tables

Introduction _
The Table Export function enables you to export partner Cross-reference and

L ookup tables to a sequential file. This allows you to define atable for one
trading partner and copy that table to another partner profile.

Export file layout _ .
Typically, you export and then import tables created for another partner

profile. However, if necessary, you can build tables outside of Sterling
Gentran:Director by formatting your data in the export file layout.

The export file layout is afree-format ASCII text file. Each field must be
delimited, or separated, with Hex01.

Note

You can create the file with atext editor such as Notepad. The default file
extension for alookup export fileis“.LKP"” The default file extension for a
cross-referencefileis“. XRF”

Lookup table fields

Thefieldsin alookup table are listed in the following table. Mandatory
fields are designated with an asterisk[*]:

Field Description
Partner key* A unique identifier for the partner.
Table name* The name of the table. Because thisfield

isdisplayed in thetable selection list, the
name should be descriptive.

Item* Thevaluethat isfound or “looked up” in
the data during inbound or outbound
processing.

Description A brief comment about the item.

Textl, Text2, Text3, Text4 Additional reference information
required by the trandlation object using
thistable.
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Exporting Partner Tables

Cross-reference table fields

Thefieldsin a cross-reference table are listed in the following table.
Mandatory fields are designated with an asterisk (*):

Field

Description

Partner key*

A unique identifier for the partner.

Table name*

The name of the table. Because thisfield
isdisplayed in thetable selection list, the
name should be descriptive.

My ltem*

Your data value that corresponds to your
partner’s data value.

Partner Item*

Your partner’s data value that
corresponds to your data value.

Description

A brief comment about the item.

Textl, Text2, Text3, Text4

Additional reference information
required by the translation object using
thistable.
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Maintaining Partner Relationships

Procedure

To export a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

il |

¥

il

il
i
¥ i

B Select the partner profile or the system partner (<Internal
System User>) for which you want to export a Cross-
reference or Lookup table.

B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

Continued on next page
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Exporting Partner Tables

(Cont.)
Step

Action

Click EXPORT.
System Response
The Table Export File Build dialog box is displayed.

Table Expart File Build EHE

Savejn | Sl Patners =l QI l_z

File name:  [PETPARTC uf

Sava astype [Evpart Files () = Cancel
Help

From the Savein list, select the location of the exported table
file

Do one of the following:

B Typethe export file name in the File name box.
B Select it from thelist.

Note

The default file extension for cross-reference tablesis
“ XRF". The default file extension for lookup tablesis
“LKP".

Click SaVE to begin the export process.

Note

When the export process is compl ete the system displays an
informational dialog box.

Click OK.

System Response
The Partner Tables dialog box is displayed.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Importing a Table

Introduction

Procedure

The Table Import function enables you to import partner cross-reference and
lookup tables from a sequential file. Thisallows you to import tables created
for another partner profile, or build tables outside of Sterling
Gentran:Director by formatting your datain the export file layout.

To import a partner table, complete the following steps

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

il
i
¥ i

Continued on next page
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Importing a Table

(Cont.)
Step

Action

B Select the partner profile or the system partner (<Internal
System User>) for which you want to import a Cross-
reference or Lookup table.

B Click TABLES.

The Partner Tables dialog box is displayed.

Tables:

CrozsHef - FRODCODE

Mew... |
g |

Edit...

Delete |
|mport |
Export |
Help |

Click IMPORT.
System Response
The Table Import File Select dialog box is displayed.

Table Import File Select HE

=] & ol e

Lockjn: |23 Partners
PETPARTC xifsif

Filerame: [~ T |

| Cancel
Help

Files of type: [ Cross Reference Files [~af)

From the Look in list, select the location of the tablefile.

B Typetheimport file name in the File name box.
B Selectit fromthelist.

Note

The default file extension for cross-reference tablesis
“ XRF". The default file extension for lookup tablesis
“.LKP".

Continued on next page
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(Cont.)
Step Action
6 Click OPEN to begin the import process.
Note
When the export process is complete the system displays an
informational dialog box.
7 Click OK.

System Response
The Partner Tables dialog box is displayed.

8 Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Using Partner Locations

Overview

Introduction

Required
parameters

Before you begin

Each partner profile may have many associated location tables. You can use
location tablesin many different ways. For example, you may need alist of a
partner’s store addresses, warehouse addresses, or “invoice to” addresses.
Any or al of these can be stored in alocation table.

Locations are referenced in translation objects through one of the location
keys or reference codes. Locations are used only if you use atransation
object that specifically accesses those locations.

Parameters are required to tell the system the following information:

B The name of the trading partner location
B The reference codes that the system uses to identify this location

These parameters are used to create a partner location.

Before setting up a partner location, you must have the following
information:

B The unique name that identifies this partner location
B At least onereference code to identify the location
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Creating Partner Locations

Procedure

To create partner locations, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

W||W|EW|
Douds | | wewd | | po |

Click LOCATIONS.
System Response
The Location Select dialog box is displayed.

Location Select - PETZONE E

Locations: Eit |

Eddif... |
Welete |
Help |

Continued on next page
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Creating Partner Locations

(Cont.)
Step

Action

Click NEw.

System Response
The Location Entry dialog box is displayed.

Location Entry - PETZONE

Mame: |

Refersnce Codet: |

Fieference Code2: |

Contact |

AddiessT |

Address2 |

Address3 |

City: |
State:
Country

Phone: | Far |

Zip Code;

In the Name box, type a unique identifier that defines this
location within the partner.

In the Reference Code 1 box, type the unique identifier for
the location you are defining. For example, the DUNS
number can be defined for the location.

Complete the remaining boxes, as necessary.

Note
If you use Reference Code 2, it must also be unique.

Click SAVE.

System Response

Thelocation information is saved and a blank Location Entry
dialog box isdisplayed.

If you want to enter additional locations for this partner,
complete steps 4 through 7 as many times as necessary.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Editing Partner Locations

Procedure

To edit a partner location, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The Partner Editor dialog box is displayed.

w Pl Echlon

Skt o Partner

o B 0 e |

W||W|EW|
Douds | | wewd | | po |

Click LOCATIONS.

System Response
The Location Select dialog box is displayed.

Location Select - PETZONE E
Locations:
PETZOME - Accounts Payable -
Mew... |
Edit... |
Delete |
Help |

Continued on next page
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Editing Partner Locations

(Cont.)
Step

Action

B From the Locations list, select alocation.
B Click EDIT.

System Response
The Location Entry dialog box is displayed.

Lacation Entry - PETZONE [=]
Hame:  [PETZONE - Accounts Payable [ |
Reference Codel:  [ACCOUNTS Exit
Reference Code2: | Help

Contact  [Baion Walfgang

Address1:  [555 Any Strast

Address2: |

Address |

City [oubin
Stale oH Zip Code: [43016
Courtyr [USA

Phore:  [1814) 5550000 Far (574155500

Make any necessary changes.

Note
The Reference Codel box must be completed.

Do one of the following:

B Click SAVE to save thelocation information and return to

the Location Select dialog box.

B Click ExIT if you want to return to the Location Select

dialog box without saving changes.

Click ExIT.

System Response
The Partner Editor dialog box is displayed.
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Deleting Partner Locations

Procedure _ _
To delete a partner location and all associated records, complete the
following steps:
Step Action
1 From the Tools menu, select Partner Editor.
System Response
The Partner Editor dialog box is displayed.
2 Click LOCATIONS.
System Response
The Location Select dialog box is displayed.
Location Select - PETZONE E
Locations:
PETZONE - Accounts Payable o
Edit... |
Delete |
Help |
3 B From the Locations list, select alocation.
B Click DELETE.
System Response
The Delete Confirmation dialog box is displayed, and
prompts you to confirm the delete.
4 Click YEs to confirm the delete.
5 Click ExIT.
System Response
The Partner Editor dialog box is displayed.
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Overview

Using Documents

Using Documents

Overview

In this chapter

Using the
Document Editor

This chapter explains how to use the Sterling Gentran: Director document
functions, including:

B Creating and editing documents
B Managing documents
H  Routing documents

The Document Editor is the Sterling Gentran:Director data entry tool that
allows you to create, modify, and view documents.

Note

To use the Document Editor, you must register the appropriate screen entry
trand ation object with the system and set up a corresponding outbound
relationship for the partner.
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Using Documents Creating a Document

Creating and Editing Documents

Creating a Document

Introduction _ ,
To create a document using the Document Editor, the system must be set up

to support screen entry for the partner/transaction set combination you want
to enter.

Note

The appropriate Screen Entry transl ation object must be registered and a
corresponding Outbound relationship must be set up for the partner. For
more information, see Registering (Installing) a New Translation Object on
page 2 - 3 and Creating a New Outbound Relationship on page 3 - 43.

Procedure _
Complete the following steps to create a document:

Step Action

1 From The Desk, select Workspace.

System Response
The Workspace browser is displayed.

i WorkSpace - b [_[o]=

Partner Type  Mame Status  RefData i |

FPETZOME 810 1000200878 OK 4444 P
Fritit..
FETZOME 810 33322214 0K :
PETZOMEZ INVOIC 1000200345 OK 5555 Delte |
FPETZOME4 INVOIC 22435654 Motk
Sort.
FPETZOME4 INVOIC 4007654 0K %
Export.
Open
Fost

Irnport...
Refresh
o Cloze
5 Documents I 1 selected 1
E Help

Continued on next page
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Creating a Document

Using Documents

(Cont.)
Step Action
2 Click NEw.
System Response
The Create New Document dialog box is displayed.
Partrer Fielationship
b [ o]
Cancel |
3 B Select the appropriate partner/transaction set
combination from the list.
B Click OK.
System Response
The tranglation object for the selected combination is
displayed.
Example
The following illustration is an example of atrandation
object.
#&: Document Editor - ANSI X12 Invoice [810) - Pet Zone
File Edit Gioup WYiew MWindow Help
=TT A = e S R
A oice (810 Pe one =] E3
Invoice No |:| Invoice Date |:| = Open
Store
P.O. No |:| P.O. Date |:| Hew
Contract No. |:| Conlract Dats |:| o
shioTo [ ‘ T
[ \ Bext
| ‘ Frame ?
[ I |
Remit Ta | ‘
[ |
[ |
[ LI |
Payment Terms Code ﬁ
=
For Help, press F1 | InoM | 4
Continued on next page
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Creating a Document

(Cont.)
Step

Action

Type all the required data items into the boxes on the
document translation object.

Note

If the document contains a looping structure, or lower-level
detail records such asline items, then the input translation
object contains alist, asin theillustration below.

#&: Document Editor - ANSI X12 Invoice (810] - Pet Zone

File Edt Group Miew Window Help
=TT N e A T SRR
T
ANSI X12 Invoice (810) - Pet Zone [_ O[]
Item Praduct Oy Prce ~I|_Open
Line liems Slure
New
Del
Prev:
o Of Line ters [ ||
Frame ?
Tatal Invoice Amount |:|
[For Help, press Fi | [NUM | 4

To accessitemsin alist, highlight the first entry and click
NEW.

Line ltems [_[CIx]
ltem Mo |:| Product Code I:| Quantity |:| ; Lpes
Store

UoM | Frice —

I J New:
Description | Del
Date Shipped [Fransport Methor] =] Caier Cade, Prev
Next

Frame ?

Enter the data for the item.

Notes

B To enter asecond or subsequent item, click NEXT or
pressALT +T.

B After al loop items are entered, click STORE to save and
exit the loop dialog box.

B |f the document contains codes, press SHIFT + F1 from
each code field to access alist of the codes.

Continued on next page
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Creating a Document

Using Documents

(Cont.)
Step

Action

If the document contains cal culated fields, select Recal culate
from the Document Editor File menu before saving the
document.

System Response

The totals are updated, and the document is checked for
errors.

When you are finished entering data, select Save from the
Document Editor File menu.

System Response

The system saves the information and automatically
recal culates and check for errors. If errors are found, you are
prompted to view the errors.

Select Exit from the Document Editor File menu.

System Response

The Document Editor is closed. The system prompts you to
save the document before closing.

Note

You can how open and edit this document from the
Workspace browser.

May 2011
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Opening and Editing a Document

Opening and Editing a Document

Introduction

Procedure

To edit adocument using the Document Editor, you need to load the
appropriate screen entry translation object for the partner/transaction set
combination you want to edit.

Reference

For more information on registering a translation object, see Registering
(Installing) a New Translation Object on page 2 - 3. For more information
on selecting a trandlation object for a partner relationship, see Creating a
New Outbound Relationship on page 3 - 43.

To open and edit a document, complete the following steps:

Step

Action

1

From The Desk, select Workspace.

System Response

The Workspace browser is displayed.

i WorkSpace - b [_[o]=
Partner Twpe M Status  RefData i |
FPETZOME 810 ? Ok P
Fritit..
FETZOME 810 33322 0K :
PETZOMEZ INVOIC 1000200345 OK 5555 Delte |
FPETZOME4 INVOIC 22435654 Motk
Soit...
FPETZOME4 INVOIC 4007654 0K :
Export.
Open
Fost
New...
Irnport... |
Refresh
P Cloze
5 Documents 1 selected 1

Continued on next page
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Opening and Editing a Document

Using Documents

(Cont.)
Step Action
2 From the Workspace, select the document.

Note

Only documents in the Workspace can be edited.

B |f the document has already been moved to the Out
Documents and has not been sent, you can move it back
to the Workspace using the UnPost function. See
UnPosting a Document on page 4 - 37.

B |f adocument has been sent, it cannot be modified.
However, you can move a copy of the document from the
Out Drawer to the Workspace, modify the copy, and send
it. For additional information, see Copying a Document
(to Reprocess and Resend) on page 4 - 34.

3 Click OPEN.
System Response
The document is displayed in the Document Editor facility.
#%: Document Editor - ANSI %12 Invoice (810) - Pet Zone
File Edit Group Wiew ‘Window Help
=1 e R
Invoice No Invoice Date =1 Open
RO No PO, Date Zivre
Eonvactbio. [T255 ] Coniract Date i:'
Ship Ta |MWT Co \ E7mv
[4675 Lakehurst Ct. | Next
| ‘ Frame ?
[Dublin | [oH] [+201 |
Riemit To [PETZONE - Accounts Fayatle |
[1 Fet Zane Flaza |
[ |
[rvEiTy ) | e | =
For Help, press F1 [CeP[NUM [ 4
Continued on next page
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Opening and Editing a Document

(Cont.)
Step

Action

Modify the data as required.
Note

If the document contains a looping structure, or lower-level
detail records such asline items, then the input translation
object contains alist, asin theillustration below.

g5 Document Editor - ANSI X12 Invoice [810) - Pet Zone

FEile Edit Group Yiew MWindow Help
=TI A = e R

ANSI X12 Invaice (810) - Pet Zone M= B
Jtem Product Oy, Price =1 Open
Siore:
Line ltems 14532 10 559
2 TEEG44 4 25 HNew
311463 50 1688 Dol
Brey)
Nurnber Df Line Items Next
i Frame ?
Total Invaice Amount
For Help, press F1 [ [NOM i

B Toadd anew lineitem, highlight the first entry and click
NEW.

B Toaccessitemsin thelist, highlight the entry to be
changed and click OPEN. You can aso double-click the

item.
Item Na. Product Code [4532 Quantity [T =1 Open
[ ] I | [*_] _,:l
oM P ot
-| Price 9.99
ID3 J I—I New,
Desciption |Large Dog Collar Del
Date Shipped [05/11/97 Transport Melhodh j Carrier Eodelpps Prev
Next
Frame ?

Continued on next page
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Using Documents

(Cont.)
Step

Action

You can now change or enter data for the item.

Notes

B To move through the entries, use NEXT and PREV.

B To enter asecond or subsequent item, click NEXT or
pressALT +T.

W After al loop items are entered, click STORE to save and
exit the loop dialog box.

m |f the document contains codes, press SHIFT + F1 from
each code field to access alist of the codes.

If the document contains cal culated fields, select Recal culate
from the Document Editor File menu before saving the
document.

System Response

The totals are updated and the document is checked for
errors.

When you are finished entering data, select Save from the
Document Editor File menu.

System Response

Theinformation is saved and automatically recal culated and
checked for errors. If errors are found, you are prompted to
view the errors.

From the Document Editor File menu, select Exit.

System Response

The Document Editor is closed and the system prompts you
to save the document before closing.
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Using Documents Accessing Document Browsers

Managing Documents

Accessing Document Browsers

Introduction _ _ . .
You can access document browsersin Sterling Gentran:Director in any of

the following ways:

B The Desk enables you to access the In Documents, ?ln Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer,
and Out Drawer.

B TheMain Toolbar givesyou access to the In Documents, ?In
Documents, Workspace, Out Documents, ?0ut Documents,
Interchanges, In Drawer, Out Drawer, and Send Queue.

B The View menu gives you access to the In Documents, ?ln Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer,
Out Drawer, and Send Queue.

Summary dialog
boxes If you select the In Documents, 2In Documents, Out Documents, ?0ut
Documents, In Drawer, or Out Drawer browser from any of the three
locations above, the appropriate summary dialog box for that browser is
displayed.
The summary dialog box displays the number of each type of document for
each partner contained in the browser. This enables you to filter the display

of documents in the browser to only those of the document type and partner
that you want.
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Accessing Document Browsers

Using Documents

Procedure

Complete the following steps to access these browsers:

In Documents
?ln Documents
Out Documents
?0ut Documents
In Drawer

Out Drawer

Step

Action

From The Desk, select a browser.

System Response
The summary dialog box for that browser is displayed.

Select the type of document for the appropriate partner.

Note

B To highlight more than one partner/document type
combination, click on the first partner/document type,
press SHIFT, and then click the last partner/document
type in the group.

B To highlight several partner/document types that are not
adjacent to each other in the summary dialog box, press
and hold CTRL while clicking each partner/document

type.

Continued on next page
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Accessing Document Browsers

(Cont.)
Step

Action

Click VIEW.

System Response
The browser containing those documents is displayed.

Example
The following is an example of the In Documents browser.
i In Documents - PETZONE - 850 - 2 !EI
Tppe Mame Status  RefData Wiew...
] 1 K Friit..
FETZOME 850 1234867390 OK
Delete
Sort...
Expaort...
Move
Receive
Fiefiesh
Close
2 Documents v Tselected — |
<7 et
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Viewing a Document

Using Documents

Viewing a Document

View function

The View function enables you to view various types of information,
depending on the format selected in the View Choice dialog box. The view
typesinclude:

Theraw input data
EDI-formatted data
A trandator report
Tracking information

Note

The formatted view option isonly active if a Screen Entry trandlation object
isavailablein the Partner Relationship record.

Using the View

function The View function can be accessed when one of the following occurs:

A document browser such as In Documents, Out Documents,
Workspace, In Drawer, and Out Drawer is active and a single document
is selected.

The Interchanges or Restored Interchanges browser is active and a
single document within an interchange is selected.

Reference

For information on the Interchanges browser, see Viewing Documents within
Interchanges on page 6 - 11.
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Using Documents

Viewing a Document

Viewing a

Document from To view adocument from a document browser, complete the following

the Document steps:
Browsers

Step

Action

1

From The Desk, select the In Documents, Out Documents,
Workspace, In Drawer, or Out Drawer browser.

System Response
The summary dialog box for that browser is displayed.

W Select the type of document for the appropriate partner.
B Click VIEW.

System Response
The browser containing those documents is displayed.

Select a single document from the appropriate browser.

Click VIEW.

System Response
The View Choice dialog box is displayed.

Yiew Choice E
& Faw EDI

 Formatted Document
' Translator Report

€ Track Information

Cancel

Continued on next page
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Viewing a Document Using Documents

(Cont.)
Step Action
5 Use the following table to select the option that correspondsto
how you want the input data displayed.
Note
Some selections may not be available.
Select... Todisplay...
Raw EDI Thedatain EDI format.

Formatted Document | The data formatted with a screen
entry translation object.

Note

Thisoption is not available if no
screen entry translation object exists
for the document.

Tranglator Report A report of the actions the tranglator
took on this document and lists any
EDI- or trandlation object-based
compliance errors.

Reference

For a detailed explanation of
tranglator reports, see “ Appendix C,
Error Messages’ in the IBM®
Serling Gentran: Director®
Administration Guide.

Track Information The document tracking information
that is available for asingle
document.

Note
This function is not available if
document level auditing is disabled.

Reference

For more information on enabling
document level auditing, see” System
Administrator Functions” in the
IBM® Serling Gentran:Director®
Administration Guide.

Continued on next page
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Viewing a Document

Viewing a

(Cont.)
Step Action
6 Click OK to access the view that you specified.

Document from To view adocument from the Interchanges or Restored I nterchanges
the Interchan ge browser, complete the following steps:

Browser

IBM Sterling Gentran:Director User Guide

Step Action
1 From the appropriate area of The Desk, select the
Interchanges browser.
2 Select a single document.
3 Click the Dataicon on the Toolbar.

System Response

Theraw EDI dataview of the Interchangeis displayed in the
Data View window on the Interchanges or Restored

I nterchanges browser.
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Viewing Currently Processing Documents Using Documents

Viewing Currently Processing Documents

Processing

browser The Processing browser displays any document that is currently being

Reset function

processed in the Sterling Gentran:Director system. The Processing browser
allows you to find which documents are currently being processed by you or
other users in the Sterling Gentran:Director system.

Note

Any document that is currently being processed in the Sterling
Gentran:Director system is displayed in the browser as unavailable. You are
not permitted to access that document until processing is complete and the
document has been released to the system.

The Processing browser enables you to use the Reset function and return any
documents that are displayed in the browser, but for which processing has
terminated, to their previous location. Typically, you use this function for
exception cases when the processing of a document terminated improperly.
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Viewing Currently Processing Documents

Procedure

To view the documents that are currently being processed, complete the
following steps:

Step

Action

1

From the View menu, select Processing.

System Response

The Processing browser is displayed.

i Processing - 1

o=

[Partries

Type  Mame

RefData Location

Reseat I
Sot...

Refrash

Clase

1 Documents & 1 selected 5
You can perform the following functions on the Processing
browser:
Function Action
Sort Arranges the columns of the
documents in the active browser.
Reset Returns any documents that are

displayed in the Processing
browser, but for which processing
has terminated, to their previous
location.

Note

Thisfunction istypically used for
exception cases when the
processing of a document
terminated improperly.

IBM Sterling Gentran:Director User Guide
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Finding Specific Text in a Document

Find function

Using the Find

function

The Find function enables you to find specified text in the active data-view
window.

The Find function is available when a data-view is the active window. The
following are the data-view windows:

Audit Log

Document Tracking

Interchange Tracking

Raw Data-View of an Interchange
Raw Data-View of a Document
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Finding Specific Text in a Document

Procedure . . .
To find specified text, complete the following steps:
Step Action
1 Access one of the following data-view windows:
Window Accessby...
Audit Log selecting Audit Log from the View menu.
Document Tracking B selecting adocument in a browser
B selecting View from the Commands menu
B clicking the Tracking information option and OK
Interchange Tracking B selecting an interchange in the I nterchanges browser
B selecting View from the Commands menu
B clicking the Tracking information option and OK
Raw Data View of an B selecting Interchanges from The Desk
Interchange B selecting an interchange from the Interchanges browser
B sdlecting Interchanges from the View menu
B selecting Data from the Interchanges cascading menu to
display the raw EDI data
Raw Data View of a B selecting adocument in the Interchanges browser
Document B selecting View from the Commands menu
B clicking OK onthe View Choice dialog box to display the
raw EDI data
2 From the Edit menu, select Find.
System Response
The Find dialog box is displayed.
Find HE
Find what: | Eirid i Eqt |
Direction
™ Match case C Up & Dowin
3 In the Find What box, type the text you want to locate.
Continued on next page
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(Cont.)
Step Action

4 Do you want the system to search for case-sensitive text?

W [f yes, select the Match Case check box and continue with step 5.
W [f no, continue with step 5.

5 Click FIND NEXT to find the first occurrence of the specified text.

Notes

W [f the system locates that text, it is highlighted in the data-view window.

W [f the system does not find the specified text, the system beeps. If thisis the case,
skip to step 6.

6 If the system finds the specified text, continue clicking FIND NEXT to find each
subsequent occurrence of that text.
Note

When the system has located the last occurrence of that text in the direction you
specified, the system beeps.

7 Click CANCEL.

System Response
The data-view window is displayed.
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Sorting Documents

Introduction

The Sort function can be used when the In Documents, ?In Documents, In
Drawer, Workspace, Out Documents, ?0ut Documents, or Send Queue
browser is open. This function arranges the columns of the documentsin the
active browser into one of the following sequences:

B Partner/Type/Name
B Partner/Name/Type
B Type/Partner/Name
B Name/Type/Partner

The Sort function can also be used when the Out Drawer is active. The Sort
function allowsyou to arrange the Out Drawer columns and filter the display
of documents by status.

Changing the

default sort To change the default method that Sterling Gentran:Director uses to sort
method columnsin the document browsers, complete the following steps:

Step

Action

1

From the Options menu, select Preferences.

System Response
The Preferences dialog box is displayed.

Click the Sort Columns tab.

System Response
The default sort order is displayed.

Select the option that corresponds to the appropriate sort
order.

Click OK.

System Response
The changeis saved globally.
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Sorting

document To sort the columns of documentsin these browsers, complete the following

columns in steps:
browsers

B |In Documents

B ?In Documents

B |nDrawer

B Workspace

B Out Documents

B ?0ut Documents

B Send Queue

Step Action
1 From The Desk, select the browser where the documents are
located.
System Response
If you select the In Documents, ?In Documents, Out
Documents, ?0ut Documents, In Drawer, Out Drawer, or
Send Queue browser, the summary dialog box for that
browser is displayed.
2 If asummary dialog box is displayed:
B Select the type of document for the appropriate partner.
B Click ViEw.
System Response
The browser containing those documents is displayed.
Continued on next page
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Sorting Documents

(Cont.)
Step

Action

Click SORT.

System Response
The Sort Browser Columns dialog box is displayed.

Sort Browser Columns E

Soart arder

& Partner - Type - Mame
' Partrier - Mame - Type
' Type - Partrier - Mame
' Mame - Type - Partner

Do the following:
B Select the appropriate option for the desired sort order.
B Click OK.

System Response
Thelist of documentsis sorted in the specified sort order.

Sorting with Out

Drawer browser Completethe following steps to sort the columns of the documents or filter
the document display in the Out Drawer browser:

Step

Action

1

From The Desk, select the Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

B Select the type of document for the appropriate partner.
®  Click VIEw.

System Response
The Out Drawer browser is displayed.

Continued on next page
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(Cont.)
Step

Action

Click SoRT.

System Response
The Sort/Filter Out Drawer Contents dialog box is displayed.

Sort/Filter OutDrawer Contents E

— Sort order

& Partner - Type - Mame
' Partrier - Mame - Type
' Type - Partrier - Mame
' Mame - Type - Partner

— Filter

™ Sert

™ Received by Network

™ ‘waming fram Metwork

™ Enror from Mebwork:

™ Picked Up by Trading Partner
™ Acknowledged with No Errars
™ ‘Waiting for Acknowledgement
™ Acknowledgements Overdue
™ Acknowledgements with Errors
[ Partially &cknowledged

™ Acknowledged but Rejected

Cancel |

Do you want to sort the browser columns?

B |f yes, click the appropriate option for the desired sort
order and continue with step 5.

B [f no, continue with step 5.

Continued on next page
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Sorting Documents

(Cont.)
Step

Action

If you want to filter the display of documentsin the Out
Drawer by document status, you can choose not to display
documentswith certain statuses. Select the check box next to
each status that you do not want displayed.

Note

When you clear a check box, the display of that statusis
turned “off.” The default isto display documents regardless

of status.

Use the following table to determine which check boxes to

select:

Satus Code

Description

Sent

Indicates that the document was
successfully transmitted.

OnNet

Indicates that the document was
successfully delivered to a value-added
network.

Note

To obtain this status using IBM® Sterling
B2B Collaboration Network, you must have
your mailbox configured to receive the 20
report in data format.

NetWarn

Indicates that the document was delivered
to a value-added network and the network
detected non-critical errorsin the data. The
datais available to be picked up by the
designated trading partner.

Note

To obtain this status using IBM Sterling
B2B Collaboration Network, you must have
your mailbox configured to receive the 20
report in data format.

Continued on next page
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(Cont.)
Step

Action

(cont.)

Satus Code

Description

NetErr

Indicates that the document was delivered
to avaue-added network and the network
detected critical errorsin the data. The data
isavailable to be picked up by the
designated trading partner.

Note

To obtain this status using IBM Sterling
B2B Collaboration Network, you must have
your mailbox configured to receive the 20
report in data format.

PickedUp

Indicates that the document was
successfully delivered to atrading partner
via avalue-added network.

Note

To obtain this status using IBM Sterling
B2B Collaboration Network, you must have
your mailbox configured to receive the 70
report in data format.

Ack'd

Indicates that the document was
acknowledged by your partner and there
Were no errors.

Waiting

Indicates that the document is waiting to be
reconciled with an inbound functional
acknowledgment.

Overdue

Indicates that the document is waiting to be
reconciled with an inbound functional
acknowledgment but has exceeded the
number of hours by which that
acknowledgment is deemed late.

Continued on next page
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(Cont.)
Step

Action

5 Satus Code

Description

(cont.)
AckErr

Indicates that the document was
acknowledged by your partner and there
were errors, but it was accepted by your
partner in spite of the errors.

~Ack

This statusis only displayed if there were
no acknowledgments expected for this
document and either the group or the
interchange was partially acknowledged.

Note

If your partner is going to issue partial
acknowledgments at the interchange or
group level, they should also indicate
acceptance or rejection at the transaction
level.

Reject

Indicates that the document was
acknowledged by your partner and there
were errors. The document was rejected by
your partner.

Click OK.

specified.

System Response
The contents of the Out Drawer is sorted or filtered as
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Deleting a Document

Introduction

Procedure

The Déelete function is used to remove a document or group of documents
from the system.

Notes

B When adocument is deleted, all the associated document information,
tracking information, and translation report information is also deleted.

B When the last document in an interchange is deleted, the interchange
entry is also deleted.

To delete a document or group of documents, complete the following steps:

Step Action

1 From The Desk, select the current location of the document.
System Response
If you select the In Documents, ?1n Documents, Out
Documents, ?0ut Documents, In Drawer, or Out Drawer
browser, the summary dialog box for that browser is
displayed.

2 If asummary diaog box is displayed, select the type of
document for the appropriate partner and click VIEw.
System Response
The browser containing those documents is displayed.

3 Click DELETE.

System Response

The confirmation dialog box is displayed.
4 Click YEs.

System Response

The document is deleted.

May 2011
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Printing a Document

Introduction

If no documents are selected, the Print function prints a summary list of all
documentsin the browser. For selected documents, the Print function prints
one of the following:

B Raw EDI data

B Formatted version of the documents using the print translation object
established (partner relationship)

B Summary list of those documents

Procedure

To print adocument or group of documents, complete the following steps:

Step

Action

1

From The Desk, select the current location of the document.

System Response

If you select the In Documents, ?In Documents, Out
Documents, ?0ut Documents, In Drawer, or Out Drawer
browser, the summary dialog box for that browser is

displayed.

Do the following:
B Select the type of document for the appropriate partner.
B Click VIEw.

System Response
The browser containing those documents is displayed.

Do you want to print asummary list of all documents?

B |f yes, click PRINT to access the Print dialog box.
Continue with step 6.

B [f no, continue with step 4.

Continued on next page
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(Cont.)
Step Action
4 Do you want to print selected documents, either formatted or

unformatted, or asummary list of selected documents?
B |f yes, select adocument or group of documentsand click
PRINT. Continue with step 5.

System Response
The Print Choice dialog box is displayed.

Print Choice E

& Selected ltems.

¥ Fomatted
Cancel |

= Surmmary List of ltems.

Help |

B |f no, continue with step 6.

5 Select the appropriate option on the Print Choice dialog box

and click OK.

B To print selected unformatted documents, select the
Selected Items option.

B |f you want the selected documents printed as formatted,
select the Selected Items option and the Formatted check
box. A print trandation object must exist for the
documentsto be printed as formatted.

B Toprint asummary list of selected documents, select the
Summary List of Items option.

System Response
The Print dialog box is displayed.

6 On the Print dialog box, set the appropriate options and click
OK.

Note

The system displays the Print dialog box if you either
selected no documents from the browser and clicked PRINT,
or if you chose Summary List of Items from the Print Choice
dialog box.
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Routing Documents

Moving a Document to the In Drawer

Introduction

The routing function moves a selected document or group of documents to
the In Drawer. Documents are automatically moved from the In Documents
or ?ln Documents to the In Drawer by the system at the completion of a
successful Export or Print. However, you might want to manually move a
document to the In Drawer so that you could create a turnaround (response)

document.

Note

You can only move documents to the In Drawer when In Documents or the
?In Documents is the active browser.

Procedure

To move adocument or group of documents, complete the following steps:

Step

Action

1

From The Desk, select the In Documents or ?ln Documents.

System Response
The summary dialog box for that browser is displayed.

Do the following:
B Select the type of document for the appropriate partner.
B Click VIEw.

System Response
The browser containing those documents is displayed.

Select the documents that you want to move to the In Drawer.

Click MOVE.

System Response
The selected documents are moved to the In Drawer.
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Copying a Document (to Reprocess and Resend)

Introduction _ ,
The Copy function copies a document that was already sent successfully to

the Workspace, so you can modify the document and resend it. The Copy
function can only be used when Out Drawer is active.

Note
This function can result in sending duplicate documents to a trading partner.

Reference

After you modify the documents, you may want to resend them. For more
information on resending, see Resending a Document on page 5 - 9.

Procedure ,
Complete the following steps to copy a document or group of documents:

Step Action

1 From The Desk, select the Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

2 Select the type of document for the appropriate partner and
click View.

System Response
The Out Drawer browser is displayed.

3 Select the documents that you want to copy to the
Workspace.

4 Click Copy.

System Response
The selected documents are copied to the Workspace.
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Posting a Document

Introduction

The Post function moves a selected compliant document or group of
compliant documents to the Out Documents. A document is compliant if it
conforms to the validation rules as defined by the translation object. A
document is designated compliant if the Status column contains“OK.” If the
Status column contains “NotOk,” the document is not compliant and is not

posted.

Note

The Post function can only be used when the Workspace is active.

Procedure

Complete the following steps to post a document or group of documents:

Step

Action

1

From The Desk, select the Workspace.

System Response
The Workspace browser is displayed.

i WorkSpace - 5 I
Partner Type  Name Status  RAefData ..
FETZOME &10 1000200678 QK 4444
Print.
FETZONE 210 3322214 oK :
FETZONEZ INVOIC 1000200245 0K 5555 Delete |
FPETZONE4 INVOIC 22435654 NotOk
Sait
FPETZONE4 INVOIC 4007E54 oK :
Expot.. |
Open |
Post
New.. |
Impart.. |
Refresh
T Close
5D it 1 selected 1
ocuments 8 selectes E
Continued on next page
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(Cont.)
Step

Action

Select the compliant documents that you want to move to the

Out Documents.
Note

A document is designated compliant if the Status column
contains “OK.” If the Status column contains “NotOk,” the
document is not compliant and is not posted.

Click Posr.
System Response

The selected documents are moved to the Out Documents.

: Dut Documents - PETZONE - 810 - 5 I E3

Patner  Type  Name Status  RefData

1000200678 OK A444
PETZONE 210 20300876 oK

PETZONE 997 4 oK A
PETZONE 997 4 oK E
PETZONEZ INVOIC 23400056 oK 5555

PETZ0ONE 210

Wiew...

Delate |
Sart |

Export...

Send

UnPost

Refresh

5 Documents

& 1 selected

Close

Help
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UnPosting a Document

Introduction

The UnPost function moves a selected document or group of documents
back to the Workspace. You can use UnPost to prevent a document from
being sent to a trading partner or to allow the document to be modified
beforeit is sent. The UnPost function can only be used when Out Documents
isthe active browser.

Note

If you modify the document, you must repost before the system can send it.

Procedure

Complete the following steps to UnPost a document or group of documents:

Step

Action

1

From The Desk, select the Out Documents.

System Response
The Out Documents Summary dialog box is displayed.

Do the following:
B Select the type of document for the appropriate partner.
B Click VIEw.

System Response
The Out Documents browser is displayed.

Select the documents that you want to move back to the
Workspace.

Click UNPoOsT.

System Response
The selected documents are moved back to the Workspace.
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Responding to a Document

Introduction

Turnaround
documents

Modifying
documents

The Respond function automatically generates a response document by
transferring data from an inbound source document. The Respond functionis
only available when the In Drawer is the currently selected browser, one or
more documents are selected, and Turn Around translation objects exist for
the selected documents.

The Respond function creates a turnaround document, using the Turn
Around trandlation object from the Partner relationship, in response to the
currently selected documents. For instructions, see Creating a New Inbound
Relationship on page 3 - 31. You can create a turnaround document for non-
compliant documents, or documents with a“NotOK” status, as well as
compliant documents.

The documents generated by the turnaround process are placed in the
Workspace, where you can modify them prior to sending.

Note

To modify adocument, a Screen Entry translation object must be set up in
the outbound relationship for the created document.

Reference

For instructions on setting up an appropriate screen entry translation object,
see Creating a New Outbound Relationship on page 3 - 43.
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Procedure

To respond to one or more documents, compl ete the following steps:

Step

Action

1

From The Desk, select In Drawer.

System Response
The In Drawer Summary dialog box is displayed.

B Select the type of document for the appropriate partner.
B Click ViEw.

System Response
The In Drawer browser is displayed.

Select the document or documents for which you want to
create a turnaround document.

Click RESPOND.

System Response

B The system automatically creates aturnaround document
in response to each document you selected by using the
Turn Around translation object that you specified in the
Partner relationship.

B Theturnaround documents produced are displayed in the
Workspace for you to modify, if necessary, before
posting to the Out Documents.

Reference
For instructions on posting documents, see Posting a
Document on page 4 - 35.
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Importing a Document

Introduction

Additional
configuration
task

Sterling Gentran:Director allows you to import data from data files as an
alternative to using the Document Editor to enter data directly into the
system. To import adocument, you must have a system import and/or import
tranglation object for the transaction set that isimported, registered with the
system.

Reference

For more information on tranglation object registration, see Registering
(Installing) a New Translation Object on page 2 - 3.

Additionally, for each type of import file, you need to define an import
specification on the Import tab in the System Configuration program that
indicates which import or system import translation object is used to begin
translation during the import process.

Have your system administrator map to a shared folder where the files that
you want to import are located.

Note
Do not use Universal Naming Convention (UNC) paths.

Reference

For more information on adding import specifications, seethe“Imports Tab”
section in the IBM® Serling Gentran: Director® Administration Guide.
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Procedure

To import a document, compl ete the following steps:

Step

Action

1

System Response
The Workspace browser is displayed.

i WorkSpace - 5

From The Desk, select the Workspace.

1 3

Patner  Type
PETZONE 10 1000200678
FETZONE 210 a2zl

Status  RefData iiew..

PETZOME4 INWOIC 22435654 NotOK,

PETZOMEZ INVOIC 1000200345 0K 5555 Delste |

Soit
PETZOME4 INVOIC 4007654 oK

Export...

Open

Post

New. |
Import.._|

Fiefresh

— Close
5 Documents ELET 1 sslected
= Help

Click IMPORT.

System Response

Application Files to Import

Lookjn |3 Imports =l =
810 ki
Pet_einw. bt
Pek._tinv. bt

File pame:  [Pet_8T0.10 Open |
Fies of pe: [afes (7] =l Cancel
Help

The Application Filesto Import dialog box is displayed.

Continued on next page
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(Cont.)
Step Action
3 Select thefile or filesto be imported and click OPEN.

System Response
The documents are imported into the Workspace.

The documents either have an * OK” statusto indicate that
the documents were successfully read and compliance
checked or, if the documents failed compliance checking,
they are marked as “NotOK.”

Note

You may not send non-compliant documents — either delete
those documents and re-process them from the datafile, or
correct the documents in the Document Editor if you have
Screen Entry translation objects for them.

Reference

For more information on correcting the documentsin the
Document Editor, see Opening and Editing a Document on
page4- 7.

Important

If you import afile and no documents are displayed in the
Workspace, check the Audit Log. For additional information,
see Viewing and Printing the Audit Log Information on page
8-5.
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Exporting a Document

Introduction _ _ _
To export adocument to adatafile, an export translation object for the

transaction set must be loaded into the system and registered, and set up as
the Export translation object in the inbound relationship record for the
partner.

Reference

B For more information on translation object registration, see Registering
(Installing) a New Translation Object on page 2 - 3.

B For moreinformation on setting up the Export translation object, see
Creating a New Inbound Relationship on page 3 - 31.

Procedure _
To export a document, complete the following steps:

Step Action

1 From The Desk, Select the In Documents, ?In Documents, or
In Drawer.

System Response
The summary dialog box is displayed for the selected
browser.

2 B Select the type of document for the appropriate partner.
B Click VIEw.

System Response
The appropriate document browser is displayed.

Continued on next page
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(Cont.)
Step Action
3 B Select the document or documents that are to be
exported.
B Click EXPORT.
System Response
The Select Export Method dialog box is displayed.
Select Export Method E
&' Export to Single File Cancel |
" Export to Default Files
" Select File by Document
Help |
4 Select one of the following options and click OK.
B To convert all selected documentsto data and write them
to asinglefile, select the Export to Single File option.
B To write selected documents to the files set up in the
partner inbound relationship, select the Export to Default
Files option.
B To rename selected documents, select the Select File by
Document option.
System Response
The Choose file to Export document dialog box is displayed.
Choose file to Export document: [ 2] x]
Lockin | 3 Evports o =] M= =
Filename: | [F ipen
Files of type: | Tet fles [~ = Cancel
Help
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Using Communications

In this chapter _ _ . . .
This chapter explains how to use communications with Sterling

Gentran:Director. For information about stand-alone communications, see
Using Sand-alone Communications on page 5 - 18.

Communications
feature The Communications feature enables you to send and receive data from your
trading partners. Sterling Gentran:Director uses the Communicator to handle
your communication needs.

Send process _ ,
The following table describes the system process that occurs when you send

an interchange:

Stage Description

1 The documents in the selected interchange are batched into
EDI envelopes, and the required control numbers are
generated from the information in the partner profile.

2 After theinterchangeis built, it islisted in the Interchange
browser. For instructions on viewing an interchange, see
Viewing Interchanges on page 6 - 6.

3 If the communication fails because there is no profile set up,
the interchange and documents are left in a“ Ready to send”
status.

If communication fails because there is no modem, the
interchange and documents are left in a“ Queued” status.
Note

No user action is required at this point. Interchanges that
failed to send are automatically sent as part of the next
transmission session.

4 After communication is successful, the documents are moved
to the Out Drawer and the interchange statusis set to “ Sent.”

5-2 May 2011 IBM Sterling Gentran:Director User Guide



Using Communications

Sending a Document

Sending a Document

Procedure

To send a selected document or set of documents, compl ete the following

steps:

Step

Action

1

From The Desk, select Out Documents.

System Response
The Out Documents Summary dialog box is displayed.

Note

If the documents to be sent are not in Out Documents, you

must post the documents from the Workspace to Out
Documents.
Reference

For instructions on posting, see Posting a Document on
page 4 - 35.

Continued on next page
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(Cont.)
Step

Action

Do the following:

B Select the type of document for the partner.
m Click VIEW.

System Response
The Out Documents browser is displayed.

i Out Documents - PETZONE - 810 - 5 HE E3
| Wi,
prennyu Frint...
PETZOME 997 4 oK A Delete |
PETZOME 997 4 oK E
Sart...
PETZONEZ INVOIC 23400056 oK 5555
Export...
Send
UnPost
Refresh
- Cloze
5 Documents 1 selected :
o Het

Select the document or documents that need to be sent.
Note

To select agroup of documents click the first document,
press SHIFT, and click the last document. To select several
documents that are not adjacent to each other in the Out
Documentsllist, press and hold CTRL while clicking each
document.

Continued on next page
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Sending a Document

(Cont.)
Step

Action

Click SEND.

System Response
The Sterling Gentran:Director dialog box is displayed.

GEMTRAMN:Director B

@ Start a Send and Receive Transmission 5 ession now?

Click YEsto start the transmission session.
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Sending All Documents

Introduction

You can send all the documentsin Out Documents using one of the
following methods:

B Selecting the Transmit icon on The Desk.
B Accessing the Out Drawer browser and clicking SEND.

Procedure . . .
To send al documents, complete one of the following sets of instructions:
Step Action
Method 1
1 From The Desk, click the Transmit icon.
System Response
The Communication Session dialog box is displayed.
Select the mailbox you wish to communicate with:
[w| COMMERCE: Metwark
Cancel |
Continued on next page
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Sending All Documents

(Cont.)
Step

Action

Do the following:

W Select one or more profiles for which you want to send
data.

B Click OK to start acommunication session to send data.
Click CANCEL if you want to cancel the transmission
session.

Note

All documents currently located in the Out Documents, for
which the partner is using one of the selected profiles, is
sent.

If there are no documents in the Out Documents or
interchanges with a“Ready” statusin the Interchanges
browser, areceive-only session is performed and the In
Documents and ?In Documents are updated with any data
received.

Method 2

From The Desk, select Out Documents.
System Response
The Out Documents Summary dialog box is displayed.

Note

If the documents to be sent are not in Out Documents, you
must post the documents from the Workspace to Out
Documents.

Reference

For instructions on posting, see Posting a Document on
page4 - 35.

Continued on next page
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Sending All Documents

Using Communications

(Cont.)
Step Action
2 Do the following:
B Select the type of document for the partner.
m Click VIEW.
System Response
The Out Documents browser is displayed.
: Out Documents - PETZONE - 810 - 5 M= E3
Partner Type  Mame Status  RefData i, |
PETZOME 810 1000200676 O II
e w4 o A oo |
PETINEWOE 2w 0K 5 %
Send |
UnPast |
Refresh
5 Documents e 1 selected %
3 Do not select any documents. If any documents are selected,
press CTRL and click on the documents to deselect them.
4 Click SEND.
System Response
The Sterling Gentran:Director dialog box is displayed.
@ Start a Send and Receive Transmission Session now?
Mo |
5 Click YESto start the transmission session.
Note
All the documents in the Out Documents are sent to the
appropriate profiles.
May 2011 IBM Sterling Gentran:Director User Guide
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Resending a Document

Resending a Document

Introduction

After adocument is successfully enveloped and sent, it is stored in the Out
Drawer. If you need to resend the document, you must make a new copy of
the document and execute the Send process again.

Procedure

To resend a document, complete the following steps:

Step

Action

1

From The Desk, select Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

Do the following:

B Sdlect the type of document for the partner.
B Click VIEW.

System Response

The Out Drawer browser is displayed.

i Out Drawer - PETZ0ONE- 810 - 2 M= E3
F Wi,
= 4441 ;
b £ : Frint...
PETZONEZ INWOIC 1000200345  Ack'd 5555 %
Delete
Sart...
Export...
Copy |
Ack
Refresh
Cloze
2 Documents o 1 selected 1
iE Help |

Continued on next page
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Resending a Document

Using Communications

(Cont.)
Step Action
3 Select the document or documents that need to be resent.
Note
To select agroup of documents click the first document,
press SHIFT, and click the last document. To select several
documents that are not adjacent to each other in the Out
Drawer list, press and hold CTRL while clicking each
document.
4 Click Copy.
A copy of the documents is made and placed in the
Workspace.
5 From The Desk, select Workspace.
System Response
The Workspace browser is displayed.
i WorkSpace - B HE E3
Fartrer Type  Mame Statuz  RefData H
PETZOWE 810 000200 Ok 4444 5
PETZ 8 221 = ’T
PETZOWEZ INVOIC 1000200345 0K 5555 Delete |
FETZOME4 INVOIC 22435654 Motk
PETZOWE4 INVOIC 4007654 DKt %
Export... |
Open |
Post |
Mew... |
Import.. |
Refresh
5 Documents FEER 1 selected ‘_UDSE 1
B e |
6 Make any necessary changes to the documents.
Note
You can modify a document only if there is a Data Entry
tranglation object for the partner relationship.
Continued on next page
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Resending a Document

(Cont.)
Step

Action

Do the following:

B Select the documents.

B Click Posr.

System Response

The documents are posted to the Out Documents browser.

From The Desk, select Out Documents.

System Response
The Out Documents Summary dialog box is displayed.

Do the following:

B Select the type of document for the partner.
B Click VIEW.

System Response
The Out Documents browser is displayed.

i Out Documents - PETZONE - 810 -5 HE E3
Fartrer Type  Mame Statuz  RefData Wiew...

: Frint...
PETZOME 810 20300876 oK

PETZONE 337 4 oK. 2 Delete

PETZ0ONE 337 4 0K E St
PETZOMEZ INVOIC 23400056 oK 5555
Export...

Send
UnPost

Refresh

Cloze

5 Documents 1 selected

ol bl L

e

Help

Continued on next page
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Resending a Document Using Communications

(Cont.)
Step Action

10 Do the following:

B Select the documents.
B Click SEND.

System Response
The Sterling Gentran:Director dialog box is displayed.

@ Start a Send and Receive Transmission 5 ession now?

11 Click YEsto start the transmission session.
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Using Communications Receiving a Document

Receiving a Document

Introduction , o ,
Any time a Send session is executed, the system automatically checks your

Mailbox for any information waiting to be received. If any dataisin the
Mailbox, it is received without any action from you.

If you need to receive information without first sending anything, you must
initiate a receive-only session using one of the following methods:

B Selecting the Receive command from the Commands menu.
B Accessing the In Documents browser and clicking RECEIVE.

Procedure _ _ .
To start areceive-only session, complete one of the following sets of
instructions.:,
Step Action
Method 1
1 From the Commands menu, select Receive.
System Response
The system initiates a receive-only session.
Method 2
1 From the Tools menu, select In Documents.
System Response
The In Documents Summary dialog box is displayed.
Continued on next page
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Receiving a Document Using Communications

(Cont.)
Step Action
2 Do the following:
B Select the type of document for the partner.
m Click VIEW.
System Response
The In Documents browser is displayed.
i In Documents - PETZOMNE - 850 - 2 S |
IP. FiefData Vigw..
’ P, —
PETZDNE 850 1234567830 0K E—Itt
Sort...
Export...
Move
Receive
Refresh
— Cloge
2 Documents ﬂ 1 zelected —Help
3 Click RECEIVE.
System Response
The Communication Session dialog box is displayed.
Continued on next page
4 Do the following:
B Select one or more profiles for which you want to send
data.
B Click OK to start acommunication session to send data.
Click CANCEL if you want to cancel the transmission
session.
Note
Thisactioninitiatesareceive-only session and updatesthe In
Documents or 2ln Documents with any data received as a
result of that session.
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Viewing the Send Queue

Viewing the Send Queue

Introduction

Procedure

The Send Queue displays alist of documents that are currently queued to be
sent, and enables you to perform document-based tasks similar to those
available in the main system browsers.

Note

The Send Queue contains documents only if atransmission session failed.
The documents remain in the Send Queue until a successful transmission
SEsSion OCCUrs; No user intervention is required.

To view the Send Queue, complete the following steps:

Step

Action

System Response

i Queue - 3

From the View menu, select Send Queue.

The Send Queue browser is displayed.

X

[ 9

[PETZONEZ INVOIC 2112222 Queued 222212
PETZONEZ INVOIC 2113114 Queued 955

H=
| View.. |
Print.. |

Refresh

3 Documents rrrrE

Cloze
1 selected

i

Help

Select a document or a group of documents.

Continued on next page
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Viewing the Send Queue Using Communications

(Cont.)
Step Action
3 Use the command buttons on the Send Queue browser to perform the

following functions:

I F you want to... THEN click...

view the content of a VIEW
B single selected document in raw EDI data,
m formatted document,

W trandation report,

print the selected documents or summary of the PRINT
documents,

delete the selected documents, DELETE
sort the displayed columnsin the document list, SORT
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Processing Data Files

Processing Data Files

Introduction

The Process File feature invokes the post-communications process with any
datafile, just asif the file was received through a communication session.
This enables you to process a data file from a diskette or anywhere on your

system.

Procedure

To send a data file to the Communicator, complete the following steps:

Step

Action

1

From the Commands menu, select Process File.

System Response

The Process File dialog box is displayed.

Process File EHE
Loak in: I =3 Bin j gl =
Achive.exe CTT1Atmp CTT1BSE tmp CTT32.trop
B Commpost exe CTT1B.tmp CTT1BSF.tmp CTT33 .ty
Carfig.exe CTT1BS4.tmp CTT1BEDtmp CTT35FG
CTT10tmp CTT1BSE tmp CTT2CE0tmp CTT35F7.1
[#] CTT1EC tmp [#]CTTIESAMp  [#]CTTZCEIMmp  [#]CTT371tn
[#] CTT1ED tmp [#]CTTIESAmp  [#]CTT2E30tmp  [#]CTT44CD

File name: I

Files of type: [l Files [+.)

j Cancel |

Select the data file, and then click OPEN.

System Response

The system immediately invokes the post-communications
process with thefile, just asif the file was received through a

communication session.
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Using Stand-alone Communications

Introduction

SENDFILE.exe

program

A stand-alone communications module is provided with Sterling
Gentran:Director. The program SENDFILE.exeis used to browse and select
a communications profile. It can also be used to test communications, and is
recommended for use when changing a password or getting quick reports.

The SENDFILE.exe program can be run from Sterling Gentran:Director
program group. To launch the program, from the Windows start menu select
Programs>Serling Gentran Director Connection>Send file. The
Communication Options dialog box is displayed.

Communication Options E

Filename ta send:

| Browse... |

Profile to uze:

— Reguired if zending to Advantis—————————————
Feceiver's Advantis ACCOUNTID: I
Receiver's Advantiz USERID: I

— Reguired if zending to an OF TP networl:

Receiver's OFTF 1D: oK.

Cancel
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Managing Communication Port Profiles

Creating and Editing Communication Port Profiles

Introduction o _ _ _ :
A communication port is the physical serial port on your PC to which your

modem is connected. You must have at |east one port definition on your
system for the Communicator to run. However, you can configure as many
definitions of the four communication ports (COM1, COM2, COM3, and
COM4) on your system as necessary. The port profilesyou establish can a'so
be copied and modified, if necessary.

Note

If you have one modem, you can only configure the physical port to which
the modem is attached. However, Sterling Gentran:Director enables you to
set up multiple port profiles for each physical communication port. This
enables you to define:

B Different modem speeds and initialization strings for the same port.
B Specific definitions for each network you will be accessing.

IBM Sterling Gentran:Director User Guide May 2011 5-19



Creating and Editing Communication Port Profiles Using Communications

Procedure _ . : :
To create or edit acommunication port profile, complete the following steps:

Step Action

1 From the Tools menu:

B Select Communications.

B Select Ports from the Communications submenu.
System Response

The Communication Port Setup dialog box is displayed.

Communication Port Setup E
Part Profiles: Close
Setip..

Loy
elete

2 Do you want to create or modify anew port profile?

m |f you want to create anew profile, click NeEw and continue
with step 3.

System Response

The New Port Profile dialog box is displayed.

B |f youwant to edit an existing profile, select the port profile
you want to modify, click SETuP, and continue with step 4.

System Response

The Port Setup dialog box is displayed.

Continued on next page
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Using Communications

Creating and Editing Communication Port Profiles

(Cont.)
Step

Action

B |nthe Name box, type a unique name for the new port
profile.

B Click OK and continue with step 4.

System Response

The Port Setup dialog box is displayed.

Boit: |COMT =

Baud: ISEIJI] 'I Cancel |
Line: ITone 'I

Initialization: |

Flows Control

& Hardware Flow Control [CTS/RTS)
" Software Flow Control [<OFFA40M)

From the Port drop-down list, select the seria port to which
your modem is connected on this communication controller.

Values

m COM1
B COM2
B COM3
m COM4

Note
The system uses this port to send data to and from your modem.

From the Baud drop-down list, select the baud rate of your
modem.

Values

m 1200 B 9600 B 28400
H 2400 B 19200

Note

The baud rate is the transmission speed of the modem line. The
default baud rateis“19200.” If you are unsure about the rate at
which your modem operates, refer to the operations manual for
your modem.

Continued on next page
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Creating and Editing Communication Port Profiles Using Communications

(Cont.)
Step

Action

From the Line drop-down list, select the telephone dialing
method that your modem will use.

Values
B Tone - touch tone leased dialing. Thisisthe default.
B Pulse- pulsediading.

In the Initialization box, type the command(s) to initialize your
modem.

Note

These commands will vary depending on your modem’stype. If
you do not know the modem initialization command(s), refer to
the operations manual for your modem.

Select the flow control option that corresponds to the flow
control commands you set on your modem.

Note

These options control the flow of information from your PC to
your modem, and from your modem to your PC.

Click OK.

System Response

The port profile setup is saved and the Communication Port
Setup dialog box is displayed.

Click CLosE to exit the Communication Port Setup dialog box
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Copying Communication Port Profiles

Copying Communication Port Profiles

Introduction

The copy port profile feature allows you to save a port profile as a different
name and make modifications to that port profile. This keeps you from
having to create a new port profile from scratch.7

Procedure

To copy acommunication port profile, complete the following steps:

Step

Action

1

From the Tools menu:
B Select Communications.

B Sdlect Ports from the Communications submenu.

System Response

The Communication Port Setup dialog box is displayed.

Communication Port Setup [ %]
ot Profiles:

TEST

Continued on next page
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Copying Communication Port Profiles Using Communications

(Cont.)
Step Action

2 Do the following:

B Sdect the port profile you want to copy.
m  Click Copy.

System Response
The Copy Port Profile dialog box is displayed.

Copy Port Profile E

Copying TEST

Enter Mew Part Prafile Marne:

Cancel |

3 Do the following:

B Type anew port profile name.

m Click OK.

System Response

The port is copied under the new name and the Port Setup

dialog box is displayed.
Poit: Im
Baud: lm Cancel |
Line: m

Initialization: |

Flows Control

& Hardware Flow Control [CTS/RTS)
" Software Flow Control [<OFFA40M)

4 Make the appropriate modification to the port profile.

Reference

For more information on modifying communication port
profiles, see Procedure on page 5 - 20.
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Deleting Communication Port Profiles

Deleting Communication Port Profiles

Procedure

To delete acommunication port profile, complete the following steps:

Step

Action

1

From the Tools menu:
B Select Communications.

B Sdlect Ports from the Communications submenu.

System Response

The Communication Port Setup dialog box is displayed.

Part Profiles:
Setup...
New...
Lopy
Delete

B Sdlect the port profile you want to delete.

B Click DELETE.

System Response

The system prompts you to confirm the delete operation.

Click YES to remove the port profile.

IBM Sterling Gentran:Director User Guide
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Using Communication Profiles

Creating and Editing Communication Profiles

Introduction

The communication profile contains al of the relevant information needed to
establish a communication session. You must define at least one
communication profile on your system, but you can define multiple
communication profiles, if necessary.

You need to create anew communication profileif you will be using another
network or communicating directly with your trading partners.

A communication profile must be linked to a partner profilein Partner Editor
before the Communicator can use that profile to communicate.

Reference

For more information on linking a communication profile to a partner
profile, see Creating a New Partner Definition on page 3 - 28.
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Procedure . . . ,
To create or edit acommunication profile, complete the following steps:

Step Action

1 From the Tools menu:

a.  Select Communications.

b. Select Profile from the Communications submenu.
System Response
The Communication Profile Setup dialog box is displayed.

2 Do you want to create or modify a communication profile?

B If you want to create anew profile, click NEw and continue with step 3.
System Response
The New Profile dialog box is displayed.

B |f you want to edit an existing profile, select the profile you want to modify, click
SETUP and continue with step 4.

System Response
The Profile Setup dialog box is displayed.
Continued on next page
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Creating and Editing Communication Profiles

Using Communications

(Cont.)
Step Action
3 In the Name box, type the unique name of the new communication profile. Then, click
OK and continue with step 4.
System Response
The Profile Setup dialog box is displayed.
Profile Setup - GENTRAN Tutorial =
Profile Type:
|Ster|ing B2B Collaboration Metwark, Lj B
Configure Sterling B2E Collaboration Metwark ] Advanced >>
4 From the Profile Type drop-down list, select atype for the communication profile.
Values
B Sterling B2B Collaboration Network
B File Copy
Continued on next page
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(Cont.)
Step

Action

Configuring Sterling B2B Collaboration Network

Did you select a Profile Type of Sterling B2B Collaboration Network?
B If no, continue with the “ Setting advanced options’ section of this table.

System Response
The Sterling B2B Collaboration Network dialog box is displayed.
B |f yes, click Configure Sterling B2B Collaboration Network to configure those
options.
Reference

For more information, see the Mailboxes section in chapter 7 (Connection Manager)
of the IBM® Serling Gentran: Director® Connection User Guide.

Setting advanced options (processor and tracing)

On the Profile Setup dialog box, click ADVANCED>>.

System Response
The fields defined below are appended to the Profile Setup dialog box.

Note

If your data needs to be in a specific format, you can use the XPROCESS utility program
to manipulate the data you send. For information on how to use the XPROCESS
program, see XPROCESS Utility Program on page 5 - 32.

Field Definition

Pre-Processor Enables you to specify a program name with arguments
that are called for every file to be sent. Each send filespec
will be appended to the command line.

Example

Y ou can specify a program to be run against every fileto
be sent before communication starts.

Note

This option will not work if you have selected Sterling
B2B Collaboration Network as the Profile Type.

Continued on next page
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Creating and Editing Communication Profiles Using Communications

(Cont.)
Step Action

1 Pre-Post Processor Enables you to specify a program name with arguments
(cont.) that will be called for every file received. Each receive

filespec will be appended to the command line.

Example

Y ou can specify a program that will be run against every
file received before the post-processor processes it.
Note

This option will not work if you have selected Sterling
B2B Collaboration Network as the Profile Type.

Post Processor Enables you to specify the program that will processthe
received data.
Example

You can specify a program that will process all received
datain the system and update the status.

Caution

Do not change the default value “commpost.exe” unless
you areinstructed to do so by Sterling Gentran:Director
Customer Support.

Tracel Enables a“datascope” trace that shows every byte sent or
received during a session.

Warning

If Tracel or Trace? is enabled, the trace information is
written to the communication log file.
You should only select the Tracel and/or Trace2 check box

to debug communication problems. Clear these check
boxes once the problem is resolved.

Continued on next page
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Creating and Editing Communication Profiles

(Cont.)
Step Action
1 Trace? Enables afunction level trace to show every function
(cont.) called during a session.
Warning
If Tracel or Trace? is enabled, the trace information will
be written to the communication log file.
You should only select the Tracel and/or Trace2 check box
to debug communication problems. You should clear these
check boxes once the problem is resolved.
Note:
Windows NT and 2000 users must select Trace 2 for the
communication session to run properly.
Saving the communication profile
1 Click OK.
System Response
The profile setup is saved and the Communication Profile Setup dialog box is displayed.
2 Click CLoSE.

System Response

The Communication Profile Setup dialog box is closed.

IBM Sterling Gentran:Director User Guide May 2011 5-31



XPROCESS Utility Program Using Communications

XPROCESS Utility Program

Introduction

XPROCESS
Options

The XPROCESS utility program enables you to manipulate data that you
send or receive into a specific format.

If you specify this program in the Pre-Processor field of the Profile Setup
diaog box (Advanced section), it will manipulate the data you send based on
the specified options.

If you specify this program in the Pre-Post Processor field of the Profile
Setup dialog box (Advanced section), it will manipulate the data that was
received based on the specified options.

When you specify the XPROCESS program in either the Pre-Processor or
Pre-Post Processor field, you must also specify an option using the following
format: XPROCESS - n (n = value from 0 to 13). See XPROCESS Options
below for alist of options.

The available XPROCESS program options are listed in the following table:

Note

For the options listed bel ow, you only need to specify a[filename] if you are
running XPROCESS from a command line.

Option Definition What you type
-0 Converts any specified hex XPROCESS-0
character to any other specified [hexValuel] [hexValue?]
hex character. [filename]

The syntax for the hex valuesis
“0x” followed by the hex code.
For example, for hexadecimal A,
you would type “0x41".

-1 Appends the file you specify to XPROCESS-1
the beginning of the data. [filename]

Continued on next page
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XPROCESS Utility Program

(Cont.)
Option Definition What you type

-2 Replacestilde (~)/carriagereturn | XPROCESS -2
(OD)/line feeds (0A) with [filename]
carriage returns (OD).

-3 Replaces all carriage returns XPROCESS-3
(OD) with tildes (~) and drops [filename]
any line feeds (0A).

-4 Drops al carriage returns (0OD) XPROCESS -4
and line feeds (0A). [filename]

-5 Drops all carriage returns (OD) XPROCESS-5
and linefeeds (OA) and addshex | [filename]

Ox1A to the end of thefile.

-6 Removes all hex 0x1A fromthe | XPROCESS -6
file. [filename]

-7 Adds GM header/trailer records | XPROCESS-7
and drops al carriage returns [filename]

(OD) and line feeds (0A).

-8 Replacesevery tilde(~), carriage | XPROCESS -8
return (OD), and line feed (0A) [filename]
with line feed (0A).

-9 Replaces every line feed (0A) XPROCESS -9
with tilde (~). [filename]

-10 Replaces al carriage returns XPROCESS-10
(OD) with carriage return (0D) [filename]
and linefeed (0A).

-1 Replacesastring of hexadecimal | XPROCESS -11
characters with another string of | [hexStringl]
hexadecimal characters. [hexSring?] [filename]

-12 Removes all occurrences of a XPROCESS -12
hexadecimal string from afile. [hexSring] [filename]

-13 Inserts a hexadecimal stringat a | XPROCESS -13
specified increment (number of [#bytes][hexSringl]
bytes) in the input file. [hexSring2] [filename]
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Using the VATPRINT Utility Program

Introduction

Using VATPRINT

Syntax

Parameters

The VATPRINT utility is an external data processor used to generate Value
Added Tax (VAT) Transmission Reports when sending or receiving
TRADACOMS or UK EDIFACT data. Thisreport is generated in the format
defined by UK Customs and Excise and the UK Article Number Association
(ANA).

You invoke the VATPRINT utility by entering the utility name and
parameters in the Pre-Processor and/or Pre-Post Processor fields of the
Communication Profile Setup screen.The Pre-Processor is used for sending
and the Pre-Post Processor is used for receiving.

The syntax of the VATPRINT utility is:
VATPRINT [option] [Print_filename] [Attachment_filename]

The VATPRINT utility has the following parameters:

Iltem Description

Option B /p Writesthe report to the printer.
B /f Createsor appendsthe report to afile.

Print_filename The name of thefile to create or append. Used
only with the /f option. If the Print_filename
contains an asterisk (*), then the asterisk will
be replaced with the current date and timeiin
the format YYYYMMDDHHMMSS.

Continued on next page
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Using the VATPRINT Utility Program

Example

Error Handling

Supported
Standards
Versions

Supported
Messages

Iltem Description

Attachment_filename The name of the file containing the EDI
messages that you want the VAT Report for.
Used only when the utility isinvoked
manually from a Command Prompt. When
used as a Pre-Processor or Pre-Post Processor
within a Communication Profile, the currently
processing file nameis substituted
dynamically each time the utility isrun.

In this example, you want to generate a VAT report from Interoffice Ltd., a
Trading Partner in the UK who uses the UK EDIFACT standards. You enter
the command line shown below in the Pre-Post Processor field on the
Communication Profile assigned to Interoffice. When messages are received
from Interoffice, a VAT report is generated and appended to afilein the
C:\Reports directory.

Command line:
VATPRINT.EXE /f C:\Reports\VATreport.txt

The VATPRINT utility records processing errorsin the file Vat.err. Thisfile
Is stored in the bin directory where you installed Sterling Gentran:Director.
Errors are time- and date-stamped, and the most recent error islocated at the
end of thefile.

The following standards versions are supported with this release of Sterling
Gentran:Director:

B TRADACOMSV9
B EDIFACT 90.1

TRADACOMS Credit Notes and TRADACOMS and EDIFACT INVOIC
messages are the only messages that are supported with this rel ease of
Sterling Gentran:Director.
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Using Communications

Copying Communication Profiles

Introduction

The copy profile feature enables you to save aprofile as a different name and

make modifications to the profile, instead of creating a new profile from
scratch.

Procedure . : .
To copy acommunication profile, complete the following steps:
Step Action
1 From the Tools menu:

B Select Communications.
B Sdlect Profile from the Communications submenu.

System Response
The Communication Profile Setup dialog box is displayed.

Communication Profile Setup [ %]

Profiles

- Setup... -
New...
Lapy

..
Delete

fu}

Continued on next page

May 2011 IBM Sterling Gentran:Director User Guide



Using Communications Copying Communication Profiles

(Cont.)
Step Action
2 B Select the profile you want to copy.
m Click Copy.
System Response
The Copy Profile dialog box is displayed.
Copy Profile
Copying TEST
Enter Mew Profile Mame:
|
3 B Typethe new profile name.
B Click OK.
System Response
The profileis copied under the new name and the Profile Setup dialog box is
displayed.
Profile Setup - GENTRAN Tutorial
Frafile Type:
|Sterling BZB Collaboration M etwork, Lj Bercel
Configure Sterling B2E Collaboration Metwark, | Advanced >
4 Make any necessary changes to the profile.
Reference
For moreinformation on modifying communication profiles, see Creating and
Editing Communication Profiles on page 5 - 26.
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Deleting Communication Profiles

Procedure . . ,
To delete a communication profile, complete the following steps:

Step Action

1 From the Tools menu:

B Select Communications.

B Select Profile from the Communications submenul.
System Response

The Communication Profile Setup dialog box is displayed.

Communication Profile Setup E2

Profiles:

r!_ .
New...
Lopy
Delete

2 B Sdlect the profile you want to delete.
B Click DELETE.

System Response
The system prompts you to confirm the delete operation.

3 Click YES to remove the profile.
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Overview

Using the Communication Log

Overview

Log Summary

The Log Summary enables you to view, print, delete, purge, or reprocess
communication log entries. You can view information for all completed
communication sessions, including the following:

Status of the session

Finish date and time

Profile name

Name of the application that requested the communication session
Session control number

Log Detail

The Log Detail function enables you to view the complete communication
log for a selected session, including trace information if the Trace functioniis
enabled.
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Using the Log Summary

Procedure

To use the log summary, compl ete the following steps:

Step

Action

From the Tools menu:

B Select Communications.

B Select Log from the submenu.

System Response

The Communication Log Summary window is displayed.

: Communication Log Summary [_ O] =]
el Enmtls Deletel Furgell Bepazess! Closel

Status Completed Profile Initiator Control
NO ENTRIES IN LOG

Note
Thiswindow contains the available session control records for the completed
communication sessions.

Continued on next page
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Using the Log Summary

(Cont.)
Step Action

2 Do one of the following:
m  View the summary information for completed session control records.
W Usethefollowing table to determine your next step.
I F you want to... THEN...
view the complete click LoG DETAIL
communication log for aselected
session,
print the log summary;, click PRINT!
purge session control records B select asession control record or
older than the number of days records and click DELETE!
you specify,
delete a selected document, click PURGE!
restart the post-communications | B select asession control record and
process for any filesthat were click REPROCESS!
received,

3 Click CLosE! to exit the Log Summary window.

Status

information The following table describes the status options that can be displayed for a

communication session.

Status Description
Success Indicates that the communication session was a
SuCCess.
Failure Indicates that the communication session failed.
Continued on next page
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Status Description

Snd Fail B Refersto a Send/Receive session. A Send/
Receive session consists of a Send sub-process
and Receive sub-process.

B |ndicates that the Send sub-process failed, but
the Receive sub-process succeeded.

Note

If both sub-processes succeed, the statusis Success.
If both sub-processesfail, the statusis Failure.

Rcv Fail B Refersto a Send/Receive session. A Send/
Receive session consists of a Send sub-process
and Receive sub-process.

B [ndicates that the Send sub-process succeeded,
but the Receive sub-process failed.

Note

If both sub-processes succeed, the statusis Success.
If both sub-processesfail, the statusis Failure.
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Using the Log Detail

Using the Log Detail

Procedure , _
To use the log detail, complete the following steps:
Step Action
1 From the Tools menu:

B Select Communications.
B Select Log from the submenu.
System Response
The Communication Log Summary window is displayed.
: Communication Log Summary =] E3

el Enmtls Deletel Furgell Bepazess! Closel
Status Completed Profile Initiator Control

NO ENTRIES IN LOG

Note

Thiswindow contains the available session control records for the completed

communication sessions.

Continued on next page
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Using the Log Detail Using Communications

(Cont.)
Step Action

2 B Select alog summary record.
B Click DETAIL!
System Response
The Communication Log Detail window is displayed.
Note
The Communication Log Detail window displays the details for each action
from the selected communication session record.

3 Use the following table to determine your next step.
IF you want to... THEN...
print the log details, click PRINT!
return to the Log Summary click SUMMARY!
Window,
exit the Log Detail window, click CLOsE!

4 Click CLosE! to exit the Log Summary window.
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Using the Communicator

Overview

Introduction _ _ _ _ .
The Communicator isthe Sterling Gentran:Director communication feature.

The Communicator window lists the currently executing communication
session and all sessions waiting to execute.

The Communicator gives you access to al the communications functions
available in Sterling Gentran:Director, enables you to view the currently
gueued communication sessions, and delete communication jobs from the
queue.

How to access . . .
You can access the Communicator by selecting Gentran Director

Communicator from the Start menu, or by selecting the Communicator icon
from your taskbar when a communication session is executing.
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Viewing a Communication Session

Procedure _ , . .
To view the currently executing and queued communication sessions,

complete the following steps:

Step Action

1 From the Start menu:

B Select Gentran Director.

B Seect Gentran Director Communicator.
System Response

The Communicator window is displayed.

Dpiors Help

HO JODS IN QUEUE

Note

Thiswindow enables you to view information for all queued
communication sessions. The available information includes
the following:

W Status of the session

Requested date and time

Profile name

Name of the application that requested the
communication session

Session control number
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Deleting a Communication Session

Deleting a Communication Session

Procedure

To delete a currently queued communication session, compl ete the following

steps:

Step

Action

1

From the Start menu:

B Sdect Gentran Director.

B Sdect Gentran Director Communicator.
System Response

The Communicator window is displayed.

Dpiors Help

HO JODS IN QUEUE

Select the communi cation session you want to remove from
the queue.

From the Options menu, select Del ete Job.
System Response
The communication session is removed from the queue.

Note

You can only delete jobs that are queued; not jobs that are
currently executing.
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Overview

Using Interchanges

Overview

In this chapter

Interchange
feature

T

his chapter explains how to use interchanges with Sterling

Gentran:Director.

The Interchange feature enables you to:

View ahierarchical list of all the interchanges that were sent or
received.

View status information for the interchanges. For example, whether or
not a functional acknowledgment was received and the status of that
acknowledgment.

Filter the display of interchanges.
Access the documents within the interchanges.
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Understanding the Interchanges Browser

Introduction . _ ,
The Interchanges browser enables you to view alist of all the interchanges,

groups, and documents that were sent or received. This browser contains
status information about the interchanges. For example, whether or not a
functional acknowledgment was received and the status of that
acknowledgment.

Note
The Interchanges browser can always be accessed.

Information

organization Theinformation on the Interchanges browser is organized in a hierarchical
manner. The following table describes the hierarchical organization of the
information on the Interchanges browser:

Level How to access Information displayed

Interchange Open Interchanges
browser

The direction of the interchange

Control number

Partner name

Date and time the interchange was created
Process status

Network status

Interchange acknowledgment status

Note
Any components that are missing or not appropriate for
aparticular interchange, are not displayed.

Group Double-click an B The group control number
interchange B Group type
B Group acknowledgment status

Note
Any components that are missing or not appropriate for
aparticular group, are not displayed.

Continued on next page
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Using Interchanges

(Cont.)
Level How to access Information displayed
Document Double-click agroup B The document status
B Document control number
B Document typ
B Document name
B Reference data
B Transaction acknowledgment status
Note
Any components that are missing or not appropriate for
aparticular document, are not displayed.
EDI data Double-click a EDI data

document

Note

A screen entry

tranglation object for

that document must be

available on your

system.

Browser

functions You can perform the following functions on the Interchanges browser:

B Filter the display of interchanges from the Interchanges Filter dialog
box by date, partner, and direction (inbound and outbound).

B Display theraw-EDI data or translator report data for the selected
interchange or document, in the Data view and Translator Report view

windows.

B Toggle the status of interchanges between “Ready to Send” and “Hold".
B Print or delete a selected item.

Note

Use the toggle function if you do not want to send an interchange right away.

May 2011
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Understanding the Interchanges Browser

How to access

To access the Interchange Browser, select | nterchanges from The Desk. The

Interchanges browser is displayed.

= Interchanges Suramary - 3 M=l E3
=1 = |All Partners Date/Time Checking is .
=14 PETZONET 0521 |BEG*XX*NE*123456769
@UUUUUUUU'I PETZONE 0521 [NTE*001*FREEFCORM ME
L=i PO REF+X¥+123456759012
% 0001 ALSUESEEAEEEEEEEER v
& 000000004 PETZONE 051 [ "ET*EBILL TO NIME-
Lpm Po M3+123 BILL TO STRE
T _[w4rEILLTOCITY"0R*11
[&3000¢ 850 100002 1 +5 T+ SHIPTONAME~

N3 #*SHIPTO STREET*SU
N4 *SHIPCITT*OH*2222
PO1#1%10¥EA*10**CCH

PID*F*#**THIS I3 jﬂ
GI I 3

Document Summary

Trading Parthner:
Direction:
Interchange Control
Group Control:
Document Control:

| K1 1Y
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Using Interchanges

Viewing Interchanges

Procedure . .
To view interchanges, complete the following steps:
Step Action
1 From The Desk, select Interchanges.
System Response
The Interchanges browser is displayed.
i Interchanges Summary - 3 M=l E
=1 = | Al Partners D ate/Time Checking iz Off.
=4 PETZONE1 0521 |[BEG*XX*NE# 123456759 &
(&, 000000001 PETZONE 0521 [NTE*0D01*FREEFORM ME
Lb1 [0 REF*XX*123456739012
ITD 14+ s ¥ & &+ v ¥ K+ % TH
& 000000004 PETZONE 0521 E;:?;;B;EELT$0N2¥§;
LBL'4 Fo _[H4*BILLTOCITY#OH*11
(0004 850 1000022 s +5T+SEIPTONAME~
M3 *3SHIPTO STREET*3U
M4*ZHIPCITY*OH*Z2E2
PO1%1%10+*EA*10%*CCH*
PID*F*+#+*THI3 IS IT =
K _>IJ
Document  Summary =
Trading Partner:
Direction:
Interchange Control
Group Control:
Document Control:
4 | Ji3 | K1 [ ' 4
2 Do you want to filter the display of interchanges by status?
B If yes, see Sorting Interchanges on page 6 - 8.
| If no, continue with step 3.
Note
The Sort function enables you to filter the display of interchanges by date,
partner, and direction (inbound and outbound).
3 Select an interchange, or a group of interchangesiif allowed.
Continued on next page
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Viewing Interchanges

(Cont.)
Step

Action

Use the following table to determine your next step.

IF you want to...

THEN select...

view atrandator report of the
actionsthe translator took on this
interchange,

B View from the Commands menu, and
then Translator Report.

view the content of asingle
selected interchange in raw EDI
data format,

B [nterchanges from the View menu.
B Datafrom the View submenu.

print a selected interchange or a
summary of interchanges,

Print from the File menu.

view the translator report for a
single selected interchange,

B [nterchanges from the View menu.
W Trandator Report from the View
submenu.

delete a selected interchange and
all associated documents,

Delete from the Document menu.

Notes

B |f you delete an interchange with a
status of “Queued,” you receive a
warning that you must remove
specified messages from Out
Documents and from your trading
partner’s Inbox. If you proceed, you
are warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

B |f you delete an interchange with a
status of “Ready to send,” you are
warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

attach an interchange to a partner

Attach from the Document menu.
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Using Interchanges

Sorting Interchanges

Introduction

When the Interchanges browser is active, the Sort function enables you to
filter the display of interchanges by date, partner, and direction for inbound
and outbound.

Procedure

To sort interchanges by partner and/or date, compl ete the following steps:

Step

Action

1

From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

S [nterchanges Surmary - 3

M= E3
=1 = |All Partners Date/Time Checking is .

=14 PETZONE1 0521 |BEG*XX*NE*123456769 ~|
(& 000000001 PETZONE 05/21 [NTE*O01*FREEFORM ME
Lb1 [Ta] REF*XX*123456759012

(2000000004
Lb4
L (g o004

PETZONE

ITDﬁquﬁTﬁTﬁ‘TfﬁfﬁTH
N1*ET*BILL TO NAME~
N3 123 BILL TO STRE
_ [H47BILLTOCITY#OH 11
1000022 by #5THSHIPTONAME-
N3 *SHIPTO STREET#SU
N4 *SHIPCITTAOH 2222
PO1%1%10¥EAT10FCCH

PID*F*#**THIS I3 jﬂ
3

K

Document Summary -
Trading Parthner:
Direction:
Interchange Control

0a21
PO
850

Group Control:
Document Control:

-

M 4

| KIS

Continued on next page
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(Cont.)
Step Action
2 From the Commands menu, select Sort.
System Response
The Interchange Filter dialog box is displayed.
Interchange Filter E
~fae— ~Patther———————
hom——————————————
01 Janwary 94 00:00
K0l I
— Toi
27 May 57 13.00
K0l I
2 & sags ey Unselect All Partners
Direction——————————————————
¥ Mo Date/Time Checking I InBound B0
Cancl | V OutBound =
3 Do you want the system to filter the display of interchanges

by date and time?

B If yes, clear the “No Date/Time Checking” check box
and proceed with step 4.

B | no, select the “No Date/Time Checking” check box
and proceed with step 6.

4 Use the Date From slide bar to select the beginning date of a
date range, from which the system should filter the display
of interchanges.

5 Do you want the end date for the date range to always be the
current system date and time?

W |f yes, select the “ Always Current” check box.

W [f no, deselect the “ Always Current” check box and
move the Date to slide bar to the date and time you want
to use.

Continued on next page
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Using Interchanges

(Cont.)
Step

Action

Do you want to filter the display of interchanges by partner?

W [f yes, select the partners that you want displayed from
the Partner list. The Partner list contains all the partner
profiles on your system.

Note

By default, all partners are displayed. You can click partner

profilesto deselect them and change the display. To deselect
al the partner profiles, click UNSELECT ALL PARTNERS. At

least one partner must be selected.

® If no, continue with step 7.

Which direction do you want to filter the interchange?

The default display is both inbound and outbound
interchanges. Click the Inbound or Outbound check box to
clear the direction.

Note

At least one of the Direction check boxes must be selected.

May 2011

IBM Sterling Gentran:Director User Guide



Using Interchanges

Viewing Documents within Interchanges

Viewing Documents within Interchanges

Introduction

You can view the individual documentsin an interchange aslong as a screen
entry translation object for each document is available on your system.

Procedure

To view the documents within an interchange, complete the following steps:

Step

Action

1

From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

&4 Interchanges Summary - 3

k=1 0= IAII Partriers IDate.:’Time Checking is Off.

E4 PETZOMNET 0521 |BEG*XX*NE+*123456780
) 000000001 PETZONE 0521 [NTE*0D1+FREEFORN HE
LB'] PO REF*EE*123456789012
= ITD*lq******?**?*TH
) 000000004 PETZONE 05721
LB4 PO I3+123 BILL TO ITRE
= IN4FBTLLTOCITT#OR#11

[ 0004 830 1000025 i1 #&T+SHIPTONANE~

N3 *SHIPTO ITREET*3U
N4*SHIPCITY*OH*2222
PO1*1*10*EA*10%*CC*

PID*F****THI3 I3 ilj
4| I »

Document Summary o

Trading Parthner:
Direction:
Interchange Control
Group Control:
Document Control:

a | I3 || K1 o

Note

The Interchanges browser contains all the interchanges, group,
and documents that were sent or received.

Continued on next page
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(Cont.)
Step Action

2 Double-click a document to view it.
Note
You must have a screen entry translation object for this
document available on your system.

3 Select a document.

4 Use the following table to determine your next step.
I F you want to... THEN select...
view atrandator B [nterchanges from the View menu,
report of the and then Trandlator Report.
actions the

translator took on
this document,

view thecontent of | B Interchanges from the View menu.
asingle selected B Datafrom the View submenu.
interchange in raw
EDI data format,

print a selected Print from the File menu.
document or
tranglation report,

delete a selected Delete from the Document menu.
document,

copy thedocument | B Copy from the Document menu.

to the appropriate B Select the appropriate browser:

browser, U Select 2In Documentsor In
Documents for compliant Inbound
documents.

U Select Workspace for outbound
documents from the submenu.
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Attaching Interchanges to a Partner

Attaching Interchanges to a Partner

Introduction

Procedure

The Attach to Partner dialog box can be accessed when the Interchanges
browser is active and one interchange is selected. The Attach function
enables you to link the interchanges to a partner. For example, you should
use the Attach function if you received documents that did not have an
identifiable partner and are now listed without a partner in the ?2In
Documents browser.

Note

The interchanges for documents not having an identifiable partner, are listed
in the Interchanges browser without a partner.

To attach an interchange to a partner, complete the following steps:

Step

Action

1

From The Desk, select Interchanges.

System Response

The Interchanges browser is displayed.

4 [nterchanges Summary - 3

B=1 I (Al Partners  |Date/Time Checking is OF

=4 FETTONET
FETZOMNE

) 000000001

a8
05

BEG*IX*NE*123456765 «
[NTE*001*FREEFORM ME
REF*ZX*123456789012

ORI, |ITD# 141+ # #4315 4TH

M1*BT*BILL TO MNAME~

) 000000004 08721
L s PO M3*123 BILL TO STRE
(=] . M4*BILLTOCITY*0H*11
L@an 850 1000022 N1*3T*SHIPTONAME~
N3 *SHIPTO STREET*3U
N4 *SHIPCITV*OH*2222
PO1*1*10FEAT10%*CCH
PID*F#*#+THIS IS IT »
[l »
Document Sukmary |
Trading Partner:
Direction:
Interchange Control
Group Control:
Docurent Control:
S | | KIS I
Continued on next page
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Attaching Interchanges to a Partner

Using Interchanges

(Cont.)
Step

Action

Select an interchange.

Doesthe partner already exist?

m If yes, continue with step 4.
B If no, you must create the partner before you can
continue.

Reference

For instructions on creating a new partner and partner
relationship, see Creating a New Partner Definition on page
3-28.

From the Document menu, select Attach.
System Response
The Select Partner dialog box is displayed.

Select Partner

Pozzible Partners

FETZ0OME
FETZOMET
FETZ0ME?Z
SYSTEMUSR

Cancel Help |

Continued on next page
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Attaching Interchanges to a Partner

(Cont.)
Step

Action

B Select apartner from the Possible Partnerslist.
H Click OK.

System Response

The selected interchange is linked to the partner, and the
Interchange browser is displayed.

Exceptions

1. If the partner to which you are attaching the interchange
has more than one interchange definition, you are
prompted with an additional dialog box. In this case, you
should do the following:

B Select the appropriate interchange definition.
B Click OK.

2. If the partner to which you are attaching the interchange
has more than one group definition, you are prompted
with an additional dialog box. In this case, you should do
the following:

B Select the appropriate group definition.
m Click OK.

3. If the partner to which you are attaching the interchange
has more than one relationship defined for a type of
document in the interchange, you are prompted with an
additional dialog box for each instance. In this case, you
should do the following:

B Select the appropriate relationship definition.
H Click OK.

After you attach the interchange to a partner, open ?In
Documents by selecting it from the appropriate area of The
Desk.

Note

You can then export, print, or move the documents to the In
Drawer.
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Using Interchanges

Resending Interchanges

Introduction

To resend outbound interchanges from the Interchanges browser, you must
use the Resend command.You can only resend interchanges that were
previously sent or that have a status of “Ready to send.”

Resend process

The following table describes the system process that occurs when you
resend a selected interchange:

Stage

Description

1

The documents in the selected interchange are batched into
EDI envelopes and the required control numbers, etc., are
generated from the information in the partner profile.

After the interchangeis built, it islisted in the Interchange
browser. For instructions on viewing an interchange, see
Miewing Interchanges on page 6 - 6.

If the communication fails because there is no mailbox set up
or the Mailbox service is not started, the interchange and
documents are left in a“Ready to send” status.

If communication fails because there is no modem, the
interchange and documents are left in a“ Queued” status.

Note

No user action is required at this point. Interchanges that
failed to send are automatically sent as part of the next
transmission session.

After communication is successful, the documents are moved
to the Out Drawer and the interchange status is set to “ Sent.”

6-16 May 2011

IBM Sterling Gentran:Director User Guide



Using Interchanges

Resending Interchanges

Procedure
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To resend outbound interchanges, complete the following steps:

Step

Action

1

From The Desk, select Interchanges.

System Response
The Interchanges browser is displayed.

B L= Al Partners | Date/Time Checking i OIf
=k PETZONE! 05/21 |BEGHXK*NE +123456789 4
2000000001 PETZONE 05621 [HTE*00L*FREEFORK HE
L=t PO REF*XX+123456789012
oy TTD A g R xR RATR
) 000000004 PETZONE 0g [[ITTETTSILL TO HAKES
Lbi PO 37123 BILL TO STRE
T _ [H4*BILLTOCITY*OH*11
oo 850 1000027 1+ #SHIPTONAME
N3 *SHIPTO STREET*3T
M4 *SHIPCITV*0H*2222
POLTLFI0REAT10**CCH
PIDAF****THIS IS IT &
4 »
Document Summary |
[Trading Partner:
Direction:
Interchange Control
Group Control:
locument. Control:
-
0 — o] ETN| P

Select the outbound interchange that needs to be resent.

From the Commands menu, select Resend.

System Response
The Sterling Gentran:Director dialog box is displayed.

@ Start a Send and Receive Transmission 5 ession now?

Click YEsto start the transmission session.
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Overview

Using Acknowledgments

Overview

In this chapter

Acknowledge
feature

This chapter explains how to use Sterling Gentran:Director
acknowledgments, and includes the following topics:

B Defining inbound acknowledgment criteria
B Defining outbound acknowledgment criteria
B Manualy acknowledging a document

Acknowledgments are sent to atrading partner to inform them that you
received their transmission, and to tell them about any errors. You must
definethelevel of acknowledgmentsfor those you receive from your trading
partners, as well as those that you send to your trading partners when you
receive a transmission from them.
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Defining Inbound Acknowledgment Criteria

Introduction o ,
The criteria that the system uses to acknowledge inbound document,

functional groups, and/or interchangesis defined at the Partner level. The
tranglation objects that are necessary to generate functional
acknowledgments are included as system trandation objects and are
registered when you install Sterling Gentran:Director.

Note

If you are generating functional acknowledgments as aresult of receiving
documents for an inbound relationship, part of establishing that inbound
relationship is setting up the corresponding outbound relationship to
generate acknowledgments.

Reference

For information on establishing an outbound relationship to generate
acknowledgments, see Creating a New Outbound Relationship on
page 3-43.
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Defining Inbound Acknowledgment Criteria Using Acknowledgments

Procedure

To define criteriato generate acknowledgments, compl ete the following

steps:

Step

Action

1

Document acknowledgment criteriais defined when you set
up the partner relationship using the Advanced options on
the Inbound Relationship dialog box.

Seguence Checking Last Uzed Contral Mumber, Generate Acknowledgments
@ Mone IDDDU @® Mo
€ Duplicate [ Duplicate Documents ) Yes - Mo Ermor Dietail

I Incremental } .
! Chianological | [~ Skip Compliance Check © ‘Yes - with Enor Detal

Test Indicatar: | ) Test (® Praoduction

Reference

For more information about setting parameters on the
Inbound Relationship dialog box, see page 3 - 31.

Continued on next page
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Defining Inbound Acknowledgment Criteria

(Cont.)
Step

Action

Functional Group acknowledgment criteriais defined when
you set up the Inbound Group Entry using the Advanced
options on the Inbound Group Entry dialog box.

Sequence Checking Il:ast Uszed Group Control Murnber: ¥ Acknowledge Group
® Nong Ack Transaction Set [D:
C Duplicate 937

O Imeremental
O Chronological

Tranhsaction Control Mumbers

[™ Sequence From Group Format Last Used Control Mumber:

Sequence Checking ® Homal
@ - O &3

nerements O 5
O Chronologica O 543

Group Transl. Obj: I
Acknowledge Tranzl. Obj: IAEKBUILD_SS?

Lee] [ie]

Reference
For more information about setting parameters on the
Inbound Group Entry dialog box, see page 3 - 31.

Interchange acknowledgment criteriais defined when you
set up the Inbound Interchange Entry using the Advanced
options on the Inbound I nterchange Entry dialog box.

Seguence Checking  Last Used Control Mumber: [ Acknowledge Interchange
@ Mone I

T Duplicate Ack Transaction Set D

O Incremetal I .

) Chronalogical

Interchange Transl. Obj. I |£I
Acknowledge Tranzl. Obj. I |£I
Reference

For more information about setting parameters on the
Inbound Interchange Entry dialog box, see page 3 - 31.
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Defining Outbound Acknowledgment Criteria

Introduction

Reconciling documents and their acknowledgments is a function that the
system automatically performs for you. The trand ation objects that are
necessary to process the acknowledgments you receive, are included as
system tranglation objects and are registered when you install Sterling
Gentran:Director.

However, you must establish the level of acknowledgments that you receive
from your trading partners by completing the Outbound Relationship dialog
box.

Note

If you are receiving functional acknowledgments as aresult of sending
documents for an outbound relationship, part of establishing that outbound
relationship is setting up the corresponding inbound relationship to receive
acknowledgments from your partner.

Reference

For information about establishing an inbound relationship to receive
acknowledgments, see Creating a New Inbound Relationship on
page 3 - 31.
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Procedure _
To set up the level of acknowledgments that you expect to receive from your
partners, complete the following steps:

Step

Action

1

Therequirement for receiving interchange acknowledgments
is set in the Advanced section of the Outbound Interchange

Entry dialog box.

I Set Max Mumber of Documerts per Interchange
f & I umben of Decuments pen hterchanae: o
Last Uzed Control Mumber: [™ Expect &cknowledgement
000000000 Hizurs Dyerdie: IU
Interchange Transl. Obj. IISA Build Template - ANS| ﬂ
Acknowledge Transl. Obj. I ﬂ
Reference

For more information on setting parameters on the Outbound
Interchange Entry dialog box, see page 3 - 42.

Recommendation

Do not change the translation objects in the Interchange
Trangl. Obj. or Acknowledge Trandl. Obj. listsunlessyou are
certain of the result.

Continued on next page
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(Cont.)
Step Action
2 The requirement for receiving functional group

acknowledgmentsis set in the Advanced section of the
Outbound Group Entry dialog box.

Lasgt Used Group Control Mumber; ¥ Expect Acknowledgement

I 0 Hours Owerdue: I 48

Transaction Control Humbers

[ Sequence From Group Format
@ Momal
Laszt Used Control Humber: [@-7k]
| O 54
O 53
Giraup Trarsl Obi [ G5 Build Template - ANSI

[i¢] [i¢]

Acknowledge Tranzl Obj: I

Reference

For more information on setting parameters on the Outbound
Group Entry dialog box, see page 3 - 42.

Recommendation

Do not change the trandlation objects in the Group Trandl.
Obj. or Acknowledge Trangl. Obj. listsunlessyou are certain
of the result.

Note

If the acknowledgment is overdue, or it isnot received in the
number of hours designated in the Hours Overdue box, it is
indicated with a status of “Overdue” on the Interchanges
browser.

B For instructions on how to access the Interchanges
browser, see Viewing Documents within Interchanges on
page 6-11.

B For an explanation of status codes, see status on page -
G-8.

Continued on next page
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Defining Outbound Acknowledgment Criteria

(Cont.)
Step

Action

The requirement for receiving transaction set
acknowledgmentsis set in the Advanced section of the
Outbound Relationship dialog box.

Last Uzed Control Mumber: I nooo

[~ Expect Acknowledgement [ Duplicate Documents

Hours Owerdue: I Test Indicator: | C) Test @ Productior

Reference

For more information on setting parameters on the Outbound
Relationship dialog box, see page 3 - 42.
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Manually Acknowledging a Document

Introduction _ ,
The Acknowledge function does NOT generate an acknowledgment; it

merely changes the status of the outbound document. The status of a
document in the Out Drawer may need to be manually set to
“acknowledged” for many reasons. For example, if you have contacted a
partner about an overdue document and that partner verified that it was
received, but they are not sending you an acknowledgment.

Procedure
To manually change the status of adocument to acknowledged, complete the

following steps:

Step Action

1 From The Desk, select Out Drawer.

System Response
The Out Drawer Summary dialog box is displayed.

Continued on next page
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Manually Acknowledging a Document

(Cont.)
Step Action
2 Do the following:
B Select the type of document for the partner.
m Click VIEW.
System Response
The Out Drawer browser is displayed.
i | Wigw... |
ETZDNE2 INVOIC 1000200345 Ackd ) st \E
Delete |
Sort... |
Export... |
Copy |
Ack |
Refresh
2 Dacuments T 1 selected ‘&'
\E Help |
3 Select an Unacknowledged document that needs to be set to
“Ack’d” (acknowledged).
Note
Unacknowledged documents can have one of the following
statuses:
® Overdue
m  Waiting
H  Sent
H  OnNet
B PickedUp
B NetErr
B NetWarn
4 Click Ack.
System Response
The status of the document is set to “Ack’d.”
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Using the Tracking and Audit Systems

Overview

In this chapter

Tracking feature

Audit feature

This chapter describes how to use the Sterling Gentran:Director tracking and
audit systems.

The system writes a Document Tracking record for every significant event
that occurs for a document. For example, a Document Tracking record is
written when the document is created, when it is modified, or when it is
exported.

Note

Thisfunction is not available if document level auditing is disabled. For
more information on enabling document level auditing, see “ System
Administrator Functions” in the IBM® Serling Gentran: Director®
Administration Guide.

The system writes an Audit record for every significant event that occursin
the system. For example, an Audit record is written when a user logs on,
when a Send session isinitiated, or when a document is deleted.

Note

The Audit Log contains entries for the entire Sterling Gentran:Director
system. The events are differentiated by user name and machine name.
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Viewing and Printing Document Tracking Information

Introduction _ , o .
Typicaly, you view document tracking information to help resolve a

problem with a document. These records can be viewed from any of the
document browsers.

Procedure _ _ o _ .
To view or print document tracking information, complete the following

steps:

Step Action

1 From The Desk, select a browser.

System Response

If you select the In Documents, ?In Documents, Out
Documents, 70ut Documents, In Drawer, or Out Drawer
browser, the summary dialog box for that browser is
displayed.

2 Do the following:

B Sdlect the type of document for the appropriate partner.
B Click VIEW to access the browser containing those
documents.

Continued on next page
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(Cont.)
Step

Action

Do the following:

B Seect asingle document.
B From the Commands menu, select View.

System Response
The View Choices dialog box is displayed.

View Choice E

& RawED|
" Formatted Document

" Translator Report

" Track Infarmation

Cancel |

Select the Track Information option and click OK.

System Response
A new tracking window for that document is displayed.

0714653:Doc Track Info _[Ofx

05/27/1997 12:59:22 System Adwiniscrator 2011 Doc wview 0714653 13 PETZCNE 81;‘
05/27/1987 14:02:16 System Administrator 2015 Doc move 0714653 of PETZCNE:51—

1] | M o

Note

The tracking window contains an entry for each tracked
event. If there are more events than can be displayed in the
window, a scroll bar enables you to view the remaining
records.

To print the displayed tracking information, select Print from
the File menu.

May 2011
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Viewing and Printing the Audit Log Information

Viewing and Printing the Audit Log Information

Introduction

The Audit Log allows you to get information to help resolve a system
problem, or to track a user’s activities. These records may be viewed at any

time.

Procedure

To view or print audit log information, complete the following steps:

Step

Action

1

From the View Menu, select Audit Log.

System Response

A new Audit Log window is displayed that contains an entry
for each audited event.

N:Director - [Audit Log]

105 13:29:45 Cindy Commpost flag removed
105 13:29:45 Cindy ConnPost is ending
105 13:29:45 Cindy Unattended Processing - Completed Session COMOO020
105 13:29:45 Cindy CommPost has sent the application notification
105 13:29:45 Cindy Unattended Processing — Completed Command GDW_Comm
105 13:29:45 Cindy Communication completed successfully
105 13:29:45 Cindy CommPost is processing network reports
105 13:29:45 Cindy Splitter — completed processing: 0 interchanges
105 13:29:45 Cindy ComnPost is s=plitting interchanges
105 13:29:45 Cindy Splitter — starting processing: file C:“Program Files-CO
105 13:29:45 Cindy ConnPost is processing comm session #124
105 13:29:45 Cindy ComnPost is starting
105 13:29:45 Cindy Commpost flag created
105 13:29:42 Cindy Unattended Processing — Started Command GDW_Comm
105 13:29:42 Cindy Unattended Processing - Started Session COMO0020
105 13:29:37 Cindy Receive Session Started
105 13:29:24 Cindy View Audit Log (Audit)
105 13:29:20 Cindy Clo=ze browser In Drawer Summary
105 13:29:19 Cindy Close browser In Drawer
105 13:25:50 Cindy View 10000234500:Doc Track Info {Doc Track)
105 13:25:44 Cindy Open browser In Drawer
105 13:25:42 Cindy Open browser In Drawer Summary
105 12:52:21 Cindy Close browser Cut Drawer Sumnary
105 12:52:19 Cindy Open browser Cut Drawer Summary
105 12:52:17 Cindy Cloze browser In Documents Summnary
105 12:52:16 Cindy Close browser In Documents
105 12:52:03 Cindy View :TransReport (ELator Report)
105 12:51:58 Cindy Open browser In Documents
105 12:51:57 Cindy Open browser In Documents Summary
105 12:51:55 Cindy Close browser ?7In Documents Summary
105 12:51:54 Cindy Close browser ?In Documents
105 12:51:49 Cindy View Unknown (EDI Doc)
105 12:51:45 Cindy Open browser ?In Documents
105 12:51:43 Cindy Clo=se browser ?In Documents
105 12:51:38 Cindy Open browser 7In Documents
2 To print the displayed audit information, select Print from

the File menu.
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Overview

Understanding the Accum Tracking Extension

Introduction

How Accum
Tracking works

Some automotive origina equipment manufacturers (OEMS) require their
suppliersto track accumulative year-to-date (Y TD) quantities of the parts
they ship. These parts must be tracked through a combination of destination
(partner location) and part number (trackable item).

Example

If a customer ships a partner number 55663322 to two different locations,
there are two records (one for each location) for this part number.

The accumulative count for each part number isincluded in the ANSI X12
856 Advance Ship Notices (ASN) that the supplier sends to the OEM.

The accum quantity that most OEMstypically require in the ASN isthe sum
of the actual YTD quantity (for the model year, not the calendar year) at the
last shipment, plus the ship quantity.

The Accum Tracking Extension is an add-on feature of Sterling
Gentran:Director which enables you to do the following:

B Defineitemsto be tracked

B Maintain itemsto be tracked

B Maintain the associated counts
B Report on those items

The Accum Tracking Extension lets you define trackable items. Each
trackableitem isthe equivalent of one part (identified by part number) that is
shipped to one location for a partner. This enables you to automatically keep
track of accumulative Y TD quantities of automotive parts, so that you can
send them in the ASNSs.
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Accum Tracking
process Thefollowing table illustrates the accum tracking process. It is based on a
scenario in which you ship part number 123 to the Detroit and Toronto
locations of Generic Auto Company:

Stage Description

1 You receive the system and screen entry trandation objects for
Generic Auto Company from IBM.

2 Register the tranglation objects in Sterling Gentran:Director.

3 Import an outbound partner relationship for Generic Auto
Company into the Sterling Gentran:Director Partner Editor.

4 In the Generic Auto Company partner relationship (in Partner
Editor), create one location table for the Detroit location and
one location table for the Toronto location.

5 In the Accum Tracking Extension, create atrackable item 123
for the Detroit location and another trackable item 123 for the
Toronto location.

6 The system stores each trackable item as arecord in the
Sterling Gentran: Director database lookup table (identified as
aaccum tracking item by the tag “ $$$A ccum$$s”).

Note

This processis handled by the system and is hidden from you.
You do not create the lookup table.

7 Use the screen entry translation object to enter the ASN in
Sterling Gentran:Director. As part of the ASN, type the ship
guantity of each part or trackable item.

8 Send the ASN to your partner.
Continued on next page
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Manual
intervention

Software
components

Stage Description

9 While the system is preparing to send the ASN, it looks up the
accum quantity of each item and adds that quantity to the ship
guantity you entered on the ASN. The system inserts the sum
of these two quantities in the accum quantity field on the ASN.
Example

For item 123 bound for Detrait:

Accum guantity + Ship quantity = total accum quantity

10 After the ASN is sent, the system automatically adds the ship
guantity to the accum quantity stored in the database lookup
table, and updates the accumulative count.

As shown in the previous table, the system handles most of the accum
tracking process automatically. There are very few exceptions when you will
need to manually intervene. Some exceptions are the following:

B |f you experience communication problems, you may need to manually
correct the affected accums.
B For each new model year, you need to reset each accum to zero.

Note

Some automotive OEM s have specific accum tracking requirements. The
translation objects that you receive from IBM are designed to accommodate
these requirements.

The Accum Tracking Extension is a separate install set on the Sterling
Gentran:Director CD. The Accum Tracking Extension consists of the
following components:

Component Description

ACCUM.EXE Accum Tracking Extension executable.

ACCUM.HLP Help file for the Accum Tracking Extension.

READMEA.TXT | Read Mefilefor the Accum Tracking Extension.
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Implementing the Accum Tracking Extension

Process

The following table provides a high-level overview of the sequence of tasks
you complete to implement the Accum Tracking Extension with Sterling
Gentran:Director.

Stage

Description

1

Install Serling Gentran:Director, including the Accum
Tracking Extension

Reference

For more information, see the IBM® Serling
Gentran: Director® Getting Sarted Guide.

Register tranglation objects

In Sterling Gentran:Director, register the system and screen
entry translation objects from the disk you receive from IBM
(*.TPL files).

Reference

For more information, see Registering (Installing) a New
Tranglation Object on page 2-3.

Import partners
In Partner Editor, import the partner profiles from the disk
you receive from IBM (*.PAR files).

Reference

For more information, see Importing a Partner Profile on
page 3-61.

Createlocation tables
In the Partner Editor, create location tables for the associated
locations for each partner.

Reference

For more information, see Creating Partner Locations on
page 3-88.

Continued on next page
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Stage Description
5 Configure Accum Tracking Extension
Configure the Accum Tracking Extension to your
specifications.
Reference

For more information, see Using the Configuration Dialog
box on page 9-11.

6 Set up the tracking environment
Set up the items that you want to track.

Reference

For more information, see Adding a Trackable Item on
page 9-21.

7 Process your data through Sterling Gentran:Director

Reference

For more information, see the chapter entitled Using
Documents on page 4-1.
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Using the Accum Tracking Extension

Accum Tracking Extension Components

Introduction

Diagram

The Accum Tracking Extension isa graphical user interface that uses a
branching series of dialog boxes, and enables you to add and maintain
trackable items.

The following diagram illustrates the branching sequence of the Accum
Tracking Extension dialog boxes:

Accum Tracking Extension -
Partner List

Accum Tracking
—— Extension -
Location List

Accum Tracking

Extension -

Item List
Accum Tracking Accum Tracking
Extension - Extension -
Configuration Item Maintenance
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Using the Partner List Dialog box

Introduction _ . . . -
The Accum Tracking Extension - Partner List dialog box isthe main dialog

box of the Accum Tracking Extension. This dialog box contains alist of al
partner relationships currently defined in Sterling Gentran: Director.

Note
To define anew trading partner, you must use the Sterling Gentran:Director
Partner Editor.

Accessing the
dialog box From the Sterling Gentran:Director Tools menu, select Accum Tracking.
The Partner List dialog box is displayed.

GENTRAN Accum Tracking Extension

~Trading Partners

<Internal System User>»

PETZONE Locations

Clear Counts
Delete Items
Configuration
Load Counts

Report
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Parts and

functions Thefollowing table lists the parts of the Partner List dialog box and their

functions:

Part

Function

Trading Partners

Listsall the partner relationships currently
defined in Sterling Gentran:Director. You
may select one or more partners.

ExIT

Closes the Accum Tracking Extension.

LOCATIONS

Accessesthe Locations List dialog box for a
selected partner.

Exception

Only valid if one partner is selected.
Reference

For more information on the Location List
dialog box, see Using the Location List
Dialog box on page 9 - 14.

SELECT ALL

Selects all partner relationshipsin the
Trading Partnerslist.

CLEAR COUNTS

Sets the counts for all items associated with
the selected partnersto zero.

Confirmation
The system prompts you for confirmation.

DELETE ITEMS

Deletes all trackable items associated with
the selected partners.

Confirmation
The system prompts you for confirmation.

CONFIGURATION

Accesses the Configuration dialog box.

Reference

For more information, see Using the
Configuration Dialog box on page 9-11.

Continued on next page
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Part

Function

LoAD COUNTS

Not currently used.

REPORT Prints areport for all trackableitemsin all
defined locations for the selected partners.
HELP Displays help for the Partner List dialog

box.

May 2011
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Using the Configuration Dialog box

Introduction _ . o
The Accum Tracking Extension - Configuration dialog box enables you to

set global configuration options for the Accum Tracking Extension. These
options are stored in the registry.

Accessing the

dialog box o :
To access the Configuration dialog box, click CONFIGURATION.

GEMTRAMN Accum Tracking Extension Configuration E

Item Maintenance Options

[¥ Usze Secondary Description
[X Use Secondary Count

[X Zero Counts on Add

X Hide Accum Entries From Partner Editor
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Parts and

functions Thefollowing table lists the parts of the Configuration dialog box and their

functions:

Part

Function

Use Secondary
Description

Specifies whether the secondary description
isused for trackable items, in addition to a
primary description.

Note

This option is selected by default. Clearing
this check box makes the Secondary
Description box on the Item Maintenance
dialog box unavailable.

Reference
For more information, see Using the Item
Maintenance Dialog box on page 9-18.

Use Secondary Count

Specifies whether the secondary count is
used for trackable items, in addition to a
primary count.

Note

This option is selected by default. Clearing
this check box makesthe Count 2 box on the
Item Maintenance dialog box unavailable.

Reference
For more information, see Using the Item
Maintenance Dialog box on page 9-18.

Zero Countson Add

Specifies whether the counts of a new
trackable item are automatically set to zero.
The new trackable item counts are shown in
the Count 1 and Count 2 boxes on the Item
Maintenance dialog box.

Note
This option is selected by default.

Reference
For more information, see Using the Item
Maintenance Dialog box on page 9-18.

Continued on next page
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Part

Function

Hide Accum Entries
From Partner Editor

Specifies whether the accum tracking
lookup table is hidden in the Partner Editor.

Note
This option is selected by default.

OK

B Appliesthe configuration settings by
making the appropriate changes to the
registry.

B Closesthe Configuration dialog box.

CANCEL

B Discards any changes.
B Closesthe Configuration dialog box.

HELP

Displays help for the Configuration dialog
box.

IBM Sterling Gentran:Director User Guide
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Using the Location List Dialog box

Introduction

Accessing the

dialog box

The Accum Tracking Extension - Location List dialog box displaysalist of
all locations currently defined in Sterling Gentran:Director for the selected
partner on the Partner List dialog box.

Note

The Accum Tracking Extension does not allow you to define trackable items
for locations which have a“ PrimaryRefCode” greater than eight characters.

Reference

To define anew trading partner, you must use the Sterling Gentran:Director
Partner Editor.

To accessthe Location List dialog box, select a partner relationship from the
Partner List dialog box and click LOCATIONS.

GENTRAN Accum Tracking Extension - PETZ0NE E2

-Partner Locations

PETZONET |
PETZONEZ Items to Track

Clear Counts
Delete Items

Beport

i}

Help
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Using the Location List Dialog box

Parts and

functions Thefollowing table lists the parts of the Location List dialog box and their

functions:

Part

Function

Partner Locations

Contains al the locations currently defined
for the selected partner.

OK

Closes the Location List dialog box.

ITEMS TO TRACK

Accesses the Items List dialog box for the
selected location.

Exception
Only valid if onelocation is selected.
Reference

For more information, see Using the Items
List Dialog box on page 9-16.

SELECT ALL

Selects all locationsin the Partner Locations
list.

CLEAR COUNTS

Sets the counts for all items associated with
the selected locations to zero.

Confirmation

The system prompts you to confirm the
selection.

DELETE ITEMS

Deletes all trackable items associated with
the selected locations.

Confirmation

The system prompts you to confirm the
selection.

REPORT

Prints areport for all trackable itemsin all
selected locations.

HELP

Displays help for the Location List dialog
box.

IBM Sterling Gentran:Director User Guide

May 2011 9-15



Using the Items List Dialog box Using the Accum Tracking Extension

Using the Items List Dialog box

Introduction . . . :
The Items List dialog box displaysalist of al trackable items currently

defined for a selected location.

Accessing the

dialog box Toaccessthe Items List dialog box, select alocation from the Location List
dialog and click ITEMS TO TRACK.

[GENTRAN Accum Tracking Extension - PETZONET |
-ltems To Track s
oK
Parts and
functions Thefollowing table lists the parts of the Items List dialog box and their
functions:
Part Function
Itemsto Track Contains all the trackable items for the
selected location.
OK Closesthe Items List dialog box.
Continued on next page

9-16 May 2011 IBM Sterling Gentran:Director User Guide



Using the Accum Tracking Extension

Using the Items List Dialog box

Function

Displays ablank Item Maintenance dialog
box, which allows you to define a new
trackable item for this location.

Reference

For more information, see Using the Item
Maintenance Dialog box on page 9-18.

Displays the Item Maintenance dialog box
for the selected trackabl e item, which allows
you to edit the selected trackable item.

Reference

For more information, see Using the Item
Maintenance Dialog box on page 9-18.

Part
ADD
EDIT
SELECT ALL

Selects dll trackable itemsin the ltems to
Track list.

CLEAR COUNTS

Sets the counts for the selected trackable
items to zero.

Confirmation

The system prompts you to confirm the
selection.

DELETE ITEMS

Deletes the selected trackable items.

Confirmation

The system prompts you to confirm the
selection.

REPORT

Prints areport for the selected trackable
items.

HELP

Displays help for the Item List dialog box.

IBM Sterling Gentran:Director User Guide
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Using the Item Maintenance Dialog box

Introduction . . . ,
The Accum Tracking Extension - Item Maintenance dialog box enables you

to add or edit atrackable item.

Accessing the
dialog box Do youwant to add or edit atrackable item?

IF you want to... THEN (on the Item List dialog box)...
add an item click ADD.
edit anitem select atrackable item from the ltems to
Track list, and click EDIT.

System Response
The Item Maintenance dialog box is displayed.

GEMTRAMN Accum Tracking Extension E

-Item M aintenance
Partner: |PETZONE

Location: |PETZONET | Update/New I

Item 1D: |PETD413
Update/Hext

Description: [Nylon cat collar

|Red Cancel
Count 1: I[1] | Delete I
Count 2: I[1]
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Parts and

functions Thefollowing table lists the parts of the Item Maintenance dialog box and

their functions.

Part

Function

Partner

Displays the partner name of the selected
partner.

Location

Displays the location name of the selected
location.

Item ID

Containsthe item identifier of theitem you
want to track.

Note
This box is mandatory.

Description

Consists of primary and secondary
description boxes for the item, or a product
description for the trackable item.

Note

The secondary description box is not
available if the “Use Secondary
Description” check box is cleared on the
Configuration dialog box.

Reference

For more information, see Using the
Configuration Dialog box on page 9-11.

Count 1
Count 2

Displays the current accum counts for the
selected or new trackable item.

Note

For anew trackable item, these boxes are set
to zero if “Zero Counts on Add” is selected
on the Configuration dialog box.

Reference

For more information, see Using the
Configuration Dialog box on page 9-11.

Continued on next page
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Part

Function

UPDATE/EXIT

B Updates or adds the current trackable
item.

B Closesthe Item Maintenance dialog
box.

UPDATE/NEW

B Updates or adds the current trackable
item.

B Displays ablank Item Maintenance
dialog box to enable you to add a new
trackable item.

UPDATE/NEXT

B Updates or adds the current trackable
item.

B Displaysthe next trackable item on the
Item List dialog box.

CANCEL

B Discards any changes or additions.
B Closesthe Item Maintenance dialog
box.

DELETE

B Deletesthe current trackable item.
B Closesthe Item Maintenance dialog
box.

HELP

Displays help for the Item Maintenance
dialog box.
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Adding a Trackable Item

Introduction . _ . .
Before you add a trackable item with the Accum Tracking Extension, you

must first verify that the following are set up in the Sterling Gentran: Director

Partner Editor:

B The partner relationship for which you need to track the item.

B A location table for the specific partner relationship location for which
you need to track the item.

Reference

B For more information on creating partner relationships, see Creating a
New Partner Definition on page 3-28.

B For moreinformation on creating location tables, see Creating Partner
Locations on page 3-88.

Procedure _ _
To add a trackable item, complete the following steps:
Step Action
1 In the Sterling Gentran:Director program group, double-click

the Accum icon.

System Response
The Partner List dialog box is displayed.

GENTRAN Accum Tracking Extenzion
~Trading Part

| < Internal Sislem User>

LClear Counts
Delete Items
Configuration
Load Counts

Report

Continued on next page
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Using the Accum Tracking Extension

Step

Action

From the Trading Partnerslist, select the partner relationship for
which you want to set up atrackable item.

Click LOCATIONS.

System Response
The Location List dialog box is displayed.

GENTRAMN Accum Tracking Extension- PETZONE

-Partner Locations

PETZONE1 W

PETZONEZ Items to Track

Clear Counts
Delete ltems

Report

iudidil

Help

From the Partner Locations list, select the partner location where
the tracked item is sent.

Click ITEMS TO TRACK.

System Response
The Items List dialog box is displayed.

Atems To Track————————————————
C =

Continued on next page
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Adding a Trackable Item

Step

Action

Click ADpD.

System Response
The Item Maintenance dialog box is displayed.

GEMNTHAN Accum Tracking Extension
~Item Maint
Partner: JPETZONE
Location: |PETZONET Epdale!New I
Item ID: [

Update/Mext
Description:
—

Count 1: I_l]

Delete I

Count 2: Jo

In the Item ID box, type the part number of the item you want to
track.

Do the following:

B |nthefirst Description box, type the primary product
description for the item.

B |nthe second Description box, type the secondary product
description for the item.

Note

The second Description box is not be available if the “Use
Secondary Description” check box is cleared on the
Configuration dialog box. For more information, see Using the
Configuration Dialog box on page 9-11.

Do you need to add another trackable item for this location?

B |f yes, click UPDATE/NEW, and repeat steps 7 - 9.
B |f no, click UPDATE/EXIT and continue with step 10.

10

Click OK.

System Response
The Item List dialog box is closed.

Continued on next page
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Using the Accum Tracking Extension

Step Action
11 Click OK.
System Response
The Location List dialog box is closed.
12 Click ExIT.

System Response
The Accum Tracking Extension is closed.
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Introduction

Daily Processing

Overview

Introduction

In this chapter

10-2 May 2011

This chapter provides an example of operational activities that may be
executed as part of your daily processing.

Note
This example may not be valid for your company.
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Understanding the Outbound Process Flow

Outbound Processing

Understanding the Outbound Process Flow

Process flow

An example outbound process flow islisted in the following table:

Stage

Description

1

Do one of the following:

B Import afile from the Workspace.
B Create adocument using the Document Editor.

Reference

B For instructions on how to import afile, see Importing a
Document on page 4-40.

B For instructions on creating a new document, see
Creating a Document on page 4-3.

Post the compliant documents to Out Documents.

Reference
For instructions on posting, see Posting a Document on
page 4-35.

Send selected, or all documents, to your trading partner.

Reference

B For instructions on how to send selected documents, see
Sending a Document on page 5-3.

B For instructions on how to send all documents, see
Sending All Documents on page 5-6.

If you expect to receive acknowledgments for the sent
documents, open the Interchanges and OutDrawer browsers
from The Desk.

Review the documents you sent to make sure you received
acknowledgments for al of them.
Note

Process control can automate some tasks. For more
information, See “Controlling Your Processes’ in the IBM®
Serling Gentran: Director® Administration Guide.
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Inbound Processing

Completing Inbound Processing with Valid Documents

Introduction o _ . .
You can initiate inbound processing after sending documents using the

outbound processing flow shown on the previous page, or by initiating a
receive-only session.

Reference

For instructions on receiving documents, see Receiving a Document on
page 5-13.

Process flow , . o
An example inbound process flow for valid documentsis listed in the

following table:

Stage Description

1 Do the following:

B From The Desk, select In Documents.
B Review the valid documents you received. These
documents are shown with an “OK” status.

2 Print using the associated print translation object, or
export the valid documents.

Note
Process control can automate some tasks.

Reference

B For instructions on printing documents, see Printing a
Document on page 4-31.

B For more information on exporting documents, see
Exporting a Document on page 4-43.

B For more information, see “Controlling Your Processes’
in the IBM® Serling Gentran: Director® Administration
Guide.
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Completing Inbound Processing with Invalid Documents

Completing Inbound Processing with Invalid Documents

Introduction

You can initiate inbound processing after sending documents using the
outbound processing flow shown on page 10 - 3, or by initiating a
receive-only session.

Reference

For instructions on receiving documents, see Receiving a Document on

page 5-13.

Process flow

An example inbound process flow for invalid documentsislisted in the

following table:
Stage Description
1 From The Desk, select 2ln Documents.

Note

If the system cannot find an existing partner relationship for a
document, the datawill go to 2In Documents. The following
are reasons this might occur:

B Thereisno partner.

B Thereisapartner but no relationship is set up for this
document.

B Thereisno template associated with the partner
relationship.

Continued on next page
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10-6

(Cont.)
Stage

Description

Are the documentsinvalid due to an incorrect or missing

partner, or amissing inbound relationship or trandation

object?

W [ yes, you can set up apartner relationship (if necessary)
and then attach the document to a partner relationship.

W [f no, continue with stage 3.

Reference

B For instructions on creating a partner profile, see
Creating a New Partner Definition on page 3-28.

B For instructions on creating an inbound relationship or
selecting transl ation objects, see Creating a New Inbound
Relationship on page 3-31.

B For instructions on attaching an interchange to a partner
relationship, see Attaching Interchangesto a Partner on
page 6-13.

Once the documents are valid, you can do the following:

B Print using the associated print translation object.
B Export them.

Note
Process control can automate some tasks.

Reference

B For instructions on printing documents, see Printing a
Document on page 4-31.

B For more information on exporting documents, see
Exporting a Document on page 4-43.

B For more information, see “Controlling Your Processes’
in the IBM® Serling Gentran: Director® Administration
Guide.
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Overview

Overview

Introduction

The Transaction Data File (TDF) serves as a bridge between your
application data and the Sterling Gentran:Director translator. For outbound
processing, dataisimported from a TDF (or application) file and translated
to EDI format using a TDF Import translation object. The dataiis then ready
to be posted and sent to your trading partner.

For inbound processing, EDI documents that are received by Sterling
Gentran:Director can be exported to a TDF-formatted file using a TDF
Export trandation object. This datafileis then ready to be processed or
converted to your internal application files.
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Importing Data from TDF (or Application) Files

Introduction . . . o
TDFs provide a simple method to integrate your application with the

tranglation capabilities of Sterling Gentran:Director. Importing data from
TDF, or application datafiles, is an alternative to using the Document Editor
to enter data directly into the system without having to define your datafile
import maps.

TDFisaflat file representation of the EDI standard document. Each EDI
segment that is sent will be generated from aflat file record that corresponds
to that segment. In order to use the TDF interface, you must reformat your
application datainto the standard TDF layout using an application program.
In addition, you must have a TDF import translation object for the
transaction set that will be imported, registered with the system.

Getting Started _ _ _ _ _ :
The information presented in the following sections relate to setting up your

system to correctly import datafrom TDF files. If you have already set up
thisinformation in the system, proceed directly with the TDF
(or Application) File Format procedure in this chapter.

The TDF layout and the TDF import translation object can be downloaded
using the IBM® Sterling Library facilities. Remember that once you
download the translation object, it must be registered with Sterling
Gentran:Director.

In addition, you must establish correct outbound relationships for all trading
partners who will receive this data. During the process of establishing an
outbound relationship, you should specify the name of the TDF translation
object as the Import translation object for the outbound relationship.

The TDF file must contain a header record for every document in the input
file. This header record is used by the system to determine what type of
document is being translated and also identifies the trading partner. This
header can be in one of two formats: Basic TDF Header Format or Extended
TDF Header Format.

Reference

For more information, see Registering (Installing) a New Translation Object
on page 2 - 3. For procedural information, see Creating a New Outbound
Relationship on page 3 - 43.
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Using the Basic TDF Header Format

Introduction

The limitation imposed on you if you choose to use the Basic TDF Header
format is that you can only establish one outbound relationship per trading
partner for each transaction set to be imported.

Note

Thisisthe default format that isloaded for the product.

Field
Requirements Thisformat requires that the following fields are loaded correctly into the
header record:
Field Description

Transaction Set ID
Columns1through 6 (6 characters,
left justified, space-filled)

Thisfield should contain the Transaction Set ID of
the document to be imported. The Transaction Set
ID isdefined in the TDF trandlation object and the
information can be obtained by viewing the
tranglation object.

Reference

For additional information, see Using Tranglation
Objectsonpage 2 - 1.

Record Tag
Columns 7 through 17 (11
characters, zero-filled)

Thisfield identifies the record as a TDF header
record and should be filled with eleven zeroes

*0").

Partner ID

Columns 57 through 71 (15
characters, left justified,
space-filled)

Thisfield is used to identify the trading partner.
The value used in thisfield should correspond
exactly with the value coded as the partner's
Application Code in the Partner Editor (on the
Partner Definition - New dialog box).

A-4 May 2011
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Using the Extended TDF Header Format

Introduction

Field
Requirements

The Extended format of the TDF Header record is not completely
compatible with the Basic version, but it can easily be formatted with minor
modifications from existing programs that create TDF files. Thisformat
allows you greater flexibility when establishing your outbound rel ationships
because you have the ability to set up multiple outbound relationships for the
same transaction set and the same trading partner. If you test a new version
of adocument with an existing trading partner, this header format can make
that process much easier.

Note

If you are developing anew TDF interface program, we strongly suggest that
you use the Extended TDF Header format.

This format requires that the following fields are loaded correctly into the
header record:

Field Description
Transaction Set ID Thisfield should contain the Transaction Set ID of
Columns1through 6 (6 characters, | the document to be imported. The Transaction Set
left justified, space-filled) ID isdefined in the TDF trand ation object and the

information can be obtained by viewing the
tranglation object.

Reference

For additional information, see Using Tranglation
Objectsonpage 2 - 1.

Record Tag Thisfield identifies the record as a TDF header
Columns 7 through 17 (11 record and should be filled with eleven zeroes
characters, zero-filled) (*0").

Continued on next page
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Field

Description

Partner 1D

Columns 57 through 71 (15
characters, left justified, space-
filled)

Thisfield is used to identify the trading partner.
The value used in thisfield should correspond
exactly with the value coded as the partner's
Application Codein the Partner Editor (on the
Partner Definition - New dialog box).

Version ID

Columns 114 through 125 (12
characters, left justified, space-
filled)

Thisfield is used to identify the EDI standard
version of the document to be trandlated. Thisis
defined in the TDF trandation object. The
information can be obtained by viewing the
tranglation object.

Reference

For additional information, see Using Trandlation
Objectson page 2 - 1.

Sandard
Column 143 (1 character)

Thisfield is used to identify the EDI standard of
the document to be translated. Thisisdefined in
the TDF translation object. The information can be
obtained by viewing the translation object.

Reference

For additional information, see Using Translation
Objectsonpage 2 - 1.

Continued on next page
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Field

Description

Test/Production Code
Column 189 (1 character)

Thisfield isused to identify whether to select atest
or production trading partner relationship for
tranglation (selected by clicking the ADVANCED>>
button on the Outbound Relationship dialog box).

STOP

We suggest that you always use production
outbound relationships unless you are otherwise
instructed by customer support.

If you determine that you want to use the Extended
TDF Header Format, all you have to do is register
the extended System Import TDF trandation
object. Thisfileislocated in the translation objects
directory as TDFHDRX.TPL.

Reference

For information on registering translation objects,
see Using Tranglation Objects on page 2 - 1.

STOP

Once the extended System Import TDF trandation
object (TDFHDRX.TPL) isregistered, files
containing the Basic TDF headers will not be
processed correctly.

If the extended System Import TDF trandation
object was registered by mistake or you want to go
back to using the Basic TDF header format,
register the Basic System Import TDF translation
object. Thisfileislocated in the translation objects
directory as TDFHDR.TPL.

Reference

For information on registering translation objects,
see Using Translation Objects on page 2 - 1.
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Using Sterling Gentran:Director TDF Integration

Overview

Procedure

Sterling Gentran:Director TDF Integration enables you to create an import or
export translation object so that you can use TDF files with Sterling
Gentran:Director. In addition, you can use TDF Integration to create a
detailed report on the TDF layout of any EDI standard.

Use the following procedure to launch the Sterling Gentran:Director TDF
Generator. For additional information, see your Sterling Gentran:Director
TDF Integration Installation card.

Step Action

1 From the Sterling Gentran:Director Programs sub-menu,
select Gentran Director TDF Generator.
System Response
The Sterling Gentran:Director - TDF Integration dialog box
isdisplayed.

2 Click NEXT>.
System Response
You are prompted to determine whether you want to create a
TDF translation object or a TDF Record Layout Report.

3 Select the appropriate radio button, and click NEXT>.
System Response
The TDF Integration generator guides you through the
creation process.
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Selecting an Import File and Translation Object

Introduction — . : : ,
When the system is shipped, it is assumed that all of your imported files will

be placed in the IMPORTS sub-directory and that all of the import formats
will be TDF. If thisistrue for your company, continue with the TDF (or
Application) File Import procedure later in this chapter.

Before you import afile, you must designate its file name and path, and
associate that filename and path with a registered System Import translation
object. To do this, you use the Imports tab of the Sterling Gentran:Director
System Configuration dialog box.

Procedure _ _ _ _ ) :
To associate an import file name and path with the registered translation

object that you want to use during the import process, complete the

following steps:
Step Action
1 From the Sterling Gentran:Director program group, select

Sterling Gentran:Director Configuration.

System Response
The System Configuration dialog box is displayed.

2 Select the Imports tab.

System Response
The Imports tab is displayed.

3 In the File Path text box, enter the
drive:\directory\subdirectory\file name of the file that you
want to import, or click BROWSE to search for thefile.

Note

The default TDF setting is*.TDF and the default tranglation
object is System Import TDF. If you enter afilename,
wildcards may be used. Paths must use mapped drive
letters; UNC paths are not valid.

Continued on next page
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(Cont.)

Step Action
4 Do the following:
B Sdect atrand ation object from the Translation Objects
drop-down list.
m Click OK.

System Response
Thefile is associated with the trand ation object that will be
used during the import process.

A-10 May 2011 IBM Sterling Gentran:Director User Guide



Importing a TDF (or Application) File

Importing a TDF (or Application) File

Procedure , o :
To import a TDF (or application) file, complete the following steps.

Step Action

1 From The Desk, select WorkSpace.

System Response
The WorkSpace dialog box is displayed.

2 Click IMPORT.

System Response

B TheApplication Filesto Import dialog box is displayed.

B The system imports the documents into the Work Space.
The document(s) either have an “OK” status indicating
that the document(s) were successfully read and
compliance checked or, “Not OK” indicating the
document(s) failed compliance checking. You may not
send non-compliant documents. Either delete those
documents and re-process them from the TDF (or
application data file), or correct the documentsin the
Document Editor if you have Data Entry trandation
objects for them.

Reference

For more information on correcting the documentsin the
Document Editor, see Using Documents on page 4 - 1.

3 Select thefile or filesto be imported and click OK.
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Exporting Data to TDF (or Application) Files

Introduction

To export datato a TDF (or application) file, an Export trandlation object for
the transaction set must be loaded into the system, registered, and set up as
the Export translation object.

Reference

For information on tranglation object registration, see Using Translation
Objectson page 2 - 1.

Procedure

To export information to a TDF (or application) file, complete the following

steps:

Step

Action

From The Desk, select the In Documents, 2ln Documents,
or InDrawer.

System Response
A dialog box is displayed.

Continued on next page
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(Cont.)
Step

Action

Do the following:

B Sdlect the document or documents that are to be
exported. To highlight a group of documents, click the
first document, press SHIFT, and click the last
document. To highlight several documents that are not
adjacent to each other, press and hold CTRL while
clicking each document.

B Click EXPORT.

System Response
The Select Export Method dialog box is displayed.
Valid options are:

W Export to Single File - all the documents selected will
be converted to TDF (if TDF files) or converted to data
(if application datafiles), and written to asinglefile.

B Export to Default Files - the documents will be written
to the files designated in the partner inbound
relationship.

B Sdect File by Document - the system prompts you for
the new file names.
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N O T C E S

Notices

This information was devel oped for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the products
and services currently available in your area. Any reference to an IBM product,
program, or serviceis not intended to state or imply that only that IBM product,
program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead.
However, it isthe user's responsibility to evaluate and verify the operation of any non-
IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.SA.

For license inquiries regarding double-byte character set (DBCS) information, contact
the IBM Intellectual

Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

IBM Sterling Gentran:Director User Guide May 2011 N-1
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Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions areinconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "ASIS' WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
youl.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for thisIBM
product and use of those Web sitesis at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation

JBA/GA

555 Bailey Avenue

San Jose, CA__95141-1003
U.SA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of afee.
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Notices

The licensed program described in this document and al licensed material available
for it are provided by IBM under terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary
significantly. Some measurements may have been made on devel opment-level
systems and there is no guarantee that these measurements will be the same on
generdly available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-1BM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-1IBM products should be addressed to the suppliers of those
products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

Thisinformation is for planning purposes only. The information herein is subject to
change before the products described become available. Thisinformation contains
examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examples include the names of individuals, companies,
brands, and products. All of these names are ficticious and any similarity to the names
and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programsin source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to IBM,
for the purposes of developing, using, marketing or distributing application programs
conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. The sample programs are provided "AS
IS', without warranty of any kind. IBM shall not be liable for any damages arising out
of your use of the sample programs.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2011.

If you are viewing this information softcopy, the photographs and color illustrations
may not appear.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies. A
current list of IBM trademarks is available on the Web at “ Copyright and trademark
information” at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or
other countries.

IT Infrastructure Library is aregistered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States and
other countries.

Linux isaregistered trademark of Linus Torvaldsin the United States, other countries,
or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL isaregistered trademark, and a registered community trademark of the Office of
Government Commerce, and is registered in the U.S. Patent and Trademark Office.

UNIX isaregistered trademark of The Open Group in the United States and other
countries.

Javaand all Java-based trademarks and logos are trademarks or registered trademarks
of Oracle and/or its affiliates.

Cell Broadband Engineis atrademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are trademarks
of HR, IBM Corp. and Quantum in the U.S. and other countries.
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Notices

Connect Control Center®, Connect:Direct®, Connect:Enterprise, Gentran®,
Gentran:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran: Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks of
others.
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?In Documents

?0ut Documents

acknowledgment

ack

AIAG

ANA

ANSI

application system

audit log

browser

click

Glossary

A browser containing alist of documents received by the system but that
failed compliance checking, or that do not have an identifiable partner or
transaction set.

A browser containing alist of documents that were imported into the system
but areinvalid.

The term used to indicate the ANSI 997 functional acknowledgment, the
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL.

A function that enables you to manually change the status of documentsin
the Out Drawer to “Ack’d” (acknowledged).

Automotive Industry Action Group.The standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

Article Numbering Association.

American National Standards Institute. ANSI sets standards for many
products and services, such as safety glasses and battery capacities. The
ANSI X12 committeeisthe chief EDI standards-setting organization for the
United States.

Computer systems, outside of EDI, designed to fulfill specific business
functions. Some of these include accounting, purchasing, materials control,
human resources, and shipping.

A function that enables you to view system audit log information.

A window that displaysalist of items, such as documents (transaction sets),
interchanges, or trang ation objects. A document browser displays only
documents.

Term indicating that you should position your cursor on top of the
designated item and press and release your primary mouse button. The
primary mouse button is the button you access with your index finger,
regardless of whether you are utilizing right-handed or | eft-handed mouse
operation.
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communications
session

Communicator

compliant

component data
element

composite data
element

copy

data-view windows

default

Desk, The

Everything sent and received to/from one telephone number in one
continuous period of connection. This could include sending two or three
interchange envel opes to a network, each for adifferent trading partner.

The Sterling Gentran: Director communications software. The
Communicator enables you to send, receive, resend, establish
communication port definitions, establish communication profiles, establish
communication scripts, and view and delete communication sessions.

Term indicating that the document conforms to the EDI standards as defined
by the trandlation object.

A simple data element that belongs to a composite data element. Component
data elements are also called sub-elements.

A data element that is made up of multiple component elements.

A function that enables you to copy one or more documents from the Out
Drawer to the Workspace.

The following are data-view windows in the Sterling Gentran:Director:
Audit Log, Document Tracking, Interchange Tracking, raw data-view of an
interchange, raw data-view of a document.

A predefined value — programs use these built-in values unless you
specifically override them.

A graphic representation of the Sterling Gentran:Director that provides you
with aquick and easy way to access some of its most commonly used
browsers, functions, and subsystems. You can click the appropriate part of
The Desk any time you need to access a browser, function, or subsystem
represented there. The browsers you can access are In Documents, 2In
Documents, Workspace, Out Documents, 20ut Documents, | nterchanges, In
Drawer, and Out Drawer. Each browser icon displays a graphic
representation of paper if the document location contains documents. The
Desk also allows you to access the Partner Editor subsystem, the Help
system, the Process Control function (clock icon), and the Send/Receive
functions (phone icon). It also allows you to quit Sterling Gentran:Director
(EX1T/door icon).

You can turn the display of The Desk off by clicking The Desk on the View

menu. This toggles the display of The Desk “on” and “off.” A checkmark
next to that item meansitis“on.”
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dialogbox A dialog box (or dialog) containing additional information or options that
you need to act on. If you specify any options, you can select a button to
execute the command. Some dialog boxes display warnings or messages
indicating why a requested task cannot be accomplished. If the dialog box
has atitle bar, you can move it to another location on your desktop.

To close adialog box, double-click the Control menu box or select Close
Active Window from the File menu.

document One transaction set containing actual data and treated as a single entity. The
amount of data does not affect whether something is adocument or not, only
thefact that it istreated as asingle entity. For example, regardless of whether
apurchase order contains one item or ten thousand, if it is one purchase
order, it is one document.

If atrading partner sends you a communication containing 10 purchase
orders, you have received 10 documents. If the communication contained 15
invoices, you have received 15 documents.

double-click Thisindicates that you should position your cursor on top of the designated
item and quickly press and release your primary mouse button twice. The
primary mouse button is the button you access with your index finger,
regardless of whether you are utilizing right-handed or |eft-handed mouse
operation.

EANA International Article Numbering Association, Brussels, Belgium.
EDI Electronic Datalnterchange. The process by which companies can exchange
business documents directly from application to application by computer,

without paper documents being produced.

EDI standard Therules, or standard, for turning a business document into an EDI
document.

EDIA The Electronic Data I nterchange Association, formerly known as the
Transportation Data Coordinating Committee (TDCC).

EDIFACT Electronic Datalnterchange for Administration, Commerce, and Transport.
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element Thesmallest piece of usableinformation defined by the standards. Examples
might include a quantity, unit price, or description.

Anindividual element can have somewhat different meanings depending on
context. Therefore, elements are normally not considered to have useful
meaning until they are combined into segments.

The three types of data elements areillustrated in the following table:

Data Element Definition

Simpledataelement | A single piece of information defined by the

standards.
Composite data A data element that is made up of multiple
element component elements.
Component data A simple data element that belongsto a
element composite data el ement. Component data

elements are also called sub-elements.

envelope A way of separating information in transmissions for ease of processing.
Each envelope contains a header segment and atrailer segment, which
separate the envel ope from other envel opes and provide information about
the contents of the envelope.

The three levels of envelopes are illustrated in the following table:

Envelope Definition

Transaction Set Each transaction set, or business document, is
contained within atransaction set envelope.

Functional Group An envelope containing related business
documents. The standards define which
transaction sets should be placed together into a
functional group envelope.

Continued on next page
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export

find

functional group

import

In Documents

In Drawer

interchange

Envelope Definition
Interchange All material being sent to one trading partner in
Envelope one communication. Interchange Envelopeisthe

term used by ANSI. EDIA uses theterm
Transmission Envelopeto refer to thislevel of
envelope. Since we use the term transmission for
other uses, we refer to Interchange Envelope
only.

Note

A communications session could easily include a
number of interchange envelopes. For this
reason, the standards-setting bodies are
considering afourth level of envelopeto cover an
entire communications session.

A function that enables you to write adocument or documents to an external
file for processing by another application. There must be a system export
tranglation object for the document or a partner-specific export translation
object for the document.

A function that enables you to find specified text in the active data-view
window.

A group of transaction sets that the standards-setting body, such as ANSI,
has defined as fitting together with other related transaction sets. An
example might be a Functional Group defined as containing all purchasing
transaction sets.

A command that enables you to import data from an external application file.
Depending on the content of thefile, the system may prompt you for partner,
transaction, or tranglation object information.

A browser containing alist of documents that the system received, but that
have not yet been processed by the user. Once the documents are processed,
meaning printed or exported, they are transferred to the In Drawer.

A browser containing alist of documents that were received and processed.

Contains all the functional groups of documents, or transaction sets, sent
from one sender to one receiver in the same transmission.
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Interchanges
browser

label

menu

menu bar

move

network

ODETTE

Out Documents

Out Drawer

partner

Partner Editor

post

A browser that enables you to view a hierarchical list of all the interchanges
that were sent or received. The Interchanges browser can always be
accessed. It contains status information about the interchanges, such as
whether or not a functional acknowledgment was received and the status of
that acknowledgment. This browser also enables you to access the
documents within the interchanges.

Descriptions of information. They can be aimost anything on atrandation
object that is not an element, a keyword title, or an information indicator.
They can aso be things used as information dividers, such as aline of
dashes.

A list of items from which you can choose. Each item represents a
command. Unavailable items on a menu are dimmed to inform you they are
disabled.

Containsthe list of menus for the application.

A function that enables you to move a document or group of documents
either from the In Documents or ?Iln Documentsto the In Drawer or from the
?20ut Documents to the Workspace.

A service, such as Sterling B2B Collaboration Network, that accepts and
hol ds transmissions from companies until it is convenient for atrading
partner to accept them. It isalso known as a Third Party Network or Vaue-
Added Network (VAN).

The Organization for Data Exchange by Tele-Transmission in Europe.

A browser that contains alist of documents ready to be sent. After the
documents are successfully sent, they are automatically transferred to the
Out Drawer.

A browser that contains alist of documents that were successfully sent out
by the system.

Another firm with which your company trades documents. Also referred to
as atrading partner.

A function that enables you to define, edit, and delete all partner information
for your company and al of your trading partners.

A function that enables you to move compliant documents from the
Workspace to the Out Documents.
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predefined

print

printout

receive

respond

responsible agency

segments

send

Send Queue

set

sort

IBM Sterling Gentran:Director User Guide

A default value for a particular element on a data entry translation object.
You can change the value as necessary.

A command that enables you to print an unformatted or formatted version of
the selected documents using the print translation object set up in the partner
relationship for those documents, or print a summary list of the documents.

The result of datareceived from atrading partner passing through a print
tranglation object. You do not have to actually print the data. The printout
could beto afile on your hard disk.

A function that enables you to manually initiate acommunications session to
receive data from your trading partner.

A function that enables you to create a turnaround document, using the Turn
Around translation object in the partner relationship, in response to one or
more selected documentsin the In Drawer.

An organization that devel ops and updates standards for EDI
communications. These organizationsinclude ANSI, EDIA, AIAG, UCS,
and VICS.

A number of elements combined to communicate useful data. For example, a
catalog price segment might consist of elements for item description,
volume, price, and lead time. By themselves, none of these elements would
communicate useful information. Together, they provide the information
necessary for someone to tell if the item iswhat they want, or whether the
priceisreasonable. Segments are defined by the EDI standards. A number of
segments together form atransaction set.

A function that enables you to manually start a communications session to
send datato your trading partner. Only selected documents are envel oped
and sent. If no documents are selected, ALL documents are sent.
Successfully sent documents are moved to the Out Drawer.

A function that enables you to display alist documents currently queued to
be sent.

See Transaction Set.
A function that enables you to sort the list of documents in a document

browser into one of the following sequences: partner/type/name, partner/
name/type, or type/partner/name.
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Glossary

status A document’s or interchange’s processing stage, indicated in the “ Status’
box. Refer to the following table for additional status information.

?In Documents

NotOK

All documentsin the 2ln Documents havethis
status. This code indicates one of the
following:

B The document failed to comply with the

EDI standard. If thisis the cause of the
error, the errors are indicated on a
translator report associated with the
document. Despite the fact that the
document is not fully compliant, it is
eligible for further processing.

The received document could not be
associated with a specific trading partner.
If thisisthe case, the partner listed for the
document in question is “Unknown.” To
associate this document and the other
documents received in the interchange
with a partner, attach the documents from
the Interchanges browser.

A suitable trading relationship or
translation object could not be associated
with the document. Detailed information
concerning what information was used to
locate the relationship and/or the

trand ation object islisted in the audit log.
To correct this problem, avalid
relationship must be established using the
Partner Editor and avalid export, print, or
turn around trangl ation object must be
defined for that relationship.

Continued on next page

May 2011
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B A major error occurred while processing
theinterchange, functional group, or
transaction level enveloping structures.
This error may include header and trailer
control numbers that do not match, an
invalid trailer control count, or a control
number sequence checking error. If any
of these errors occur, they are listed on
the translator report for the interchange
containing the documents.

?0ut Documents

NotOK

This code indicates that the document does
not comply with the EDI standard definition.
The errors that are causing the compliance
failure can be determined by viewing the
tranglator report for the document.

In Documents

OK

All documents in the In Documents have a
status of “OK.” These documents are fully
compliant and are eligible for further
processing.

In Drawer

OK

This code indicates that the documents are
fully compliant with the EDI standard and are
eligible for further processing.

Continued on next page
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NotOK
This code indicates one of the following:
B The document failed to comply with the

EDI standard. If thisis the cause of the
error, the errors are indicated on a
tranglator report associated with the
document. Despite the fact that the
document is not fully compliant it is
eligible for further processing.

The received document could not be
associated with a specific trading partner.
If thisisthe case, the partner listed for the
document in question is “Unknown.” To
associate this document, and the other
documents received in the interchange
with a partner, attach the documents from
the Interchanges browser.

A suitable trading relationship or
translation object could not be associated
with the document. Detailed information
concerning what information was used to
locate the relationship and/or the
trandlation object islisted in the audit log.
To correct this problem, avalid
relationship must be established using the
Partner Editor and avalid export, print, or
turn around trangl ation object must be
defined for that relationship.

A magjor error occurred while processing
theinterchange, functional group, or
transaction level enveloping structures.
This error may include header and trailer
control numbers that do not match, an
invalid trailer control count, or a control
number sequence checking error. If any
of these errors occur, they are listed on
the translator report for the interchange
containing the documents.

Continued on next page
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I nterchanges The Interchanges browser contains graphics
that represent the interchange process status,
interchange network status, interchange,
group, document acknowledgment status, and
document compliance status. When you
highlight an entry in the Interchanges
browser, an explanation of the status codes

for that lineis displayed in the Sterling
Gentran:Director status bar.

I nterchange Process Satus

Ed

Received
Indicatesthat the interchange was received by
the system

i

Sent

Indicates that the interchange was
successfully transmitted to the appropriate
partner.

]
Ready to Send
Indicates that an attempt was made to send
this interchange, but the communication
session was not successful. Thisinterchange
is sent during the next appropriate
communication session.

=

Queued
Indicates that the document is queued to send.

i

Hold Indicates that the document is on
“hold,” i.e., is not sent.

Continued on next page
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A

Overdue

Indicates that the interchange is waiting to be
reconciled with an inbound functional
acknowledgment but has exceeded the
number of hours by which that
acknowledgment is deemed late.

Send Failed
Indicates that the send attempt failed due to
an error during the communications process.

Continued on next page

May 2011
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I nterchange Networ k Status

L

On Network

Blue dish indicates that the interchange was
successfully delivered to a value-added
network. (To obtain this status using Sterling
B2B Collaboration Network you must have
your mailbox configured to receive the 20
report in data format).

e
Network Warning
Yellow dishindicatesthat theinterchange was
delivered to a value-added network and the
network detected non-critical errorsin the
data. The datais available to be picked up by
the designated trading partner. (To obtain this
status using Sterling B2B Collaboration
Network you must have your mailbox
configured to receive the 20 report in data
format).

¥

Network Error
Red dish indicates that the interchange was
delivered to a value-added network and the
network detected critical errorsin the data.
The datais not available to be picked up by
the designated trading partner. (To obtain this
status using Sterling B2B Collaboration
Network you must have your mailbox
configured to receive the 20 report in data
format).

K
Picked Up
Green dish indicates that the interchange was
successfully delivered to atrading partner via
avaue-added network. (To obtain this status
using Sterling B2B Collaboration Network
you must have your mailbox configured to
receive the 70 report in dataformat).

Continued on next page
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K
Transmitted to third-party network Black
dish indicates that the interchange was
transmitted to a third-party network.

Interchange, Group, and Document
Acknowledgment Satus

(&}

Waiting Indicatesthat the interchange is
waiting to be reconciled with an inbound
functional acknowledgment.

Overdue Indicates that the interchangeis
waiting to be reconciled with an inbound
functional acknowledgment but has exceeded
the number of hours by which that
acknowledgment is deemed late.

=
Y]

Rejected Indicates that the interchange was
acknowledged by your partner and there were
errors. The interchange was rejected by your
partner.

Acknowledged Indicates that the
interchange was acknowledged by your
partner and there were no errors.

2
Acknowledged with Errors Indicates that
the interchange was acknowledged by your
partner and there were errors. It was accepted
by your partner in spite of the errors.
Partially Acknowledged Indicates that the
interchange was successfully received by the
trading partner and some of the documents
within the interchange were accepted or
accepted with errors and other documents
within the interchange were rejected.

Continued on next page

May 2011

IBM Sterling Gentran:Director User Guide



Glossary

Document Compliance Satus

[

OK

This code indicates that the documents are
fully compliant with the EDI standard and are
eligible for further processing.

CL

NotOK

Red “thumbs down” indicates that this code

indicates one of the following:

B The document failed to comply with the
EDI standard. If thisis the cause of the
error, the errors are indicated on a
tranglator report associated with the
document. Despite the fact that the
document is not fully compliant it is
eligible for further processing.

B Thereceived document could not be
associated with a specific trading partner.
If thisisthe case, the partner listed for the
document in question is “Unknown.” To
associate this document, and the other
documents received in the interchange
with a partner, attach the documents from
the Interchange browser.

B A suitable trading relationship or
translation object could not be associated
with the document. Detailed information
concerning what information was used to
locate the relationship and/or the
trangation object islisted in the audit log.
To correct this problem, avalid
relationship must be established using the
Partner Editor and avalid export, print, or
turn-around trandlation object must be
defined for that relationship.

Continued on next page
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B A major error occurred while processing
theinterchange, functional group, or
transaction level enveloping structures.
This error may include header and trailer
control numbers that do not match, an
invalid trailer control count, or a control
number sequence checking error. If any
of these errors occur, they are listed on
the translator report for the interchange
containing the document.

El

Duplicate

Yellow “thumbs down” indicates that the
document has the same name as another
document on the system.

Out Documents

OK

This code indicates that the document is fully
compliant with the EDI standard. Documents
with this status can be sent.

Out Drawer

Sent

This code indicates that the document was
successfully transmitted to the appropriate
partner.

Waiting

This code indicates that the document is
waiting to be reconciled with an inbound
functional acknowledgment.

Overdue

This code indicates that the document is
waiting to be reconciled with an inbound
functional acknowledgment, but has exceeded
the number of hours by which that
acknowledgment is deemed late.

Continued on next page
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Ack’'d

This code indicates that the document was
acknowledged by your partner and there were
no errors.

AcKErr

This code indicates that the document was
acknowledged by your partner and there were
errors, but it was accepted by your partner in
spite of the errors.

Reject

This code indicates that the document was
acknowledged by your partner and there were
errors. The document was rejected by your
partner.

~Ack

This statusis only displayed if there were no
acknowledgments expected for this document
and either the group or the interchange was
partially acknowledged. If your partner is
going to issue partial acknowledgments at the
interchange or group level, he/she should also
indicate acceptance or rejection at the
transaction level.

OnNet

This code indicates that the document was
successfully delivered to a value-added
network. To obtain this status using Sterling
B2B Collaboration Network, you must have
your mailbox configured to receive the 20
report in data format.

PickedUp

This code indicates that the document was
successfully delivered to atrading partner via
avalue-added network. To obtain this status
using Sterling B2B Collaboration Network,
you must have your mailbox configured to
receive the 70 report in data format.

Continued on next page

IBM Sterling Gentran:Director User Guide

May 2011 G-17



Glossary

NetWarn

This code indicates that the document was
delivered to a value-added network and the
network detected non-critical errorsin the
data. The datais available to be picked up by
the designated trading partner. To obtain this
status using Sterling B2B Collaboration
Network, you must have your mailbox
configured to receive the 20 report in data
format.

NetErr

This code indicates that the document was
delivered to a value-added network and the
network detected critical errorsin the data.
The datais not available to be picked up by
the designated trading partner. To obtain this
status using Sterling B2B Collaboration
Network, you must have your mailbox
configured to receive the 20 report in data
format.

Send Queue

Queued

This code indicates that the document was
successfully interchanged in preparation for
sending, but the interchange was not
transferred correctly to your partner. The
interchange is automatically sent in the next
communication session with this partner.

]
Ready to Send
Indicates that a document is ready to send but
amailbox message has not yet been created
for the data.

Send Failed
Indicates that the send attempt failed due to
an error during the communications process.

Continued on next page
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Workspace

OK

A codeindicating that the document is fully
compliant with the EDI standard. Documents
with this status can be posted to the Out
Documents and sent.

NotOK

A codeindicating that the document does not
comply with the EDI standard definition. You
can determine the errors that are causing the
compliance failure by viewing the translator
report for the document.

status bar The status bar of an application window defines information about a
selection, command, or process. It also defines Menu Bar items as the user
highlights each item, and indicates any current keyboard-initiated modes for
typing. For example, CAP for the “ Caps Lock” key or NUM for the “Num
Lock” key.

TDCC SeeEDIA.

translation object A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify
which trand ation objects are used by each partner relationship.

Inbound Translation Objects:

Turn Around: A translation object used when a document is received, to
create the natural response document that contains as many elements from
the received document as possible.

Export File: A trandation object that indicates when a document is
received, it is exported to a specified file format.

Print: A trandation object used to print documents.

Outbound Translation Objects:
Import: A translation object used to import data from an application file.

Print: A translation object used to print documents.

Data Entry: A transation object used to enter data into the Document
Editor facility.

third-party network See Network.
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title bar

toolbar

track

TRADACOMS

trading partner

transaction set
(document)

transmission

transmission chain

turnaround document

turnaround map

ucs

UnPost

version

Part of an application window containing the name of the application and
enables you to move the window to another position on your desktop.

Contains buttons that graphically represent commands availablein the Menu
Bar. Thisfunction displays tracking information for a single selected
document.

Function that displays tracking information for a single selected document.

The U. K. standards for EDI that are published by the Article Numbering
Association (UK) LTD.

Another firm with which your company trades documents. Also referred to
as a partner.

A business form as defined by the standards. Examplesinclude an ANSI 850
purchase order or a UCS 880 invoice. The standards define each transaction
set in terms of the segments and elements that make up the form, the order in
which they appear, and the relationships among them. Thisis also known as
“message” in Europe.

See Communications Session.

A path an EDI communication could follow, including one company, one
trading partner, and one or more network services.

A document into which data e ements from the source document have been
automatically transferred using a turnaround map.

A series of instructions that the system uses to create aturnaround document
(alogical response document to the source) from an inbound (source)
document, by transferring data from the source document to elementsin the
target document (translation object).

Uniform Communications Standard. The standard used by the grocery
industry.

This function enables you to move a document previously posted to the Out
Documents back to the Workspace for further processing.

Each standards-setting body updates its standards on aregular basis. Each
formal updateis referred to asaversion.
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view For documents, this function enables you to display the raw EDI data, a
formatted document using a translation object, or atranslator report,
depending on the format selected. For interchanges, this function enables
you to display the raw EDI data or atrand ator report, depending on the
format selected.

VICS The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

Workspace TheWorkspace containsalist of outbound “Work in Progress’ documents. It
also contains recently imported or data entry documents.

X12 The ANSI committee that sets and publishes standards for EDI.
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Symbols
?ln Documents G-1
?0ut Documents G-1

A
ack G-1
acknowledgements
reconciling documents and 7-6
setting a document to "Acknowledged” 7-10
acknowledgments G-1
criteria
defining 7-3
defining acknowledgment criteria 7-3
using 7-1
AIAG G-1
ANA G-1
ANSI G-1
application system G-1
attaching
interchanges to a partner 6-13
audit log G-1
printing 8-5
using 8-1
viewing 8-5

B

Basic TDF Header Format A-4
BAT functional group 3-54
BG envelope 3-57

browser G-1

Browser Toolbar 1-18

C

click G-1

communication session
status 5-41

communications
receiving 5-13
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Index

resending 5-9
sending a document 5-3
sending all documents 5-6
using 5-1
VATPRINT utility program 5-34
viewing
Send Queue 5-15
XPROCESS utility program 5-32
communications session 1-10, G-2
compliant G-2
component data element G-2
composite data element G-2
control menu 1-17
copy G-2
copying
documents 4-34
partner profile 3-66
Copying Communication Profiles 5-36
creating
documents 4-3
inbound relationship 3-31
partner definition 3-28
partner locations 3-88
tables 3-71
customer service 1-6

D
daily processing 10-1
data element 1-11, G-4
datafiles
processing 5-17
data-view windows G-2
default G-2
deleting
documents 4-30
entriesin atable 3-76
partner locations 3-92
tables 3-78
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trang ation objects 2-5
Deleting Communication Profiles 5-38
Desk, The 1-19, G-2
dialog box G-3
Docsin Interchange G-3
Document

exporting 4-43
Document Editor 1-13
documents G-3, G-20

copying 4-34

creating 4-3

deleting 4-30

editing 4-7

finding text in 4-20

moving 4-33

opening 4-7

posting 4-35

printing 4-31

responding 4-38

sorting 4-23

turnaround G-20

UnPost 4-37

using 4-1

viewing 4-33
double-click G-3

E
EANA G-3
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